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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described in the next section or sections by product name.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

This section contains regulatory compliance information for the following devices of the Surveyor Plus family of LC 
instruments:

Surveyor LC Pump Plus

When the Surveyor LC Pump Plus is delivered to you, it meets all pertinent electromagnetic compatibility (EMC) and 
safety standards as described below.

EMC Directive 89/336/EEC amended by 92/31/EEC and 93/68/EEC

EMC compliance has been evaluated by Underwriters Laboratories Inc.

• Surveyor LC Pump Plus • Surveyor PDA Plus Detector
• Surveyor MS Pump Plus • Surveyor UV/Vis Plus Detector
• Surveyor Autosampler Plus

EN 55011 1998 EN 61000-4-3 2002
EN 61000-3-2 1995, A1; 1998, A2; 1998, A14; 2000 EN 61000-4-4 1995, A1; 2001, A2; 2001 
IEC 61000-3-2 2000 EN 61000-4-5 1995, A1; 2001
EN 61000-3-3 1995 EN 61000-4-6 1996, A1; 2001
IEC 61000-3-3 1994 EN 61000-4-11 1994, A1; 2001
EN 61326-1 1997
EN 61000-4-2 1995 A1; 1998 A2; 2001 CISPR 11 1999, A1; 1999, A2; 2002
FCC Class A, CFR 47 Part 15 Subpart B: 2004



Low Voltage Safety Compliance

Low voltage safety compliance has been evaluated by TUV Rheinland of North America, Inc. This device complies 
with Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

Surveyor MS Pump Plus

When the Surveyor MS Pump Plus is delivered to you, it meets all pertinent electromagnetic compatibility (EMC) and 
safety standards as described below.

EMC Directive 89/336/EEC amended by 92/31/EEC and 93/68/EEC

EMC compliance has been evaluated by Underwriters Laboratories Inc.

Low Voltage Safety Compliance

Low voltage safety compliance has been evaluated by TUV Rheinland of North America, Inc.This device complies with 
Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

EN 55011 1998 EN 61000-4-3 2002
EN 61000-3-2 1995, A1; 1998, A2; 1998, A14; 2000 EN 61000-4-4 1995, A1; 2001, A2; 2001 
IEC 61000-3-2 2000 EN 61000-4-5 1995, A1; 2001
EN 61000-3-3 1995 EN 61000-4-6 1996, A1; 2001
IEC 61000-3-3 1994 EN 61000-4-11 1994, A1; 2001
EN 61326-1 1997
EN 61000-4-2 1995 A1; 1998 A2; 2001 CISPR 11 1999, A1; 1999, A2; 2002
FCC Class A, CFR 47 Part 15 Subpart B: 2004



Surveyor Autosampler Plus

When the Surveyor Autosampler Plus is delivered to you, it meets all pertinent electromagnetic compatibility (EMC) 
and safety standards as described below.

EMC Directive 89/336/EEC amended by 92/31/EEC and 93/68/EEC

EMC compliance has been evaluated by Underwriters Laboratories Inc.

Low Voltage Safety Compliance

Low voltage safety compliance has been evaluated by TUV Rheinland of North America, Inc. This device complies 
with Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

EN 55011 1998 EN 61000-4-3 2002
EN 61000-3-2 1995, A1; 1998, A2; 1998, A14; 2000 EN 61000-4-4 1995, A1; 2001, A2; 2001 
IEC 61000-3-2 2000 EN 61000-4-5 1995, A1; 2001
EN 61000-3-3 1995 EN 61000-4-6 1996, A1; 2001
IEC 61000-3-3 1994 EN 61000-4-11 1994, A1; 2001
EN 61326-1 1997
EN 61000-4-2 1995 A1; 1998 A2; 2001 CISPR 11 1999, A1; 1999, A2; 2002
FCC Class A, CFR 47 Part 15 Subpart B: 2004



Surveyor PDA Plus Detector

When the Surveyor PDA Plus Detector is delivered to you, it meets all pertinent electromagnetic compatibility (EMC) 
and safety standards as described below.

EMC Directive 89/336/EEC amended by 92/31/EEC and 93/68/EEC

EMC compliance has been evaluated by Underwriters Laboratories Inc.

Low Voltage Safety Compliance

Low voltage safety compliance has been evaluated by TUV Rheinland of North America, Inc.This device complies with 
Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

EN 55011 1998 EN 61000-4-3 2002
EN 61000-3-2 1995, A1; 1998, A2; 1998, A14; 2000 EN 61000-4-4 1995, A1; 2001, A2; 2001 
IEC 61000-3-2 2000 EN 61000-4-5 1995, A1; 2001
EN 61000-3-3 1995 EN 61000-4-6 1996, A1; 2001
IEC 61000-3-3 1994 EN 61000-4-11 1994, A1; 2001
EN 61326-1 1997
EN 61000-4-2 1995 A1; 1998 A2; 2001 CISPR 11 1999, A1; 1999, A2; 2002
FCC Class A, CFR 47 Part 15 Subpart B: 2003



Surveyor UV/Vis Plus Detector

When the Surveyor UV/Vis Detector is delivered to you, it meets all pertinent electromagnetic compatibility (EMC) 
and safety standards as described below.

EMC Directive 89/336/EEC amended by 92/31/EEC and 93/68/EEC

EMC compliance has been evaluated by Underwriters Laboratories Inc.

Low Voltage Safety Compliance

Low voltage safety compliance has been evaluated by TUV Rheinland of North America, Inc.This device complies with 
Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

FCC Compliance Statement

EN 55011 1998 EN 61000-4-3 2002
EN 61000-3-2 1995, A1; 1998, A2; 1998, A14; 2000 EN 61000-4-4 1995, A1; 2001, A2; 2001 
IEC 61000-3-2 2000 EN 61000-4-5 1995, A1; 2001
EN 61000-3-3 1995 EN 61000-4-6 1996, A1; 2001
IEC 61000-3-3 1994 EN 61000-4-11 1994, A1; 2001
EN 61326-1 1997
EN 61000-4-2 1995 A1; 1998 A2; 2001 CISPR 11 1999, A1; 1999, A2; 2002
FCC Class A, CFR 47 Part 15 Subpart B: 2004

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or bulky for one 
person alone to handle safely.

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) 
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermo.com/
WEEERoHS for further information on Thermo Fisher Scientific’s compliance with these Directives and the 
recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen.  
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information 
über die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, über die Verwerter, und weitere Hinweise, 
die nützlich sind, um die Produkte zu identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  
www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de 
l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage d'informations sur la 
conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre pays et les informations sur les 
produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
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Preface

This guide describes how to use your Thermo Scientific mass spectrometry application to 
control the Surveyor™ Plus high-performance liquid chromatography (HPLC) system.

Contents

• Related Documentation

• Safety and Special Notices

• Contacting Us

Tip  Use the Lamp Startup Time feature to preserve the useful lifetime of the deuterium 
lamp. The default lamp startup time for the PDA detector is 4:55 PM. For optimal system 
performance, reset the lamp startup time to approximately two hours before you plan to 
start data acquisition. For information about changing the lamp startup time, see “Setting 
the Lamp Startup Time” on page 166.

Tip  The default setting for the autosampler maintenance counters is 0. If you turn on the 
autosampler maintenance log (see “Communication Page” on page 52) when you specify 
the configuration settings for the autosampler and leave the counters at the default setting, 
the autosampler status displays Maintenance Due and the data system prevents you from 
starting a run. For information about changing the counter settings on the Maintenance 
Information page, see “Autosampler Maintenance Information” on page 309. 
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Preface
Related Documentation
In addition to Help that you can access from the data system, these manuals are provided with 
LC Devices as PDF files for the Surveyor Plus family of high-performance LC instruments:

• Surveyor Plus User Guide for LC Devices (formerly entitled Surveyor Plus User Guide for the 
Xcalibur Data System)

• Surveyor Plus Preinstallation Requirements Guide

• Surveyor Plus Getting Connected Guide

• Surveyor Autosampler Plus Hardware Manual

• Surveyor LC Pump Plus Hardware Manual

• Surveyor MS Pump Plus Hardware Manual

• Surveyor PDA Plus Detector Hardware Manual

• Surveyor UV/Vis Plus Detector Hardware Manual

 To view manuals for your Surveyor Plus LC devices

Go to Start > Programs > Thermo Instruments > Manuals > LC Devices > Surveyor >.

 To open Help

• From the Instrument Setup window, choose Help >product name Help.

• If available for a specific window or dialog box, click Help or press F1 for 
information about setting parameters. 

For more information, visit www.thermoscientific.com. 
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Preface
Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

CAUTION  Highlights hazards to humans, property, or the environment. 
Each CAUTION notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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Preface
Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

 To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

 To contact Customer Service for ordering information

 To get local contact information for sales or service

Go to www.thermoscientific.com/wps/portal/ts/contactus.

 To copy manuals from the Internet

Go to mssupport.thermo.com, agree to the Terms and Conditions, and then click 
Customer Manuals in the left margin of the window. 

 To suggest changes to documentation or to Help

• Fill out a reader survey online at www.surveymonkey.com/s/PQM6P62.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
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1

Introduction to the Surveyor Plus LC System

The Surveyor Plus high-performance liquid chromatography system (see Figure 1), which 
integrates with the Thermo Scientific family of mass spectrometers, consists of an analytical 
pump, an autosampler, an optional PDA detector or UV/Vis detector, and a solvent platform.

Figure 1. Surveyor Plus LC instrument

Contents

• Analytical Pump

• Autosampler

• Detector

• Solvent Platform

• Communication with the Data System Computer

• Turning Off the Computer’s Energy Saving Features

• Synchronization of the LC Devices

• Status LEDs
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1 Introduction to the Surveyor Plus LC System
Analytical Pump
Analytical Pump
Thermo Scientific, part of Thermo Fisher Scientific Inc., offers two analytical pumps in the 
Surveyor Plus product line: the Surveyor MS Pump Plus, which provides optimum 
performance in the lower flow rate ranges needed for mass spectrometry; and the Surveyor LC 
Pump Plus, which provides optimum performance in the flow rate ranges needed for 
chromatography. 

Both analytical pumps contain a built-in solvent degassing system that consists of four 
independent chambers maintained at a constant vacuum of approximately 27 in. Hg. Each 
chamber contains an 18 in. length of 0.045 in. ID Teflon™ AF tubing. This translates to a 
volume of less than 500 μL per channel, adding very little to the quantity of solvent required 
to purge the lines when you replace an eluent.

These topics describe the features of the Surveyor analytical pumps:

• Surveyor MS Pump Plus

• Surveyor LC Pump Plus

Surveyor MS Pump Plus

The Surveyor MS Pump Plus is a dual-piston, quaternary, low-pressure mixing pump with a 
built-in vacuum degasser and pulse dampener. The pumping system provides flow rates from 
1 to 2000 μL/min, which is the range needed to perform LC and LC/MS applications. You 
can run precise gradients from 200 to 2000 μL/min, while the extremely low gradient delay 
volume of 65 μL ensures minimum system cycle times.

The pulse dampening assembly consists of a low volume T-connector that the mobile phase 
passes through. Attached to the side leg of the T-connector is a 2 mL loop of stainless steel 
tubing. The loop terminates with a priming valve (pulse dampener flush valve). When the 
priming valve is open, you can flush or fill the dampening loop with an appropriate solvent 
such as methanol or isopropanol. When the priming valve is closed, the loop is shut off from 
the flow path and absorbs pump pulsations. Because the 2 mL loop is shut off from the flow 
path, it adds no gradient delay volume to the LC system.

The priming solvent in the loop does not interfere with the purity of the mobile phase, and its 
composition does not need to match the mobile phase.

The data system remotely controls the pump with an RS-232 communication link from the 
data system computer. The only manual control is the power switch located on the front of 
the pump in the lower-left corner below the door.
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 1 Introduction to the Surveyor Plus LC System
Analytical Pump
Surveyor LC Pump Plus 

The Surveyor LC Pump Plus is a dual-piston, quaternary, low-pressure mixing pump with a 
built-in vacuum degasser and pulse dampener. The pumping system provides flow rates from 
0.001 to 9.999 mL/min, which is the range needed to perform high-performance liquid 
chromatography. You can run precise gradients from 0.200 to 2.000 mL/min.

The Surveyor LC Pump Plus is a bench-top unit for inclusion in the Surveyor Plus high 
performance liquid chromatograph (HPLC). The Xcalibur™ data system controls the pump 
through an Ethernet communication link with the data system computer. The only manual 
controls are the power switch located on the front of the pump in the lower-left corner below 
the door and the drain valve. 

The Surveyor LC Pump Plus has five major components: the vacuum degassing assembly, the 
solvent proportioning assembly, the pump head assemblies, the purge manifold assembly, and 
the pulse dampening assembly (see Figure 2). The pulse dampening assembly adds 400 μL of 
gradient delay volume to the system. The Surveyor LC Pump Plus has status LEDs on the 
front door and a low-voltage power supply.

Figure 2. Front view of the Surveyor LC Pump Plus

A

IN OUT

B

C

D

DRAIN

CLOSE OPEN

Solvent lines entering 
and exiting the 
degassing assembly

Pump head
assemblies

Left Right

Line body containing 
filter frit

On/Off
switch

Solvent 
proportioning 
assembly

Pulse dampening 
assembly (behind the 
front panel)

Purge 
manifold 
assembly
Thermo Scientific Surveyor Plus User Guide for LC Devices 3



1 Introduction to the Surveyor Plus LC System
Analytical Pump
You can use the Purge command from the data system to draw solvent at a rate of 10 mL/min 
through the solvent lines connected to the pump after you open the purge valve. To open the 
purge valve, turn the knob on the front of the purge manifold assembly counterclockwise 
(see Figure 3). When the valve is in the open position, look for the word DRAIN to appear 
upside down on the knob.

Figure 3. Drain valve positions

Figure 4 shows the line body fitting removed from the top of the purge manifold assembly. 
The line body fitting contains an inline filter frit that captures particulate matter shed by the 
pump seals. This prevents particulate matter from contaminating the tubing that connects the 
pump to the autosampler. As this filter frit becomes clogged, the system backpressure rises. 
Replace this filter frit when the system backpressure rises above its typical operating limits.

Figure 4. Line body and filter frit
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 1 Introduction to the Surveyor Plus LC System
Autosampler
Autosampler
Thermo Fisher Scientific offers two autosampler models in the Surveyor Plus product line: 
the full-featured Surveyor Autosampler Plus and the Surveyor Autosampler Plus Lite. The 
full-featured autosampler includes a built-in column oven (5 to 95 °C) and a temperature 
controlled tray/sample compartment (0 to 60 °C). Both models let you inject samples and 
perform sample preparation tasks automatically.

For more information about the autosampler, see these topics:

• Tray Compartment

• Vial and Well Notation 

• Injection System

• Injection Modes

• Temperature Control

Tray Compartment

The tray compartment (see Figure 5) can hold up to five conventional sample trays or one 
carrier that holds three microwell plates. The tray compartment also holds up to four 16 mL 
capacity reservoir vials that you can use to hold solvent, reagent, or diluent. The reservoir vials 
are located behind the wash station and are designated RV1, RV2, RV3, and RV4. 

Figure 5. Tray compartment

Note   To convert from °C to °F, use the following equation:

°F = (1.8 × °C) + 32
 

XYZ arm 
mechanism RV4

RV3
RV2

RV1

Injection port

Wash station
Thermo Scientific Surveyor Plus User Guide for LC Devices 5



1 Introduction to the Surveyor Plus LC System
Autosampler
The five conventional sample trays, from the left side to the right side of the tray 
compartment, are designated A, B, C, D, and E. Each sample tray holds up to 40 standard 
1.8 mL vials, for a total capacity of 200 samples. Overlays allow the sample trays to 
accommodate different vial sizes. The microwell carrier can hold up to three low-density 
96-well microplates or up to three high-density 384-well microplates. The microplates are 
designated A, B, and C.

The tray compartment door contains a magnetic switch. The magnet is located in the door 
and the switch is attached to the chassis. When you open the door, the switch signals the 
autosampler that the door is open. 

When you configure the autosampler (from the data system) to verify whether the tray 
compartment door is open or closed, the XYZ arm automatically moves to the back of the 
tray compartment when you open the door, allowing you to remove trays or replace vials. 
Opening the tray compartment door while the autosampler is making an injection does not 
interrupt the current run. The XYZ arm moves to the back of the compartment after the 
current injection is complete. The programmed sequence of injections then halts. When you 
close the tray compartment door, the sequence resumes.

Vial and Well Notation

You specify the vial or microplate well location where you want the autosampler to withdraw 
sample in the sequence table or the Inject Sample direct command. You also specify the vial or 
microplate well locations for sample preparation tasks.

These topics describe the notation for specifying vial and well locations:

• Vial Notation

• 96-Well Microplate Notation

• 384-Well Microplate Notation

Vial Notation

The notation for the location of vials is as follows: 

Tray location in tray compartment:Vial location in tray 

Where:

Tray location in tray compartment = A, B, C, D, or E

Vial location in tray = 1 through 40

A colon separates the tray location in the tray compartment from the vial location in the tray. 

Figure 6 shows the tray locations.
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 1 Introduction to the Surveyor Plus LC System
Autosampler
Figure 6. Standard trays 

96-Well Microplate Notation

The notation for the location of 96-well microplates is as follows: 

Plate:RowColumn

Where:

Plate = A, B, or C

Row = A through H 

Column = 1 through 12
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1 Introduction to the Surveyor Plus LC System
Autosampler
Figure 7 shows the notation for 96-well microplates when you select the top left orientation. 

Figure 7. Notation for 96-well plates—Top left orientation
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 1 Introduction to the Surveyor Plus LC System
Autosampler
Figure 8 shows the notation for 96-well microplates when you select the bottom right 
orientation.

Figure 8. Notation for 96-well plates—Bottom right orientation
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1 Introduction to the Surveyor Plus LC System
Autosampler
384-Well Microplate Notation

The notation for the location of 384-well microplates is as follows: 

Plate:RowColumn

Where:

Plate = A, B, or C

Row = A through P 

Column = 1 through 24

Figure 9 shows the notation for 384-well microplates.

Figure 9. Notation for 384-well microplates
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 1 Introduction to the Surveyor Plus LC System
Autosampler
Injection System

The main components of the injection system include the following: 

• Syringe Drive Assembly and Syringe Valve

• Wash Bottle Reservoir and Tubing

• Interchangeable Syringe

• XYZ Arm Mechanism

• Needle Assembly and Needle Tubing Assembly

• Injection Port and Transfer Tubing Assembly 

• Injection Valve and Sample Loop

Syringe Drive Assembly and Syringe Valve

The syringe drive assembly holds the autosampler syringe. There are three holes with 
grommets on the back of the syringe drive assembly. You mount the syringe drive assembly to 
the front of the autosampler by matching these holes to one vertical mounting pin and two 
horizontal mounting pins located in front of the autosampler injection port. The rubber 
grommets minimize the effects of vibration, but also cause the connection between the syringe 
drive assembly and the body of the autosampler to feel slack (see Figure 10).
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1 Introduction to the Surveyor Plus LC System
Autosampler
Figure 10. Syringe drive assembly for the Surveyor Autosampler Plus, showing the front and the back of assembly
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The syringe valve is a two-position rotary valve. In the wash bottle position, the syringe draws 
wash solvent into its syringe barrel as its plunger descends. In the needle position, the syringe 
draws sample solution into the needle tubing as its plunger descends and pushes sample 
solution out of the needle tubing as its plunger ascends. The syringe never draws sample 
solution into its barrel. 

Wash Bottle Reservoir and Tubing

The wash bottle rests in the solvent platform on the top of the LC stack. It is connected to the 
syringe valve by way of the wash bottle tube. Both of the direct commands, Flush (from 
bottle) and Wash Needle (from bottle), draw solvent from the wash bottle. In addition, both 
the partial loop injection and the no waste injection modes draw transfer solution from the 
wash bottle. If the wash bottle runs dry, the wash bottle tubing and the syringe barrel fill with 
air. If the syringe runs dry, the autosampler cannot draw sample into the needle tubing.

Figure 11 shows the syringe valve in the wash bottle position.

Figure 11. Drawing wash solvent from the wash bottle 

Note  The needle tubing holds approximately 560 μL of solvent. If you installed the 
2500 μL standard syringe (which must be special ordered) and you plan to make large 
volume injections, install the 1 mL needle tubing extension that comes with this syringe.
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Interchangeable Syringe

The standard configuration for the autosampler consists of a 250 μL dual-concentric syringe. 
The dual-concentric syringe consists of a small, inner plunger, and a larger, outer plunger 
(see Figure 12).

Figure 12. Dual-concentric syringe

The syringe uses its inner plunger to draw and deliver sample amounts equal to or less than its 
maximum capacity, which is 265 μL for the 250 μL concentric syringe. The syringe uses its 
outer plunger to draw and expel large volumes of solvent, for example, during a flush or wash 
cycle.

Dual-concentric syringes are available in 100, 250, and 500 μL sizes. The volume of the outer 
plunger region, 565 μL, is the same for all three dual-concentric syringes. The size of the inner 
plunger and the injection mode determine the available injection volume range. In addition 
to offering three sizes of concentric syringes, Thermo Scientific also offers a 2500 μL standard 
(single plunger) syringe. 

XYZ Arm Mechanism 

The XYZ arm mechanism moves the needle along the x-y plane to the requested vial or well 
location. After it positions the needle above the vial or well, the XYZ arm mechanism lowers 
the needle along the z axis to the requested needle height. 

Figure 13 shows the needle descending to a depth of 2 mm from the bottom of a standard 
1.8 mL vial.

Inner plunger

Outer plunger
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Figure 13. Autosampler needle positioned 2 mm from the bottom of a vial

After the autosampler withdraws the sample from the sample vial or well into the needle 
tubing, the XYZ arm mechanism moves along the x-y plane, back to the home position, 
which is above the injection port of autosampler, and then lowers the needle into the injection 
port where it expels the sample. The sample travels through transfer tubing and into the 
sample loop of the injection valve.

Do not move the XYZ arm manually. Instead, use the following commands and options 
provided by the data system to control the position of the XYZ arm:

• To make the XYZ arm automatically move to the back of the tray compartment when you 
open the tray door, select the Verify Door is Closed option, which is available when you 
configure the autosampler device driver (see “Communication Page” on page 52).

• To move the XYZ arm to the back of the tray compartment, use the Position Arm to 
Access Tray direct command (see “Removing and Installing Sample Trays” on page 199).

• To move the XYZ arm mechanism to its home position above the injection port, use the 
Set Arm to Home Position direct command. 

• To move the XYZ arm mechanism to the middle front of the tray compartment, allowing 
easy access to the needle, use the Remove Needle direct command. 

IMPORTANT      Because the XYZ arm moves to the sample position to withdraw sample, 
do not place objects taller than 1.8 inches into the tray compartment, as they will stall the 
XYZ arm.

Wash solvent
Sample

2 mmBottom of vial

Needle height
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Thermo Scientific Surveyor Plus User Guide for LC Devices 15



1 Introduction to the Surveyor Plus LC System
Autosampler
Needle Assembly and Needle Tubing Assembly

The needle assembly consists of a blunt-tip needle, a latch nut, a flag, a compression spring, 
and a 10-32 fitting that connects to the needle tube assembly. The needle fits into the needle 
mount on the XYZ arm. 

The needle tube assembly connects the solvent path between the needle and the syringe valve 
and consists of low-pressure tubing, an internally threaded fitting that connects to the needle 
assembly fitting, a sleeve, a black or red PVC cap, a needle tube guide that attaches to the 
x-axis positioning frame, and an externally threaded fitting with a flangeless ferrule that 
connects to the right side of the syringe valve. 

Figure 14 shows the needle assembly and the needle tubing assembly.

Figure 14. Needle assembly and needle tubing assembly

IMPORTANT      To prevent damage to the needle tubing, take care when you connect the 
needle tubing guide to the back of the syringe drive assembly. Pinched tubing causes 
performance problems.

Needle assembly

Needle tubing assembly

Black or red 
PVC cap

Two-pronged 
needle guide

SleevePEEK fitting 
(that connects to the 
needle assembly)

Externally threaded nut and 
flangeless ferrule that connect to 
the right side of the syringe valve

Latch nut

Compression spring
Flag

Blunt-tip
needle

10-32
fitting
16 Surveyor Plus User Guide for LC Devices Thermo Scientific



 1 Introduction to the Surveyor Plus LC System
Autosampler
Injection Port and Transfer Tubing Assembly

Figure 15 shows the autosampler injection port. 

Figure 15. Autosampler injection port

Figure 16 shows the 0.012 in. ID transfer tube that connects the autosampler injection port 
to port 2 of the injection valve.

Figure 16. Injection port and transfer tube

IMPORTANT      The label attached to the transfer tube assembly specifies its internal 
volume. You must enter this value when you specify the configuration settings for the 
autosampler.

Injection port

Injection port
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Transfer
tube

Transfer tube assembly label 
(specifying the dead volume)
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Injection Valve and Sample Loop

The injection valve is a two-position, six-port valve that introduces sample onto the column 
by way of the sample loop. 

The sample loop is a section of stainless steel tubing with end fittings. It is an interchangeable 
part that is attached to ports 1 and 4 of the injection valve. The autosampler comes with a 
25 μL sample loop. 

There are two positions for the six-port injection valve: fill and inject.

In the fill position (see Figure 17), the sample loop is isolated from the mobile phase stream. 
As the mobile phase bypasses the sample loop, the upward movement of the autosampler 
syringe plunger pushes sample into the front of the sample loop, connected to port 1 of the 
injection valve. Once the sample loop is filled, excess solution exits the injection valve through 
port 3 to waste.

Figure 17. Injection valve in the fill position

In the inject position (see Figure 18), mobile phase enters the sample loop from the back, 
backflushing the contents of the sample loop onto the column. Excess sample left in the 
transfer tube is expelled directly to waste. To allow ample rinsing of the sample loop with 
mobile phase, the injection valve remains in the inject position during the entire run.

Figure 18. Injection valve in the inject position
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Injection Modes

The autosampler can operate in any of the following three modes:

• No Waste Injection Mode

• Partial Loop Injection Mode

• Full Loop Injection Mode

The optimum injection mode depends on the amount of sample that you have and the degree 
of precision that your application requires.

No Waste Injection Mode

The no waste injection mode is a technique that withdraws only the exact amount of sample 
requested from the sample vial. Of the three injection modes, the no waste injection mode 
uses the least amount of sample, but it is also the least precise. Use this injection mode to 
conserve sample. 

Approximately 0.25 μL of the sample is lost as it travels from the injection port, through the 
transfer tubing, and into the injection valve. Because of this loss, the minimum recommended 
injection volume is 1.0 μL. 

The quantity of lost sample depends on the syringe rate. Decreasing the syringe rate decreases 
the sample loss. For best results, use a syringe rate no greater than 4 μL/s for the no waste 
injection mode.

IMPORTANT      For no waste injections, do the following:

• Use a sample loop that is at least 5 μL larger than the injection volume. Because the 
accuracy of the nominal size is ±20%, use an estimate of 80% for the actual size. For 
example, use 20 μL as an estimate for the actual volume of a 25 μL loop, and inject no 
more than 15 μL with this loop size.

• Consider matching the chemistry of the sample matrix, the flush solution, and the 
mobile phase. For no waste injections, the autosampler loads approximately 2 μL of 
flush solvent and 3 μL of air into the sample loop, regardless of the requested injection 
volume. 

• Inject at least 1.0 μL of sample.
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Partial Loop Injection Mode

The partial loop injection mode is a technique that withdraws 22 μL of excess sample from 
the vial in addition to the requested injection volume. Approximately one-half of the excess 
volume is expelled to waste before the center of the sample bolus is metered into the front of 
the sample loop. The second portion of excess sample is expelled to waste after the sample 
bolus is backflushed onto the column. 

Partial loop injections are useful when you have a limited volume of sample. Using the partial 
loop injection mode, you can inject variable amounts of sample, ranging from a minimum of 
0.1 μL to a working maximum of one-half the volume of your sample loop. This maximum 
volume limitation is caused by the laminar flow of fluid within the stainless steel sample loop.

Full Loop Injection Mode

The full loop injection mode is a technique that withdraws a sample volume from the vial 
sufficient to overfill the sample loop by a minimum factor of two. Because the physical size of 
the sample loop determines the actual injection volume, not the metering action of the 
stepper motor, a full loop injection is very reproducible. However, because the intent of the 
full loop injection mode is to completely fill the sample loop, you cannot inject variable 
amounts of sample.

Full loop injection is useful when you want maximum precision and have unlimited sample. 
To change the injection volume, you must change the sample loop size. 

In the full loop injection mode, the autosampler withdraws a large excess of solution from the 
sample vial according to the following equation:

Amtw = 3 × Vinj + Vdead + 7.5 μL

Where:

Amtw = sample volume withdrawn by the autosampler

Vinj = user-specified injection volume

Vdead = dead volume held by the transfer tubing, injection port, and rotor slot

This equation is valid until the syringe reaches its maximum capacity, when only the 
maximum capacity of the syringe is withdrawn. The maximum capacity of the 250 μL 
concentric syringe is 265 μL.

IMPORTANT      To make precise partial loop injections, use a sample loop that is at least 
twice the size of the injection volume. The accuracy of the nominal sample loop volume 
is ±20%. Because the actual volume of the 25 μL sample loop (provided with the 
autosampler) is anywhere from 20 to 30 μL, limit the maximum injection volume with 
this loop to 10 μL. To inject more sample, use a larger sample loop.

Note  Full loop injections are limited to the size of the configured sample loop. 
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Temperature Control

The full-featured Surveyor Autosampler Plus has two built-in temperature control features: 

• Tray Temperature Control

• Column Oven Control

Tray Temperature Control

The tray temperature control feature provides temperature control of the samples in the range 
from 0 to 60 °C. A Peltier device maintains the tray temperature.

Column Oven Control

The built-in column oven controls the temperature of the air surrounding the 
chromatographic column. Isothermal temperature control is achieved using a Peltier device. 
The Peltier device is a solid-state, heat-transferring assembly used to heat or cool the column 
oven. The range of temperature control is 5 to 95 °C.

Between the analytical pump and the autosampler injection valve, the mobile phase is diverted 
through a heat exchanger located behind the column oven. As it passes through the heat 
exchanger, the mobile phase equilibrates to the temperature of the column oven before it 
reaches the injection valve. The heat exchanger adds only 3 μL of gradient delay volume to the 
LC system.

Detector
The Surveyor Plus product line includes two detectors that you can control from your 
Thermo Scientific data system: a PDA detector and a UV/Vis detector. The PDA detector, in 
combination with the 5 or 1 cm LightPipe flowcell, provides the highest level of sensitivity 
available in photodiode array detection for HPLC. The UV/Vis detector can monitor two 
wavelength channels. Both detectors have a dual-lamp optical bench that covers the 
UV-visible spectrum from 190 to 800 nm.

For more information about the Surveyor Plus detectors, see these topics:

• PDA Detector

• UV/Vis Detector

CAUTION  The column oven can reach temperatures as high as  95 °C (203 °F). 
To prevent personal injury, before installing the LC column or connecting the pump to 
the autosampler, make sure that the column oven compartment is at room temperature. 
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PDA Detector

The PDA detector is a full-featured, time-programmable, photodiode array detector that can 
scan the full ultraviolet-visible range from 190 to 800 nm. The detector can acquire data at a 
rate of up to 20 Hz with a 20 bit digital conversion.

The optimal location for the PDA detector is above the autosampler and below the solvent 
platform. The data system computer controls the PDA detector through an Ethernet 
communication link. The PDA detector consists of a dual-light source, an optical bench, a 
photodiode array, a low voltage power supply, several printed circuit boards (PCBs), and 
four status light-emitting diodes (LEDs). 

The dual-light source includes a deuterium lamp for detection in the ultraviolet 
wavelength range (190 to 360 nm) and a tungsten-halogen lamp for detection in the 
visible wavelength range (360 to 800 nm). The light emitted by the two lamps overlaps in 
the 300 to 500 nm range. A pair of attenuators that you can manually adjust controls 
the intensity of light reaching the photodiode array. 

The optical bench contains a beam combiner, focusing lens, filter wheel, flow cell, beam 
shaper, folding mirror, and grating (see Figure 19). The beam combiner reflects the light 
coming from the tungsten-halogen lamp so that it is parallel to and coincident with the light 
from the deuterium lamp. The combined beam is then focused on the inlet window of the 
flow cell through the filter wheel. The standard filter wheel has two positions. Use 
position 1 (Open), which places a clear, quartz window in the optical path, for normal 
operation. Use position 2 (Holmium Oxide), which places a sealed, quartz cuvette filled with 
a holmium oxide/perchloric acid solution (NIST™ traceable) in the optical path, for 
wavelength accuracy verification and calibration.

Figure 19. Optical bench of the PDA detector

Beam combiner
Focusing lens

Filter wheel

Flow cell
Beam shaper

Folding mirror

1 × 512
photo diode 
array

Deuterium
lamp

Tungsten-halogen lamp

Attenuators
Fixed grating
22 Surveyor Plus User Guide for LC Devices Thermo Scientific



 1 Introduction to the Surveyor Plus LC System
Solvent Platform
The PDA detector does not have independent controls, such as a keypad, to create data 
acquisition methods. Instead, you create instrument methods for data acquisition with the 
data system. The only manual controls for the PDA detector are the On/Off switch that 
controls line power, the attenuators that control the light throughput to the diode array, and 
the holmium oxide wheel that controls the position of the wavelength calibration solution.

UV/Vis Detector

The UV/Vis detector is a full-featured, time-programmable, variable-wavelength UV/Vis 
(ultraviolet/visible) absorbance detector. It operates in either the single wavelength mode, the 
dual wavelength UV wavelength mode, or the dual wavelength Visible mode. The wavelength 
range in the single wavelength mode is 190 to 800 nm. In the dual wavelength UV mode, the 
range is 190 to 450 nm and in the dual wavelength Visible mode, the range is 366 to 700 nm. 

The wavelength time table is available in all three modes. The time table can contain up to 
10 lines. If you enable the Zero On Wavelength Change feature, the baseline absorbance 
returns to zero between each line in the time table, even if the wavelengths remain the same. 
The baseline absorbance does not return to zero between the last two lines in the table.

To provide a complete spectrum of ultraviolet and visible light, the detector uses a 
deuterium lamp for the UV range (190 to 365 nm) and a tungsten lamp for the visible range 
(366 to 800 nm). The lamps are protected by a cover with a special safety interlock to reduce 
the possibility of human exposure to harmful UV light. 

To control the UV/Vis Detector, you must first add the detector to the software instrument 
configuration (see “Adding Devices to the Instrument Configuration” on page 44).

After you add the UV/Vis detector to the instrument configuration, you can set up the data 
acquisition parameters from the UV/Vis detector view of the Thermo Xcalibur Instrument 
Setup window (see “UV-Vis Detector Instrument Method Parameters” on page 106).

You can turn the detector lamps on or off and zero the detector output from the Direct 
Control dialog box (see “UV-Vis Detector Direct Controls” on page 183).

Solvent Platform
The solvent platform, located on the top of the LC stack, holds four 1 liter solvent reservoir 
bottles and one 1 liter wash bottle. Four 1/8 in. OD × 1/16 in. ID, FEP solvent lines carry 
solvent from the reservoir bottles down to the vacuum membrane degasser, which is built into 
the analytical pump. One 1/8 in. OD × 1/16 in. ID, FEP solvent line carries solvent from the 
wash bottle to the two-position syringe valve of the autosampler.
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Communication with the Data System Computer
The Surveyor Autosampler Plus, Surveyor LC Pump Plus, Surveyor PDA Plus Detector, and 
the Surveyor UV/Vis Plus Detector use an Ethernet link to communicate with the data system 
computer. To establish communication with these devices, you connect one end of an 
Ethernet cable to the Ethernet port on the back panel of the device and the other end of the 
cable to an Ethernet switch. You use a second Ethernet cable to connect the Ethernet switch to 
the computer that has the data system installed. The accessory kits include a shielded, 
Category 5, RJ-45, 7 ft length Ethernet cable with ferrite.

The Surveyor MS Pump Plus uses an RS-232 serial link to communicate with the data system 
computer.  The accessory kit for the Surveyor MS Pump Plus includes a USB cable.

In addition to connecting the communication cables, you must enter the appropriate stack 
addresses for the Surveyor Autosampler Plus, Surveyor PDA Plus Detector, Surveyor UV/Vis 
Plus Detector, and Surveyor LC Pump Plus when you configure the device drivers. The stack 
address or stack number that you enter when you add one of these devices to the 
configuration for your instrument must match the unit ID setting on the back panel of the 
device. For more information about configuring the Surveyor Plus device drivers, see 
Chapter 2, “Thermo Foundation Instrument Configuration.” 

Turning Off the Computer’s Energy Saving Features
The Surveyor PDA Plus Detector, Surveyor UV/Vis Detector, Surveyor LC Pump Plus, and 
the Surveyor Autosampler Plus communicate with the data system computer through an 
Ethernet link. To ensure communication between the data system computer and the LC 
system, turn off the data system computer’s screen saver and energy saving features.

 To turn off the screen saver and energy saving features for the Windows XP operating 
system

1. From the Windows™ XP™ desktop, choose Start > Control Panel.

2. Double-click Display. 

The Display Properties dialog box appears.

Tip  If you selected the Classic Start Menu option for the Start menu properties, 
choose Start > Settings > Control Panel.
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3. Click the Screen Saver tab.

The Screen Saver page appears (see Figure 20).

Figure 20. Screen Saver page of the Display Properties dialog box (Windows XP)

4. In the Screen Saver list, select None.

5. Click Apply to accept this setting.

6. Click Power.

The Power Options Properties dialog box opens to the Power Schemes page (see 
Figure 21).
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Figure 21. Power Options Properties

7. Modify the power scheme settings as follows:

• In the Turn Off Monitor list, select Never.

• In the System Standby list, select Never.

8. Modify the hibernate setting as follows:

a. Click the Hibernate tab.

The Hibernate page appears (see Figure 22).
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Figure 22. Hibernate page

b. If the Enable Hibernation check box is selected, clear it.

c. Click Apply to accept the setting.

9. Click OK to close the Power Options Properties dialog box.

10. Click OK to close the Display Properties dialog box.

11. Close the Control Panel window.

 To turn off the screen saver an energy saving features for the Windows 7 operating 
system

1. From the Windows 7 desktop, choose Start > Control Panel.

2. Choose Large Icons from the View By menu. 

3. Click the Personalization icon . 

The Personalization window appears (see Figure 23).
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Figure 23. Personalization window

4. Click the Screen Saver icon on the bottom-right side of the window.

The Screen Saver Settings dialog box appears (see Figure 24).
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5. Change the screen saver setting as follows:

a. In the Screen Saver list, select None.

Figure 24. Screen Saver Settings dialog box (Windows 7 operating system)

b. Click Apply to accept this setting.

6. Change the power settings as follows:

a. Click Change Power Settings.

The Select a Power Plan page of the Power Options dialog box appears (see 
Figure 25).
Thermo Scientific Surveyor Plus User Guide for LC Devices 29



1 Introduction to the Surveyor Plus LC System
Turning Off the Computer’s Energy Saving Features
Figure 25. Select a Power Plan page of the Power Options dialog box

b. Select the Balanced option.

c. Click Change Plan Settings for the Balanced option.

The Edit Plan Settings dialog box appears (see Figure 26).

Figure 26. Edit Plan Settings dialog box
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d. Click Change Advanced Power Settings.

The Advanced Settings page of the Power Options dialog box appears (see Figure 27).

Figure 27. Advanced Settings page of the Power Options dialog box

e. Set the Turn Off Hard Disk After option to Never as follows:

i. Click the  icon to the left of Hard Disk.

ii. Click the  icon to the left of Turn Off Hard Disk After.

iii. If the setting is not set to Never, click the setting and select Never.

f. Set the Hibernate After option to Never as follows:

i. Click the  icon to the left of Sleep.

ii. Click the  icon to the left of Hibernate After.

iii. If the setting is not set to Never, click the setting and select Never.

g. Click Apply to accept these settings.

h. Click OK to close the Advanced Settings page.

7. Close the Control Panel window.
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Synchronization of the LC Devices
A system interconnect cable (contact closure) provided in the Surveyor System Kit coordinates 
the run control signals between the Surveyor Plus devices.

Figure 28 shows the cable assembly with seven green combicon connectors: two are labeled 
PUMP; three are labeled DETECTOR; and two are unlabeled. You can identify the 
connector for the autosampler by the small, A/S tag on its adjacent cable. You can identify the 
M/S connector by its shape and by the small, M/S tag on its adjacent cable.

Figure 28. 7-connector system interconnect cable

Using the 7-connector cable with the Surveyor MS Pump Plus requires an additional adapter 
cable. Figure 29 shows the interconnect cable connections for a Surveyor LC system.
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Figure 29. Back panels of Surveyor devices, showing the 7-connector system interconnect cable

Figure 30 shows the cable assembly with five green combicon connectors. The assembly has 
two pump connectors: one is labeled MS PUMP and one is labeled LC Pump. You can 
identify the connectors for the autosampler, detector, and MS detector by the small tags on 
their adjacent cables. To connect the MSQ Plus Mass Detector, you must modify the wiring 
connections inside the MS detector connector.
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Figure 30. 5-connector system interconnect cable (P/N F5049-010)

Figure 31 shows the interconnect cable connections for a Surveyor LC system.

Figure 31. Back panels of the Surveyor devices, showing the 5-connector interconnect cable

For more information about connecting the interconnect cable to the devices of your LC 
system, refer to the Surveyor Plus LC System Getting Connected Guide.
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During a run, the system issues the following sequence of run control signals:

1. The data system computer issues a request to perform an injection.

2. When the autosampler becomes ready, it issues the A/S Ready signal.

The autosampler goes into the Ready state when all the configuration and instrument 
method conditions are met, including the closing of the tray compartment door, and the 
sample tray and column oven temperature zone readings showing they are within 
tolerance of their setpoints.

3. When the pump pressure stabilizes, the pump issues the Pump Ready signal to the 
autosampler. 

The autosampler injection valve switches to the fill position, and then the autosampler 
pushes sample into the sample loop.

4. The autosampler issues the Gradient Start signal to the pump. This signal commands the 
pump to start its gradient program.

5. When its piston cam reaches the home position, the pump issues the Inject Hold release 
signal to the autosampler.

6. The autosampler injection valve switches to the inject position, allowing the mobile phase 
to backflush the contents of the sample loop onto the column. The autosampler then 
issues a momentary Inject Out signal to the detector. 

7. The detector starts acquiring data.

Status LEDs
Each of the Surveyor Plus LC devices has a panel of four status LEDs located on the front of 
the left door. All of the devices have these three LEDs: Power, Comm, and Run. In addition, 
the detector has a Lamps LED; the autosampler has a Temp LED; and the analytical pump 
has a Degas LED. 

These topics describe the meanings of the LED states:

• Surveyor MS Pump Plus LED States

• Surveyor LC Pump Plus LED States

• Autosampler LED States

• PDA Detector LED States

• UV-Vis Detector LED States
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Status LEDs
Surveyor MS Pump Plus LED States

Table 1 lists the states of the Surveyor MS Pump Plus LEDs.

Table 1. Pump status LEDs and their meaning

LED Status Meaning

Power Green The pump is on and receiving power.

Comm Amber The pump is not communicating with the data 
system.

Green Communication to the data system has been 
established.

Flashing green A pump program is downloading from the data 
system computer.

Run Amber The power is switched on, but the  pistons are idle, 
producing no flow.

Flashing amber A firmware download is in progress or an error 
condition has occurred.

Green The pump pistons are moving, but a pump program 
is not running. This state can occur when the pump 
is under direct control or a pump program has ended.

Flashing green The pump is running a pump program from a 
downloaded method.

Degas Amber The degas unit is building vacuum.

Flashing amber A failure, such as a loss of vacuum, has occurred.

Green Sufficient vacuum has developed to perform 
chromatography.
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Status LEDs
Surveyor LC Pump Plus LED States

Table 2 list the LED states for the Surveyor LC Pump Plus.

Table 2. Surveyor LC Pump Plus status LEDs and meaning

LED Status Meaning

Power Green The pump is on and receiving power.

Comm Amber The pump is not communicating with the data 
system computer.

Flashing amber The rotary switches on the back panel of the LC 
pump are set to 00 for downloading firmware.

Green The pump is communicating with the data system 
computer.

Run Amber The pump is not communicating with the data 
system computer, the pump’s motor is stopped, the 
pistons are homing, or the pump is stabilizing (except 
during a run).

Flashing amber The pump is experiencing an error condition.

Green The pump is in the Ready state.

Flashing green The pump is performing a run or the pump is 
stabilizing during a run.

Degas Amber The pump is powering up and the degas unit is 
building vacuum. 

Flashing amber The degas unit is experiencing a failure, such as a 
loss of vacuum.

Green The degas unit has developed sufficient vacuum to 
degas the mobile phase solvents when the pump 
flow is set to a typical flow rate for chromatography. 
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Status LEDs
Autosampler LED States

Table 3 lists the LED states for the autosampler.

Tip  To ensure that the controlled temperature zones are in equilibrium at the set 
temperature before the autosampler makes an injection, select the Wait for Temperature 
Ready check box when you add the autosampler to the data system instrument 
configuration.

When you select this check box, the autosampler waits until the controlled temperature 
zones are in equilibrium at the set temperature before it makes an injection. While the 
temperature zones are equilibrating to the set temperature, the Temp LED remains amber.

When you do not select this check box, the autosampler does not wait for the temperature 
zones to equilibrate to the set temperature before making an injection and the Temp LED 
remains green.

Table 3. Surveyor Autosampler status LEDs and their meaning

LED State Meaning

Power Green The autosampler is on and receiving power.

Comm Amber Communication with the data system has not been 
established.

Green Communication with the data system has been 
established.

Run Flashing Amber An error condition, such as an XYZ arm jam or 
initialization startup error, has occurred.

Green The autosampler is in the Ready state.

Flashing Green An injection or timed event is in progress.

Temp Amber A temperature change within the column oven or 
tray temperature zones is in progress.

Green The column oven and tray temperature zones are in 
equilibrium at the set temperature.

–or–

The Wait for Temperature Ready check box on the 
Communication page of the Instrument 
Configuration application is not selected.
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Status LEDs
PDA Detector LED States

Table 4 lists the LED states for the PDA detector.

Table 4. PDA detector LED states and their meaning

LED State Amber

Power Green The detector is turned on and receiving power.

Comm Amber There is no communication with the data system.

Flashing amber The rotary switches are set to 00 and firmware is being 
downloaded to the CPU of the detector.

Green Communication to the data system computer has been 
established.

Run Amber The PDA detector is not ready to start a run for one of 
the following reasons:

• You have not downloaded a valid instrument 
method since the last time you powered on the 
detector.

• Both lamps are off, or one of the lamps is failing to 
turn on.

• The lamp or wavelength calibration is not valid.

Flashing amber The PDA detector is in an error state while in the 
Run mode.

Green The detector is ready for a run.

Flashing green A run is in progress and the detector is sending data to 
the data system computer.

Lamps Amber The lamps are off or the D2 lamp is starting. It takes 
approximately 10 seconds for the D2 lamp to turn on.

Green One or both lamps are turned on.
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Status LEDs
UV-Vis Detector LED States

Table 5 lists the LED states for the UV/Vis detector.

Table 5. UV/Vis detector LED states and their meaning

LED State Meaning

Power Green The detector is on.

Comm Green Communication to the data system computer has been 
established.

Amber There is no communication with the data system.

Run Green The detector is ready for a run.

Flashing green A run is in progress and the detector is sending data to the 
data system computer.

Flashing Amber An error has occurred during a run. 

Lamps Green One or both lamps are turned on.

Amber The lamps are off.
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2

Thermo Foundation Instrument Configuration

This chapter provides information about configuring the LC device drivers.

 To set up the software instrument configuration for your LC system

1. Open the Thermo Foundation™ application.

2. Add the devices of your LC system to the instrument configuration. 

3. Specify the configuration settings for each device. 

4. Close the Foundation application.

Checking the Communication Hardware
The autosampler and detector communicate with your Thermo Scientific data system 
through an Ethernet connection. Each device has an Ethernet port on its back panel. A 
shielded, Category 5 Ethernet cable with ferrite connects each device to an Ethernet switch, 
which in turn connects by way of an Ethernet cable to the data system computer. The unit ID 
setting on the back panel of the autosampler and PDA detector must match the stack number 
in the configuration.

Contents

• Checking the Communication Hardware

• Opening the Thermo Foundation Instrument Configuration Application

• Adding Devices to the Instrument Configuration

• Specifying the Configuration Settings

• Closing the Foundation Application
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Checking the Communication Hardware
Before you specify the configuration settings, check the unit ID setting on the back panels of 
the autosampler, LC pump, UV/Vis detector, and PDA detector. The unit ID consists of two 
rotary switches that are factory set to 01 (see Figure 32). 

Figure 32. Unit ID with a stack address of 01 

Unlike the other Surveyor Plus devices, the Surveyor MS Pump Plus communicates with the 
data system through an RS-232 serial connection.

 To check the communication connections

1. Check the settings of the rotary switches on the back panels of the Surveyor Autosampler 
Plus, the Surveyor UV/Vis Plus Detector or the Surveyor PDA Plus Detector, and the 
Surveyor LC Pump Plus.

2. For the Surveyor MS Pump Plus, verify that the serial communication cable connecting 
the MS pump to the data system computer is attached to COM port 1.
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 2 Thermo Foundation Instrument Configuration
Opening the Thermo Foundation Instrument Configuration Application
Opening the Thermo Foundation Instrument Configuration Application
 To open the Thermo Foundation Instrument Configuration application

From the Windows taskbar, choose Start > Programs > Thermo Foundation 1.0 > 
Instrument Configuration. 

The Thermo Foundation Instrument Configuration window appears (see Figure 33). 
This window lists the installed device drivers. 

Figure 33. Thermo Foundation Instrument Configuration window
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Adding Devices to the Instrument Configuration
Adding Devices to the Instrument Configuration
To control a device from the data system, the device must be listed in the Configured Devices 
pane of the Thermo Foundation Instrument Configuration window.

 To add the LC device drivers to the Thermo Foundation instrument configuration

In the Available Devices list, double-click the icons for your LC devices. 

A copy of the icon appears in the Configured Devices list (see Figure 34).

Figure 34. Thermo Foundation Instrument Configuration window with devices added to the 
Configured Devices list
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Specifying the Configuration Settings
Specifying the Configuration Settings
After you add the devices to the Configured Devices list, specify the configuration settings for 
each device as described in these topics:

• Surveyor Autosampler Plus Configuration Settings

• Surveyor MS Pump Plus Configuration Settings

• Surveyor LC Pump Plus Configuration Settings

• Surveyor PDA Plus Detector Configuration Settings

• Surveyor UV/Vis Plus Detector Configuration Settings

After specifying the configuration options for the instrument devices, you must close the 
Instrument Configuration application before you can open the Thermo Scientific data 
system.

Surveyor Autosampler Plus Configuration Settings

Use the Surveyor Autosampler Configuration dialog box to specify the configuration settings 
for the autosampler.

For information about specifying the configuration settings for the autosampler, see these 
topics:

• Tray Page

• Communication Page

• Signal Polarity Page

• Firmware Page

 To open the Surveyor Autosampler Configuration dialog box

1. If it is not already open, open the Thermo Foundation Instrument Configuration 
window (see “Opening the Thermo Foundation Instrument Configuration Application” 
on page 43).

2. In the Configured Devices list, double-click the Surveyor AS icon.

Note  The Accela UV/Vis Detector driver is provided with LC Devices 2.5.0 or later.
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Specifying the Configuration Settings
The Surveyor Autosampler Configuration dialog box appears with the Tray page 
displayed (see Figure 35).

Figure 35. Tray page of the Surveyor Autosampler Configuration dialog box 
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 2 Thermo Foundation Instrument Configuration
Specifying the Configuration Settings
Tray Page

The autosampler accessory kit contains several tray types, including trays that hold 1.8 mL 
vials, trays that hold 96-well microplates, and trays that hold 384-well microplates.

Use the Tray page (see Figure 36) to specify the tray type that you are using. 

 To select the tray type and orientation

1. In the list of tray types, select the tray type. 

Table 6 lists the available selections. For the three custom selections, you must calibrate 
the well bottom distance before you use the trays.

Note  The Autosampler Accessory Kit contains the vial trays and microplate carriers. 
The current version of the accessory kit contains a standard tray, a short microwell 
carrier, and a tall microwell carrier with a solid metal bottom.

Previous versions of the accessory kit contained a riser plate that you could use in 
combination with the short microwell carrier to load standard depth 96-well or 
384-well microplates into the autosampler tray compartment. Thermo Fisher 
Scientific has replaced the short microwell carrier and riser plate option with a tall 
microplate carrier that has a solid metal bottom for thermal conduction.
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Table 6. Tray type selections

Tray type Requires 
well bottom 
distance 
calibration

1 1.8 mL Vial, 5 trays, 40 vials each No

2 Custom Vial Setting Yes

3 96 Well Microplate + Tall Microwell Carrier No

4 96 Well Microplate + Tall, Solid Microwell Carrier
–or–
96 Well Microplate + Short Microwell Carrier + Riser Plate

No

5 1 mL or 2 mL Deep Well Plate + Short Microwell Carrier No

6 96 Well Microplate + Short Microwell Carrier No

7 96 Well PCR Plate + Cooling Adapter + Short Microwell Carrier No

8 Custom 96 Well Setting Yes

9 384 Well Microplate + Tall Microwell Carrier No

10 384 Well Microplate + Tall, Solid Microwell Carrier 
–or–
384 Well Microplate + Short Microwell Carrier + Riser Plate

No

11 Custom 384 Well Setting Yes
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 2 Thermo Foundation Instrument Configuration
Specifying the Configuration Settings
2. For a microplate tray type, do the following:

a. In the A1 Well Position area, select either the Top Left or the Bottom Right option 
(see Figure 36).

Figure 36. Tray page with a 96-well plate selection

b. In the Well Ordering area, click the button that represents your preference for the 
order of sequence injections.
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Autosampler Tray Page Parameters

Table 7 describes the configuration parameters on the Tray page. 

Table 7. Tray page parameters  (Sheet 1 of 2)

Parameter Description

Tray Type The Tray Type list displays pictures of the 11 sample tray configurations. When you choose 
96-well plates or 384-well plates, two additional options appear: A1 Well Position and 
Well Ordering.

The conventional autosampler tray holds 40 standard 1.8 mL vials. For other types of vials, 
select the custom vial setting and the appropriate tray adapter.

The autosampler accommodates a variety of microwell plates. You can use the tall or short 
microwell carriers to accurately position the various microwell plates at an appropriate 
location in the autosampler tray compartment. The tall microwell carrier with a solid metal 
bottom provides the same height as the short microwell carrier and riser plate combination.

The distance that the needle travels to reach the bottom of the vial is pre-calibrated for the 
eight standard configurations. You must perform a Well Bottom Distance calibration 
(see “Well Bottom Distance Calibration” on page 305) to use one of the three custom 
configurations.

For information about the height limitations for the various tray selections, see Table 8.

Note  Do not use the short microwell carrier to hold the 384-well, high density microtitre 
plates. Do not use the tall microwell carrier to hold PCR plates.
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A1 Well Position 
(for the microplate 
trays)

Use the options in the A1 Well Position area to select the orientation of the microplate when 
it is mounted in the autosampler plate holder. You can mount the plate in the plate holder 
so that the A1 well is located at the top left or located at the bottom right of the plate.

Top 
Left

Specifies that the A1 well is located at the top left of the microplate.

Bottom 
Right

Specifies that the A1 well is located at the bottom right of the microplate.

Well Ordering 
(for the microplate 
trays)

Use the buttons in the Well Ordering area to select the sampling path that the autosampler 
follows during a sequence run. The sampling path you select is independent of the A1 well 
position.

The path options are shown below:

Graphic Description

The autosampler samples wells from bottom to top and then from left to 
right, as you view the plate from the top.

The autosampler samples wells from left to right and then from bottom to 
top, as you view the plate from the top.

The autosampler samples wells from top to bottom and then from left to 
right, as you view the plate from the top.

The autosampler samples wells from left to right and then from top to 
bottom, as you view the plate from the top.

Table 7. Tray page parameters  (Sheet 2 of 2)

Parameter Description

A
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H

1 2 3 4 5 6 7 8 9 10 11 12
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1 24
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A

24 1
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Placing objects taller than 1.87 in. into the autosampler tray compartment will stall the 
autosampler arm. For custom vials, use the appropriate tray insert to ensure correct 
positioning. In addition, to trigger the vial sensor, position the vials in the tray so that the top 
of each vial reaches the minimum height of 1.55 in.

Do not use microtitre plates that exceed the heights listed in Table 8.

Communication Page

Use the Communication page to specify these options:

• The autosampler’s stack address

• The syringe size and the sample loop size

• The dead volume of the transfer tubing that connects the autosampler injection port to 
the injection valve

• Whether the controlled temperature zones must be at their set temperature, the tray 
compartment door must be closed, or both before the autosampler makes an injection

• Whether the autosampler uses the bottom distance for the configured tray type or the 
stored custom value, or determines the bottom distance of sample vials or wells for each 
injection or at the start of a sequence 

• Whether the maintenance log is enabled

Table 8. Autosampler tray compartment height limitations

Tray type Maximum height

Conventional (standard 1.8 mL vials) N/A

Custom Vial Setting N/A

96 Well Microplate + Tall Microwell Carrier 0.77 in.

96 Well Microplate + Tall, Solid Microwell Carrier or
96 Well Microplate + Short Microwell Carrier + Riser Plate

0.77 in.

1 mL or 2 mL Deep Well Plate + Short Microwell Carrier 1.80 in.

96 Well Microplate + Short Microwell Carrier 1.80 in.

96 Well PCR Plate + Short Microwell Carrier 1.80 in.

Custom 96 Well Setting 1.80 in.

384 Well Microplate + Tall Microwell Carrier 0.77 in.

384 Well Microplate + Tall, Solid Microwell Carrier or
384 Well Microplate + Short Microwell Carrier + Riser Plate

0.77 in.

Custom 384 Well Setting 0.77 in.
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 To specify the configuration settings on the Communication page

1. Open the Surveyor Autosampler Configuration dialog box (see “Surveyor Autosampler 
Plus Configuration Settings” on page 45).

2. Click the Communication tab. 

The Communication page appears (see Figure 37).

Figure 37. Communication page

3. In the Stack Address box, type the appropriate stack address or use the up and down 
arrows to select the appropriate stack address.

The stack address must match the unit ID setting located on the back panel of the 
autosampler. The rotary switches of the unit ID are factory set to 01 and the default Stack 
Address is 1. The value of 00 is reserved for service functions.

4. Under Syringe, in the Type list, select the size of the syringe that is attached to the 
autosampler. 

The default is Concentric 250 μL, the syringe that ships with the autosampler.

5. (Optional) To prevent the autosampler from making an injection when the temperature 
zones are not equilibrated at the set temperature, select the Wait for Temperature Ready 
check box. 

When the Wait for Temperature Ready check box is selected, the autosampler does not 
trigger a run until the column oven temperature, the sample tray temperature, or both 
have reached their setpoint values.

Type the value specified on the 
label attached to the transfer tube 
assembly.

When this option is selected, the 
XYZ arm moves to the back of the 
tray compartment when you open 
the tray compartment door.
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6. (Optional) To prevent the autosampler from making an injection when the tray 
compartment door is open, select the Verify Door Is Closed check box.

When the Verify Door Is Closed check box is selected, the autosampler cannot trigger a 
run when the tray compartment door is open. If the tray door is opened during a 
sequence run, the XYZ arm moves to the back of the tray compartment at the end of the 
current run, and the Xcalibur sequence halts. 

7. (Optional) To activate the maintenance log, select the Enable Maintenance Log check 
box.

The maintenance log keeps an internal count of the total injections, total valve cycles, 
total needle usage, and total syringe cycles. When any of the counters exceed the user set 
scheduled maintenance time (SMT), the autosampler cannot trigger a run until you 
perform the scheduled maintenance or you clear the check box. 

8. In the Vial Bottom Sensing area, select the type of vial bottom sensing that is appropriate 
for your application:

• To activate vial bottom sensing for every injection in a sequence, select the On 
option.

• To activate vial bottom sensing for only the first injection in a sequence, select the 
Auto option.

• To deactivate vial bottom sensing, select the Off option.

Each tray type has a stored value for the distance that the needle must travel to reach the 
bottom of the vial or well. When you activate vial bottom sensing, the autosampler 
performs a search routine to determine the actual location of the vial or well bottom. If 
the search routine determines a new value for the bottom distance, it is stored until you 
modify the tray type. If you do not want the needle to touch the bottom of a vial or well, 
deactivate vial bottom sensing.

9. In the Dead Volume (μL) box, type the value specified on the label attached to the 
transfer tube assembly.

10. In the Sample Loop Volume (μL) box, type the nominal size of the sample loop attached 
to the injection valve.

The autosampler ships with a 25 μL sample loop.

Tip  When you use the No Waste injection mode, for best results, calibrate the transfer 
tube volume, and then type the empirically determined value in the Dead Volume 
box. To calibrate the transfer tube volume, refer to the hardware manual for the 
autosampler.
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Autosampler Communication Page Parameters

Table 9 describes the parameters on the Communication page.

Table 9. Communication page parameters  (Sheet 1 of 2)

Parameter Description

Communication

Stack Address Specifies the stack address of the autosampler. The stack address must match the unit ID 
setting. The unit ID setting is specified by two rotary switches on the back panel of the 
autosampler. The rotary switches are set to 01 at the factory.

Syringe Specifies the syringe type. The selections are 100, 250, 500, and 2500 μL.

Wait for Temperature 
Ready

Selecting this check box specifies that the autosampler waits for the column oven 
temperature and the tray compartment temperature to reach their set temperatures before 
going to the Ready state.

Select this check box if you want the heated zones to reach their setpoint before the 
autosampler makes an injection.

Verify Door Is Closed Selecting this check box specifies that the autosampler waits for the door to be closed before 
starting a run and that the XYZ arm moves to the back of the tray compartment when you 
open the tray compartment door.

Select this check box if you want the autosampler to pause a sequence and send the XYZ 
arm to the back of the tray compartment when you open the tray compartment door. 

Enable Maintenance 
Log

Selecting this check box activates the maintenance log. 

The maintenance log keeps an internal count of the total injections, total valve cycles, total 
needle usage, and total syringe cycles. When any of the counters exceed the user-set 
scheduled maintenance time (SMT), the autosampler cannot trigger a run until you 
perform the scheduled maintenance or you clear the check box.

For information about setting up the scheduled maintenance time for the autosampler’s 
hardware components, see “Autosampler Maintenance Information” on page 309.

Tip  When you select the Enable maintenance log check box, check the maintenance 
schedule and make sure that the settings are appropriate for your autosampler.

Vial Bottom Sensing Specifies whether the vial bottom sensing feature is turned on or off or is set to determine 
the distance to the bottom of the first vial or well in a sequence of injections. 

The selections are as follows:

• Off. Deactivates the vial bottom sensing feature.

• On. Activates the vial bottom sensing feature for every injection.

• Auto. Activates the vial bottom sensing feature for the first injection of a sequence.
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Signal Polarity Page

During a run, the autosampler receives a Pump Ready signal and an Injection Hold release 
signal from the pump. When the autosampler switches its injection valve to the inject 
position, it sends an Inject Out signal to the detector. Figure 38 shows the signal terminals on 
the autosampler’s back panel.

Figure 38. Signal terminals on the autosampler’s back panel

Use the Signal Polarity page of the Surveyor Autosampler Configuration dialog box to specify 
the signal polarities for the input and output run signals. For the Surveyor LC Pump Plus and 
the Surveyor MS Pump Plus, ensure that the Pump Ready Active High and the Injection 
Hold Release Active High check boxes in the Input area are selected.

 To specify the signal polarities for the autosampler

1. Open the Surveyor Autosampler Configuration dialog box (see “Surveyor Autosampler 
Plus Configuration Settings” on page 45).

2. Click the Signal Polarity tab.

The Signal Polarity page appears (see Figure 39).

Dead Volume (μL) Specifies the volume of the transfer tubing that connects the autosampler’s injection port to 
the autosampler’s injection valve.

The transfer tubing has a label that specifies its dead volume.

Sample Loop Volume Specifies the nominal size of the sample loop that is connected to the injection valve. The 
autosampler cannot detect the sample loop size; it uses the sample loop size that you type in 
this box.

Table 9. Communication page parameters  (Sheet 2 of 2)

Parameter Description
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Figure 39. Signal Polarity page parameters

3. In the Input area, ensure that the Pump Ready Active High and Injection Hold Release 
Active High check boxes are selected (see Figure 39). These check boxes are selected in 
the default instrument method.

4. In the Output area, if your instrument consists entirely of Surveyor Plus devices, do not 
select the check boxes.

Autosampler Signal Polarity Page Parameters

Table 10 describes the parameters on the Signal Polarity page.

Ensure that these check boxes 
are selected for 
a Surveyor Plus LC system.

Table 10. Signal Polarity page parameters  (Sheet 1 of 3)

Parameter Description

Input

The Pump Ready Active High and the Injection Hold Release check boxes are selected in the default instrument 
method. 

Leave these check boxes selected for a Surveyor Plus pump.

Pump Ready Active 
High

Use this check box to specify the polarity of the input signal from the pump:

• If the signal from the pump is LO (Closed) and goes HI (Open) when the pump is 
ready, select the Pump Ready Active High check box.

• If the signal from the pump is HI (Open) and goes LO (Closed) when the pump is 
ready, clear the Pump Ready Active High check box.
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Injection Hold Release 
Active High

Use this check box to specify the polarity of the input signal from the pump:

• If the signal from the pump is LO (Closed) and goes HI (Open) when the pump is 
ready, select the Injection Hold Release Active High check box.

• If the signal from the pump is HI (Open) and goes LO (Closed) when the pump is 
ready, clear the Injection Hold Release Active High check box.

Output

These check boxes are clear in the default instrument method. For a Thermo Scientific LC/MS system, leave these 
check boxes clear.

Autosampler Ready 
Active High

Use this check box to set the polarity of the A/S Ready output signal: 

• When this check box is selected, the signal from the autosampler is LO (Closed) and 
goes HI (Open) when the autosampler is ready.

• When this check box is clear, the signal from the autosampler is HI (Open) and goes 
LO (Closed) when the autosampler is ready.

Note  The A/S Ready terminal sends a signal that indicates that the autosampler is in the 
Ready state. The autosampler is ready when it meets the selected ready conditions. The 
ready conditions you select include sample tray temperature, column oven temperature, 
door is closed, maintenance log, and vial bottom sensing (see “Communication Page” on 
page 52). 

Injection Out Active 
High

Use this check box to set the polarity of the Inject Out output signal: 

• When this check box is selected, the signal from the autosampler is LO (Closed) and 
goes HI (Open) when the autosampler injects a sample. 

• When this check box is clear, the signal from the autosampler is HI (Open) and goes 
LO (Closed) when the autosampler injects a sample. 

Note  The Injection Out terminal sends a signal to the other LC modules or peripheral 
devices when the autosampler injects a sample.

Gradient Start Active 
High

Use this check box to set the polarity of the Gradient Start output signal:

• When the check box is selected, the signal from the autosampler is LO (Closed) and 
goes HI (Open) to trigger the start of the pump’s gradient program.

• When the check box is clear, the signal from the autosampler is HI (Open) and goes LO 
(Closed) to trigger the start of the pump’s gradient program.

Note  The Grad Start terminal sends a signal to the pump to start the gradient program.

Table 10. Signal Polarity page parameters  (Sheet 2 of 3)

Parameter Description
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Pump Stop Active 
High

Use this check box to set the polarity of the Pump Stop output signal: 

• When the check box is selected, the signal from the autosampler is LO (CLosed) and 
goes HI (Open) when the pump is to stop. 

• When the check box is clear, the signal from the autosampler is HI (Open) and goes LO 
(Closed) when the pump is to stop. 

Note  The Pump Stop terminal sends a signal to the pump to stop. The Pump Stop output 
signal is not active during the injection sequence. The computer must make an explicit 
request to issue the Pump Stop signal.

Timed Events Active 
High

Use this check box to set the polarity of the Timed Events output signals: 

• When the check box is selected, the signal from the autosampler is LO (Closed) and 
goes HI (Open) when the timed events program is to start. 

• When the check box is clear, the signal from the autosampler is HI (Open) and goes LO 
(Closed) when the timed events program is to start. 

Note  The TF terminals send signals for events entered in the timed events table of the 
instrument method. For information about setting up the timed events table for the 
autosampler, see “Timed Events Page for the Autosampler” on page 93.

Table 10. Signal Polarity page parameters  (Sheet 3 of 3)

Parameter Description
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Firmware Page

Use the Firmware page to check the firmware version of the autosampler.

 To check the firmware version of the autosampler

1. Open the Surveyor Autosampler Configuration dialog box (see “Surveyor Autosampler 
Plus Configuration Settings” on page 45).

2. Click the Firmware tab.

The Firmware page appears (see Figure 40).

Figure 40. Firmware page

3. If you have upgraded your autosampler, upload the firmware version as follows:

a. Click Upload Firmware Version.

The firmware version of the autosampler appears next to Current Version. 

b. Click OK to save the settings and close the dialog box.

If you have finished configuring all of your LC devices, go to “Closing the Foundation 
Application” on page 66.
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Surveyor MS Pump Plus Configuration Settings

During normal operation, the Surveyor MS Pump Plus communicates with the data system 
computer through an RS-232 link. Before you configure the pump device driver, connect the 
pump to the data system computer. If your LC system contains two pumps, connect both 
pumps to the data system computer.

 To specify the configuration settings for the Surveyor MS Pump Plus

1. Ensure that the pump is connected to the data system computer and powered on.

2. For a dual-pump system, ensure that pump 2 is powered off.

3. In the Configured Devices list, double-click the Surveyor MS Pump Plus icon.

The Surveyor MS Pump Plus dialog box appears (see Figure 41).

Figure 41. Surveyor MS Pump Plus dialog box

4. If two pumps are connected to the data system computer, make sure that the appropriate 
pumps are selected in the Pump 1 and Pump 2 area.
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You can use two pumps of the same pump type to perform two-dimensional 
chromatography or high-pressure gradient mixing.

5. Click OK to close the dialog box.

Surveyor MS Pump Configuration Parameters

Table 11 provides descriptions of the parameters in the Surveyor MS Pump Configuration 
dialog box.

Table 11. Surveyor MS Pump Plus Configuration dialog box parameters 

Parameter Description

Serial number Lists the serial number stored by the Surveyor MS Pump Plus.

Status Displays the pump’s status. The states are Not Connected or Connected.

Communication Port Displays the type of communication port on the data system computer where the pump is 
connected.

Stroke Count Displays the total stroke counts for the pump’s pistons.

Pump Type Displays the pump type: Thermo Pump.

Configuration Displays Quaternary. 

Firmware Version Displays the firmware version.

Use Leak Sensor When this check box is selected, the leak sensor is in use.
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Surveyor LC Pump Plus Configuration Settings

The Surveyor LC Pump communicates with the data system by way of an Ethernet 
connection. To make this connection, connect the Ethernet cable to the Ethernet port on the 
back of the pump and to the Ethernet switch. The unit ID setting on the back panel of the 
pump must match the stack address in the configuration.

 To specify the configuration options for the Surveyor LC Pump Plus

1. In the Configured Devices list, double-click the Surveyor LC Pump icon.

The Surveyor LC Pump dialog box appears (see Figure 42).

Figure 42. Surveyor LC Pump dialog box

2. Make the following entries and selections:

• From the Pressure Units list, select the unit of measurement that you want to use to 
display the backpressure of your system.

• In the Stack Number box, type an appropriate value. 

The value must match the Unit ID setting on the back panel of the Surveyor 
LC Pump.

• If you want sequence runs to pause following a degasser error, select the 
Pause Sequence Following Degasser Error check box.

3. Click OK to exit the Surveyor LC Pump dialog box.

Note  1 MPa = 10 bar = 145 psi 
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Surveyor LC Pump Plus Configuration Parameters

Table 12 describes the configuration parameters for the Surveyor LC Pump Plus.

Table 12. Surveyor LC Pump Plus configuration parameters

Parameter Description

Configuration

Pressure Units Specifies the pressure units for the status display.

The selections are MPa, bar, and psi. 

To convert psi to bar, multiply by 0.0689476. To convert bar to 
psi, multiply by 14.5038.

Stack Number Specifies the unit ID value for the Surveyor LC Pump Plus. The 
unit ID on the back panel of the pump consists of two rotary 
switches. Each switch contains ten positions. The arrow on the left 
switch points to the first digit of the unit ID. The arrow on the 
right switch points to the second digit of the unit ID. 

The rotary switches are set to 01 at the factory. 

Error Handling

Pause Sequence 
following Degasser 
Error

Select this check box to pause the injection sequence when the 
pump detects a degassing error.

Clear this check box if you do not want the injection sequence to 
pause when the pump detects a degassing error.
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Surveyor PDA Plus Detector Configuration Settings

The PDA detector communicates with the Xcalibur data system through an Ethernet 
connection. To make this connection, connect the Ethernet cable to the Ethernet port on the 
back of the detector and to the Ethernet switch. The unit ID setting on the back panel of the 
detector must match the configured stack number. 

 To specify the configuration options for the PDA detector

1. In the Configured Devices list, double-click the Surveyor PDA Plus icon.

The Surveyor PDA Plus Configuration dialog box appears (see Figure 43).

Figure 43. Surveyor PDA Plus Configuration dialog box

2. In the Stack Number box, type the appropriate number (unit ID).

3. Click OK to close the Surveyor PDA Plus Configuration dialog box.

When you have finished configuring the instrument devices, go to the next topic: Closing the 
Foundation Application.
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Surveyor UV/Vis Plus Detector Configuration Settings

The UV/Vis Detector communicates with the data system computer through an Ethernet 
connection.

 To specify the configuration settings for the UV/Vis detector

1. In the Configured Devices list, double-click the Surveyor UV/Vis icon.

The Surveyor UV/Vis Configuration dialog box appears (see Figure 44).

Figure 44. Surveyor UV/Vis Configuration dialog box

2. In the Stack Address box, type the appropriate number (unit ID). The Stack Address 
setting must match the rotary switches on the back panel of the detector.

3. Click OK to close the Surveyor UV/Vis Configuration dialog box.

When you have finished configuring all of your LC devices, go to the next topic: Closing 
the Foundation Application.

Closing the Foundation Application
Before you can open your Thermo Scientific data system, you must close the Foundation 
application.

 To save the instrument configuration and close the Instrument Configuration window

Click Done at the bottom of the Thermo Foundation Instrument Configuration 
window. 

The Windows desktop appears.

Tip  You must close the Instrument Configuration window before you open the 
Xcalibur data system. The two applications cannot be open at the same time.
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Instrument Method Setup

This chapter describes the instrument control parameters for the Surveyor Plus LC devices. It 
does not describe the instrument control parameters for your Thermo Scientific mass 
spectrometer. For information about setting up the data acquisition parameters for a Thermo 
Scientific mass spectrometer, refer to the getting started guide or Help for the mass 
spectrometer.

To automate control of the liquid chromatography devices, you must create an instrument 
method, and then specify the instrument method to be used for each run in an acquisition 
sequence from the Sequence Setup window.

Instrument methods contain the analysis wavelengths, the chromatographic conditions, and 
the autosampler injection parameters, such as the injection mode, required for data 
acquisition.

 To create an instrument method 

1. Open the Instrument Setup window (Xcalibur data system) or equivalent window for 
your Thermo Scientific mass spectrometry application.

2. Specify the instrument method settings for each device.

3. Save the instrument method.

Contents

• Opening the Instrument Setup Window

• Surveyor LC Pump Plus Instrument Method Parameters

• Surveyor MS Pump Plus Instrument Method Settings

• Autosampler Instrument Method Parameters

• PDA Detector Instrument Method Parameters

• Triggering an External Device with the PDA Detector

• UV-Vis Detector Instrument Method Parameters

• Saving the Instrument Method
Thermo Scientific Surveyor Plus User Guide for LC Devices 67



3 Instrument Method Setup
Opening the Instrument Setup Window
Opening the Instrument Setup Window
The Instrument Setup window of the Xcalibur data system is where you create instrument 
methods and access the direct control commands for your instrument devices. If you are 
controlling your LC/MS instrument from another Thermo Scientific mass spectrometry 
application, open the equivalent window.

 To open the Instrument Setup window

1. Start the Xcalibur data system.

2. In the Thermo Xcalibur Roadmap window, click the Instrument Setup icon on the 
Road Map or choose GoTo > Instrument Setup. 

The Instrument Setup window appears (see Figure 45). The view bar on the left side of 
the window contains an icon for each configured instrument device. Clicking the device 
icon opens the view for that device.

Figure 45. Instrument Setup window
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Surveyor LC Pump Plus Instrument Method Parameters
Use the Surveyor LC Pump view to set up the instrument method parameters for the pump.

To set up the instrument method parameters for the Surveyor LC Pump Plus, see these topics:

• Surveyor LC Pump Plus General Page

• Surveyor LC Pump Plus Gradient Program Page

Surveyor LC Pump Plus General Page

Use the General page for the Surveyor LC Pump Plus to identify the mobile phase solvents, 
the LC column, and the operation pressure limits for the pump (see Figure 46).

Figure 46. General page for the Surveyor LC Pump Plus

 To specify the instrument method settings on the General page

1. In the Solvent Name boxes in the Solvents area, type the solvent names.

2. In the Description box in the Column area, type a description of the LC column.

3. In the Pressure Limits area, do the following:

a. In the Min Pressure box, type the minimum operating pressure.

Note  Pressure drops can indicate the following problems:

• Mobile phase in the solvent reservoir bottles has run out.

• A leak has occurred in the flow line or lines.

• An excessive amount of air has entered the pump head assemblies.
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b. In the Max Pressure box, type the maximum operating pressure.

Surveyor LC Pump Plus General Page Parameters

Table 13 describes the parameters on the General page.

Note  The maximum pressure setting is 43.10 MPa, 431.00 bar, or 6258.00 psi. 
Reduce the maximum pressure setting for PEEK fittings to 28 MPa, 276 bar, or 
4000 psi.

1 bar = 14.5 psi = 10 MPa

Table 13. General page parameters for the Surveyor LC Pump Plus

Parameter Description

Solvents

A Solvent Name Specifies the solvent contained in the solvent A reservoir bottle.

B Solvent Name Specifies the solvent contained in the solvent B reservoir bottle.

C Solvent Name Specifies the solvent contained in the solvent C reservoir bottle.

D Solvent Name Specifies the solvent contained in the solvent D reservoir bottle.

Column

Description User-specified description for the LC column.

Pressure Limits

Min Pressure Specifies the minimum operating pressure for the pump. If the 
system pressure falls below this limit, the data system turns off the 
solvent flow from the pump.

Pressure units Minimum Maximum

MPa 0.00 43.10

bar 0.00 431.00

psi 0.00 6258.00

Max Pressure Specifies the maximum operating pressure for the pump. If the 
system pressure rises above this limit, the data system turns off the 
solvent flow from the pump.

The maximum pressure setting must be greater than the 
minimum pressure setting.

Pressure units Minimum Maximum

MPa 1.00 43.10

bar 10.00 431.00

psi 143.00 6258.00
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Surveyor LC Pump Plus Gradient Program Page

Use the Gradient Program page (see Figure 47) to specify the solvent composition and flow 
rate for your chromatographic method.

Figure 47. Example of an isocratic pump program for the Surveyor LC Pump Plus

 To specify the solvent conditions for the Surveyor LC Pump Plus

1. Click the Gradient Program tab.

The Gradient Program page appears (see Figure 47).

2. Type the initial flow rate and the initial solvent composition for your pump program in 
the first time line of the time program table, and then press ENTER.

If you are not creating a gradient program, skip the next step.

Placeholder line

Note  If you set the limit for the maximum pressure to less than 21 MPa, the 
allowable flow rate range is 0.000 to 9.999 mL/min. If you set the maximum pressure 
limit to 21 MPa (215 bar, 3129 psi) or higher, the maximum allowable flow rate is 
5.000 mL/min.
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The first time line in the time program table is set to 0.00 minutes and is uneditable. The 
second time line in the program is a placeholder line and has no effect on the pumping 
conditions.

For example, the pump program shown in Figure 47 produces a proportioned mobile 
phase consisting of 80% methanol and 20% water (v/v). The proportions of the solvents 
remain constant throughout the run. The mobile phase flow rate remains constant 
at 1 mL/min throughout the run.

3. To create a gradient pump method, enter at least two steps in the Gradient Program table. 
For each additional line in the program, type these values:

• A time value in the Time column

• A flow rate in the Flow column

• The solvent percentages for the mobile phase in the solvent columns 

4. Press ENTER.

The last line in the gradient table, which has an * in place of a line number, is a 
placeholder and has no effect on the pump conditions.

Table 14 lists the gradient conditions used to create the gradient profile shown in 
Figure 48.

At 25.01 minutes, the program returns to its initial solvent composition. To equilibrate 
the column prior to the next run, the solvent composition is held at the initial solvent 
composition for a period of 15 minutes.

Table 14. Gradient program

Time (min) Solvent composition

0.00 to 5.00 Held constant at 90:10 water/methanol

5.00 to 25.00 Linear ramp from 10% to 90% methanol 

25.00 to 25.01 Stepped down to initial solvent composition of 
90:10 water/methanol

25.01 to 40.00 Column is equilibrated at the initial solvent composition of 
90:10 water/methanol

Note  When you are performing a sequence of gradient runs, add an equilibration 
step at the end of the Gradient Program.
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Figure 48. Example of a gradient program for the Surveyor LC Pump Plus

Surveyor LC Pump Gradient Program Page Parameters

Table 15 describes the parameters on the Gradient Program page.

Placeholder line

Table 15. Gradient Program page parameters for the Surveyor LC Pump Plus  (Sheet 1 of 2)

Parameter Description

Graph

Displays the percent composition of solvents A, B, C and D as a function of time.

Table

Specifies the gradient steps. The table can contain up to 80 rows. The solvent composition boxes are interactive. After 
you type a value in column A and press ENTER or click another box, the value in column B changes to maintain a 
total of 100%, and so on. The solvent composition changes linearly between time points.

Time (min) Specifies the time duration for each gradient step. The initial time is always 0 minutes. 

Range: 0 to 655.35 minutes
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Surveyor MS Pump Plus Instrument Method Settings
Use the Surveyor MS Pump Plus view in the Instrument Setup window to specify the 
chromatographic conditions for your instrument method.

To open the Surveyor MS Pump Plus view, click the Surveyor MS Pump Plus icon in the 
view bar of the Instrument Setup window.

To set up the chromatographic conditions, see these topics:

• Specifying the Chromatographic Conditions for a Single-Pump System

• Programming the Pumps in a Dual-Pump System

Specifying the Chromatographic Conditions for a Single-Pump System

To specify the chromatographic conditions for a single-pump system, follow these procedures 
in order:

1. Setting Up the Pump General Parameters 

2. Setting Up the Gradient Program

Setting Up the Pump General Parameters

Use the Pump General page to specify the solvents that the pump uses to create the mobile 
phase and operating conditions for the pump (see Figure 49).

Flow (mL/min) Specifies the flow rate. 

Range: 0.000 to 9.999 mL/min

%A Specifies the percent composition of solvent A for each time point.

%B Specifies the percent composition of solvent B for each time point.

%C Specifies the percent composition of solvent C for each time point.

%D Specifies the percent composition of solvent D for each time point.

Table 15. Gradient Program page parameters for the Surveyor LC Pump Plus  (Sheet 2 of 2)

Parameter Description

Tip  After you specify the solvents that make up the mobile phase, you can switch back 
and forth between the Pump General and Gradient Program pages.
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Figure 49. General page for the Surveyor MS Pump Plus

When you connect two pumps to the data system computer, you must specify the general 
parameters for both pumps. The autosampler triggers the gradient program for Pump 1 at the 
start of a run. Pump 1 triggers the gradient program for Pump 2 at a user-specified time 
during the run (see “Programming the Pumps in a Dual-Pump System” on page 84). 

The Instrument Method report attached to the raw file contains the values that you select or 
enter on this page. You can access this report in the Qual Browser view by choosing 
View > Reports > Instrument Method.

Note  You can use a dual-pump system to perform two-dimensional chromatography or to 
create a high-pressure gradient.
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 To specify the parameters on the Pump General page

1. Open the view for your pump. 

For information about opening the device views from the Xcalibur 2.1.x data system, see 
“Opening the Instrument Setup Window” on page 68.

The pump view includes a Pump 1 area for a single-pump system or a Pump 1 area and a 
Pump 2 area for a dual-pump system.

2. On the Pump General page, specify the parameters as follows:

a. In the Name box, use the default label (Pump 1 for a single-pump system) or type a 
label. 

The label can be up to 16 alphanumeric characters. The data system uses this label 
for the pump view on the Status page of the Information view.

b. In the Comment box, type additional information about the chromatographic 
method (for example, the specifications for the liquid chromatography column).

c. Identify the solvents that make up the mobile phase. 

All of the solvent check boxes are selected by default. Clearing a solvent check box 
makes the solvent unavailable on the Gradient Program page.

In the boxes to the right of the solvent check boxes, type the names of the solvents 
that make up the mobile phase. 

• In the Operating Mode list, the only selection for the Surveyor MS Pump Plus is Low 
Pressure.

d. In the Start Settings list, select how the system is triggered to start a run: Surveyor AS 
Autosampler Injection Logic or Manual. 

To trigger a run when the autosampler makes an injection, select Surveyor AS 
Autosampler Injection Logic. 

e. In the Method Finalizing list, select the ending conditions for the run. 

• For a gradient method, do one of the following:

– Select First Line Conditions to return the mobile phase conditions to the 
first line of the gradient program following the last time line in the gradient 
program table. 

– Select Last Line Conditions so that the mobile phase conditions remain at 
those of the last time line in the gradient program.

• For a shutdown method that turns off the solvent flow at the end of a run, select 
Stop after the End.

f. In the Min Pressure (bar) box, type or select the minimum operating pressure for the 
pump.

Note  The Idle Settings list is available for a dual-pump system in the Pump 2 
area of the Pump General page.
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An appropriate minimum pressure setting prevents the pump from operating when 
the solvent reservoirs have run dry or the system plumbing has developed a leak. 
Running the pump without solvent quickly ruins the piston seals. Select a value that 
is well below the typical operating pressure for your application. In the event that the 
pressure falls below this limit for more than one minute, the pump automatically 
stops and sends an error message to the computer.

The range is 0 to 400 bar (5800 psi) with a default value of 0 bar.

g. In the Max Pressure (bar) box, type or select the maximum operating pressure for the 
pump.

An appropriate maximum pressure setting prevents the pump from operating with a 
restriction on the outlet side of the pump. Excess pressure can damage the HPLC 
column and any other component between the restriction and the pump. Select a 
value that is well above the typical operating pressure for your application, but also 
below the pressure that can damage your system. If the pressure rises above this limit, 
the pump automatically stops and sends an error message to the computer.

The range is 0 to 400 bar (5800 psi) with a default value of 400 bar.

h. In the Pressure Stability (bar) box, type or select an appropriate pressure stability 
value from 1 to 100. 

The MS pump sends a Ready signal when the system pressure reaches this limit. A 
lower value requires greater pressure stability before the pump becomes ready. A 
higher value is more forgiving of pressure pulsations. 

i. In the Pressure Units list, select the pressure units for the pressure readback.

Thermo Pump General Page Parameters

Table 16 describes the parameters on the General page.

Note  1 bar = 14.5 psi

Table 16. Thermo pump method parameters  (Sheet 1 of 3)

Parameter Description

Name Identifies the pump on the pump view of the Status page of the Info view.

The text string can consist of up to 16 alphanumeric characters.

Comment User text that provides additional information. The text string can consist of up to 
255 alphanumeric characters.

Solvent A, B, C, and D 
check boxes and 
adjacent boxes

When these check boxes are selected, the associated solvent column on the Gradient 
Program page is available. Select the check boxes corresponding to the solvent bottles to be 
used to create the mobile phase. Type a description of the solvent in the adjacent box.

Clearing the check box associated with a solvent (A, B, C, or D) makes the solvent column 
unavailable on the Gradient Program page.
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Operating Mode Specifies the operating mode for the pump. The selection is (0~7000 PSI).

Start settings Specifies the device that triggers the start of a run and the run synchronization signals 
between the pump and the autosampler. 

The selections are as follows:

Surveyor AS injection 
logic

At the start of a run, the Surveyor Autosampler Plus waits for the 
pump to issue the Pump Ready and the Release Injection signal 
before making an injection. The pump then waits for the Start 
gradient signal from the autosampler before starting the pump 
program.

When you use this injection logic, set up the Surveyor 
Autosampler Plus as the start instrument that triggers the run.

Manual At the start of a run, the pump program starts immediately.

When you use this injection logic, set up the pump as the start 
instrument.

Min Pressure Specifies the minimum operating pressure of the pump. If the system pressure falls below 
this level for more than one minute, the data system triggers turns off the mobile phase flow.

Default: 0 bar

Max pressure Specifies the maximum operating pressure of the pump. If the system backpressure rises 
above this level for more than one minute, the data system triggers the pump to turn off the 
mobile phase flow.

Default: 400 bar

Pressure Stability Specifies the stability condition required for the pump to go into a Ready state. A lower 
value requires greater pressure stability before the pump state goes to Ready. A higher value 
is more forgiving of pressure pulsations.

Default: 10

The range depends on the pressure units selection.

Units Range

psi 1 to 1450

MPa 1 to 10

bar 1 to 100

Table 16. Thermo pump method parameters  (Sheet 2 of 3)

Parameter Description
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Setting Up the Gradient Program

The pump contains a built-in solvent proportioning assembly that is capable of proportioning 
up to four solvents to create binary, tertiary, and quaternary mobile phases. This capability 
reduces the need to make premixed mobile phases. You can run the pump in either the 
isocratic mode or the gradient mode. In the isocratic mode, you maintain the same 
proportions of solvent throughout the run.

Use the Gradient Program page to specify the solvent composition and flow rate for your 
chromatographic method.

The Gradient Program page contains a gradient table with time lines for the solvent 
composition and flow rate, and an interactive view that displays a graphical profile of the 
solvent gradient or flow rate gradient.

Each row in the gradient table defines the solvent composition and flow rate for a specific 
time point. The solvent composition columns (A%, B%, C%, and D%) work interactively 
with each other, maintaining a total solvent composition of 100%. 

Between time points, the solvent composition changes linearly, whereas the flow rate changes 
as a discontinuous step-function.

The gradient table can contain 2 to 398 time lines.

 To set up the gradient program for the Surveyor MS Pump Plus

1. Open the view for your pump.

2. Specify the general pump parameters (see “Specifying the Chromatographic Conditions 
for a Single-Pump System” on page 74).

Pressure Units Specifies the units for the pressure readout. 

Selections: PSI and MPa

1.00 MPa = 10.0 bar = 145 psi

Idle Settings (Pump 2 
of a dual-pump system)

Specifies the conditions for Pump 2 while it is waiting to be triggered by Pump 1.

Default: Standby

Selections: Standby, First Line Conditions, and Last Line Conditions

In the Standby mode, the pump remains in the Idle state.

Table 16. Thermo pump method parameters  (Sheet 3 of 3)

Parameter Description

IMPORTANT      The gradient table must contain at least two time lines. For an isocratic 
gradient program, the two time lines specify the same solvent composition and flow rate.
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3. Click the Gradient Program tab.

The Gradient Program page appears (see Figure 50). The columns that represent the 
solvents selected on the Pump General page are available for editing.

Figure 50. Gradient Program page

4. For time = 0.00, do the following:

a. Type the initial solvent composition in the A%, B%, C%, and D% columns. For 
each solvent, after you type the percent composition, press ENTER or click another 
box in the gradient program table.

The first row in the gradient program table is set to 0.00 min and is uneditable. As 
you change the percent composition for each solvent, the data system maintains a 
total solvent composition of 100%.

b. Type the initial flow rate in the μL/min column, and then press ENTER or click 
another box in the gradient program table.

The minimum flow rate setting depends on the start setting for the gradient program 
as follows:

• When you select Surveyor AS Injection Logic or Manual and the Home Before 
Run check box, the minimum flow rate is 10.0 μL/min. 

• When you select Manual and leave the Home Before Run check box cleared, the 
minimum flow rate is 0.0 μL/min.

The maximum flow rate setting is 2000 μL/min for the Surveyor MS Pump Plus.
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5. For an isocratic separation method, do the following on the Gradient Program page for 
the Surveyor MS Pump Plus:

a. Double-click the Time column in the second row of the gradient program table, and 
then type a time value in this cell.

The time range is 0.01 to 655.00 minutes.

If the time value for the second time point is longer than the data acquisition time for 
the PDA detector or the MS detector, the data system waits for the gradient program 
to finish before proceeding to the next row in the acquisition sequence.

b. Type the same values for the solvent composition and the flow rate that you specified 
for the initial time point. Press ENTER to accept the values.

c. Verify the gradient program in the Solvent Gradient view (see Figure 51).

Figure 51. Isocratic gradient program

IMPORTANT      You must specify the flow rate and solvent composition for at 
least two time lines. 

Solvent Gradient view The program must contain at 
least two time lines.
Thermo Scientific Surveyor Plus User Guide for LC Devices 81



3 Instrument Method Setup
Surveyor MS Pump Plus Instrument Method Settings
6. For a gradient separation method, do the following:

a. For each row in the program, type the solvent composition and the flow rate, and 
then press ENTER. 

The pump program can contain from 2 to 398 rows (time lines). The last row in the 
gradient program is a placeholder and has no effect on the pump conditions. The last 
row does not have a time entry in the Time column.

The flow rate range is the same as for an isocratic run (see step 4b on page 80). To 
produce a stable gradient, enter a flow rate of at least 25 μL/min.

b. To return the solvent conditions to those specified in the first line of the gradient 
program, select First Line Conditions in the Method Finalizing list. First Line 
Conditions is the default selection.

Figure 52 shows the gradient program entries for the gradient program in Table 17. 
After 30 minutes the gradient program returns to the first line conditions for the 
remainder of the run. To equilibrate the LC column at the first line conditions for 
10 minutes, you must set the run time for the PDA detector or MS detector to 
40 minutes.

Figure 52. Example of a pump gradient program

Tip  If you do not want the detector to acquire data during the column 
equilibration period, you can add an equilibration period to the end of the 
gradient program and make the gradient program time for the pump longer than 
the data acquisition time for the detector.
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Thermo Pump Gradient Program Page Parameters

Table 18 describes the parameters on the Gradient Program page.

Table 17. Gradient program

Time (min) Solvent composition

0.00 to 5.00 Held constant at 90% solvent A /10% solvent B

5.00 to 25.00 Linear ramp from 10% solvent B to 90% solvent B

25.00 to 30.00 Held constant at 10% solvent B /90% solvent B

30.00 to 40.00 Column is equilibrated at the initial solvent composition 
of 90% solvent A /10% solvent B

Table 18. Thermo pump method parameters 

Parameter Description

Gradient table

Each row in the gradient table defines the solvent composition and flow rate for a specific time point. Between time 
points, the solvent composition changes linearly, whereas the flow rate changes as a discontinuous step-function. The 
pump program can contain up to 398 time lines.

Time The time parameter (min box) specifies at what point in the run the associated solvent 
composition and flow rate become effective. The first time line remains set to 0 min. 

A%, B%, C%, and 
D%

The solvent composition parameters (A%, B%, C%, and D% columns) work interactively 
with each other and specify the mobile phase composition at the time point specified in the 
associated Min box. The mobile phase composition changes linearly between two 
consecutive time points. 

Default: 100% A

μL/min The μL/min box specifies the flow rate of the mobile phase at the time specified in the 
associated Time box. 

Default: 10 μL/min 

P2 (Dual-pump 
system)

For a dual-pump system, the time line position of the ball in the P2 column specifies the 
time when Pump 1 triggers Pump 2.

Graph view

Type of View Select Solvent Gradient to view the solvent gradient profile created by the pump program. 
Select Flow Gradient to view the flow rate changes created by the pump program.

The Gradient Profile area graphically displays the values entered in the pump program. The 
y axis represents percent composition or flow rate and the x axis represents time in minutes. 
Each solvent is color-coded for better visualization of the programmed gradient.
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Programming the Pumps in a Dual-Pump System

 To program the pumps in a dual-pump system

1. On the Pump General page, do the following:

a. Follow the instructions in “Setting Up the Pump General Parameters” on page 74.

b. In the Pump 2 area, select the Idle settings for the pump that you configured as the 
sample pump (Pump 2) as follows:

In the Idle Settings list, select the solvent conditions for Pump 2 before it starts its 
gradient program:

• If you want Pump 2 to remain idle until Pump 1 sends the start signal, select 
Standby.

• If you want Pump 2 to pump solvent at the solvent composition and flow rate 
specified in the first line of its gradient program until Pump 1 sends the start 
signal, select First Line.

• If you want Pump 2 to pump solvent at the solvent composition and flow rate 
specified in the last line of its gradient program until Pump 1 sends the start 
signal, select Last Line.

c. Specify the remaining parameters for Pump 2.

2. On the Gradient Program page (see Figure 53), do the following:

a. To specify the gradient programs for both pumps, follow the instructions in “Setting 
Up the Gradient Program” on page 79.

b. In the Pump 1 area, in the P2 column, select the time line that corresponds to the 
time that you want the start pump to trigger the sample pump.

To select the trigger time for Pump 2, click the appropriate row in the P2 column. 
The  button appears in the P2 column.

Figure 53. Gradient page for a dual-pump system

At 1.00 minute into the run, Pump 1 triggers the start of the 
Pump 2 gradient program.
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Autosampler Instrument Method Parameters
Use these three pages of the Surveyor AS view to specify the injection settings, the 
temperatures of the controlled temperature zones, the solvents contained in the wash bottle 
and the autosampler’s 16 mL reservoir bottles, and any external events triggered by the 
autosampler.

• Surveyor AS Method Page

• Reservoir Content Page

• Timed Events Page for the Autosampler

For information about the Sample Preparation page, see Chapter 4, “Sample Preparation 
Routines.” 

Surveyor AS Method Page

Use the Surveyor AS Method page to set the injection and the temperature control parameters 
for the autosampler (see Figure 54). 

Figure 54. Surveyor AS Method page
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 To specify the injection and temperature control settings for your instrument method

1. Select the injection mode:

• If you want to vary the volume of your sample injections, select the Partial Loop 
option. 

• If you want a high degree in injection-to-injection precision, select the Full Loop 
option. When you select Full loop, the Injection Volume (μL) box becomes 
unavailable.

• If you have a limited amount of sample, select the No Waste option. When you select 
No Waste, the Loop Loading Speed (μL/s) box becomes available.

2. For the No Waste injection mode, type or select a loop loading speed in the Loop Loading 
Speed box. 

For most applications, keep the loop loading speed at its default value.

3. For the Partial Loop and No Waste injection modes, type or select an injection volume in 
the Injection Volume box. 

The injection volume range depends on the syringe size (see “Injection Volume Range” 
on page 91). 

4. In the Needle Height from Bottom (mm) box, type or select the height from the bottom 
of the vial or well that the needle of the autosampler descends to before withdrawing 
sample from the vial/well location. 

The default value is 2 mm and the range is 0.1 to 18 mm. Entering a lower value causes 
the needle to descend closer to the bottom of the vial or well. The standard 1.8 mL vials 
supplied with the autosampler have a depth of approximately 20 mm. 

Figure 13 on page 15 shows the needle descending to a depth of 2 mm from the bottom 
of a standard 1.8 mL vial.

5. In the Syringe Speed (μL/s) box, keep the syringe speed at its default value (8 μL/s for the 
250 μL concentric syringe) for most applications. 

If you see the sample in the needle tubing break up as the autosampler withdraws sample 
from a vial or well location into the needle tubing, adjust the syringe speed.

6. In the Flush Volume (μL) box, type or select a volume from 0 to 6000 μL or keep the 
value at its default of 400 μL.

7. In the Flush/Wash Source list, select a flush/wash solution.

For most applications, select Bottle (wash bottle). If you select one of the reservoir vial 
locations as your flush/wash source, make sure that you load the autosampler with a 
reservoir vial.

Note  For more information about the injection modes, see “Injection Modes” on 
page 19.
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For information about the location of the 16 mL reservoir vials, see “Tray Compartment” 
on page 5. For information about specifying the contents of the reservoir vials and the 
wash bottle, see “Reservoir Content Page” on page 92.

8. In the Wash Volume (μL) box, keep the wash volume at its default value of 0 μL. 

To wash the exterior of the needle after each injection, type a value from 1 to 6000 μL in 
the Wash Volume box.

9. In the Flush Speed (μL/s) box, set a flush speed appropriate for the flush solvent:

• If you are using a flush solvent of low viscosity such as methanol, keep the flush speed 
at its default (100 μL/s for the 250 μL concentric syringe) 

• If you are using water or a methanol/water mixture as the flush solvent, reduce the 
flush speed.

10. In the Post-Injection Valve Switch Time (min) box, keep the time value at its default of 
0 minutes for most applications. This leaves the sample loop in the inject position during 
the entire run, allowing ample rinsing of the sample loop between injections.

11. In the Tray Temperature Control area, to control the temperature of the tray 
compartment, select the Enable Tray Temperature Control check box. Then type an 
appropriate temperature from 0 to 60 °C in the Temperature box.

12. In the Column Oven Control area, to control the temperature of the LC column, select 
the Enable Column Oven Control check box. Then type an appropriate temperature 
from 5 to 95 °C in the Temperature box. Controlling the temperature of the LC column 
increases the reproducibility of the chromatographic retention times.

Autosampler Method Page Parameters

Table 19 describes the parameters on the Surveyor AS Method page.

The autosampler ships with a 250 μL concentric plunger syringe, but you can replace this 
syringe with a 100 or 500 μL concentric plunger syringe or a 2500 μL single plunger syringe.

The injection volume range and the syringe speeds depend on the syringe size as described in 
these topics:

• Injection Volume Range

• Syringe and Loop Loading Speeds for Injections

Tip  If you hear a grinding noise from the autosampler as it performs a flush, lower the 
flush speed.
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Table 19. Autosampler Method page parameters  (Sheet 1 of 3)

Parameter Description

Injection Volume (μL) Specifies the sample volume that the autosampler loads into the sample loop.

The default value and the range depend on the syringe size (see “Injection Volume Range” 
on page 91).

Needle Height from 
Bottom (mm)

Specifies the height from the bottom of the vial or well where the needle withdraws liquid 
(see Figure 13 on page 15).

Range: 0.1 to 18.0 mm
Default: 2 mm

Syringe Speed (μL/s) Specifies the rate at which the syringe withdraws liquid from a tray vial or a plate well. 

The default value and the range depend on the syringe size (see “Syringe and Loop Loading 
Speeds for Injections” on page 91).

Flush Volume (μL) Specifies the volume of liquid that the autosampler flushes through the inside of the needle, 
the injection port, and the transfer tube. During a flush cycle, the injection valve is in the 
inject position to prevent the flush solvent from entering the sample loop. 

To reduce carryover, increase the flush volume. When the specified flush volume exceeds the 
syringe capacity, the autosampler takes multiple draws from the reservoir or bottle.

Range: 0.0 to 6000.0 μL
Default: 400 μL

Flush/Wash source Specifies the flush/wash source.

Selections: bottle, RV1, RV2, RV3, or RV4
Default: bottle (wash bottle)

Wash Volume (μL) Specifies the volume of liquid used to wash the internal and external surfaces of the needle. 

During a wash cycle, the autosampler lowers the needle into the wash port. When the 
specified wash volume exceeds the syringe capacity, the autosampler takes multiple draws 
from the reservoir vial or wash bottle.

Range: 0.0 to 6000.0 μL
Default: 0 μL
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Flush Speed (μL/s) Specifies the rate at which the syringe draws flush solvent into its chamber and expels flush 
solvent through the needle during a flush cycle. 

Syringe type Default Range

Concentric dual-plunger 1.65 to 661.38 μL/s 100.0 μL/s

Standard single-plunger 8.27 to 330.85 μL/s  82.71 μL/s

IMPORTANT      A flush speed of 250 μL/s for the 250 μL concentric syringe is the 
maximum flush speed for a solvent of low viscosity such as 100% methanol. If you are 
using a solvent of higher viscosity, reduce the flush speed accordingly. For example, 
because water has approximately twice the viscosity as methanol, if you are using water as 
your flush solvent, lower the flush speed to 100 μL/s. At high flush speeds, viscous 
solvents can cause the autosampler to make a grinding sound.

Post-Injection Valve 
Switch Time (min)

At the default post-injection valve switch time of 0 minutes, the injection valve remains in 
the inject position during the run.

A time value greater than 0.1 minutes specifies the time when the injection valve switches 
from the inject position to the load position at the end of an injection cycle.

To reduce the gradient delay volume for low-flow gradient applications, consider switching 
the injection valve from the inject position to the load position during the run by typing a 
nonzero value in this box. Allow enough time for the mobile phase to backflush the sample 
out of the sample loop. 

Default: 0 minutes
Range: 0 to 999.0 minutes

Loop Loading Speed 
(μL/s)

Specifies the rate at which the autosampler meters the sample into the sample loop for no 
waste injections. During a no waste injection, the autosampler meters the sample through 
the transfer tubing to the injection valve at the specified syringe speed. The injection valve 
then switches to the load position, and the autosampler meters the sample into the sample 
loop at the specified loop loading speed.

This parameter is only available in the No Waste injection mode.

The default value and range depend on the syringe size (see “Syringe and Loop Loading 
Speeds for Injections” on page 91).

Injection Mode 

Partial Loop Select this option if you want to inject variable volumes. 

IMPORTANT      To make precise partial loop injections, limit the maximum injection 
volume to less than half the nominal sample loop size. Because the accuracy of the 
nominal volume of the sample loop is ± 20% (which means that the actual volume of the 
standard 25 μL sample loop is between 20 and 30 μL), for best results, limit the maximum 
injection volume to 10 μL for the standard 25 μL sample loop.

Table 19. Autosampler Method page parameters  (Sheet 2 of 3)

Parameter Description
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Full Loop Select this option when you need a high degree of accuracy. The Injection Volume box is 
unavailable with this selection.

No Waste Select this option when you have a limited amount of sample.

IMPORTANT      For no waste injections, follow these suggestions to optimize 
injection-to-injection reproducibility and minimize baseline disturbances:

• Use a sample loop that is at least 5 μL larger than the injection volume. Because the 
accuracy of the nominal size is ± 20%, use an estimate of 80% for the actual size. 

• Consider matching the chemistry of the sample matrix, the flush solution, and the 
mobile phase. 

• Inject at least 1.0 μL of sample.

Tray Temperature Control

Enable Tray Temp 
Control

Select this check box to enable temperature control for the tray compartment.

In the default instrument method, this check box is clear; temperature control for the tray 
compartment is not enabled.

To maintain a stable temperature, set the temperature to a value that is a least 10 °C above 
or below the ambient room temperature. As a safety feature, a thermostat turns off the 
power to the sample tray if the temperature reaches 65 °C.

Temperature (° C) Specifies the tray temperature.

Default: 30 °C
Range: 0 to 60 °C

Column Oven Control

Enable Tray Temp 
Control

Select this check box to enable temperature control for the column oven.

In the default instrument method, this check box is clear; temperature control for the 
column compartment is not enabled.

Temperature (° C) Specifies the column oven temperature.

To maintain a stable temperature, set the temperature to a value that is a least 10 °C above 
or below the ambient room temperature. As a safety feature, a thermostat turns off the 
power to the column oven if the temperature reaches 110 °C. 

Default: 30 °C
Range: 5 to 95 °C

Table 19. Autosampler Method page parameters  (Sheet 3 of 3)

Parameter Description
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Injection Volume Range

The injection volume for full loop injections is automatically set to the value in the Sample 
Loop Volume box on the Communication page of the Surveyor Autosampler dialog box (see 
“Communication Page” on page 52). 

For partial loop and no waste injections, the minimum injection volume is 0.1 μL. The 
maximum injection volume depends on the syringe size (see Table 20).

For optimal performance, follow these guidelines:

• For no waste injections, do not inject less than 1.0 μL and limit the maximum injection 
volume to 80% of the nominal loop size minus an additional 5 μL. 

• For partial loop injections, limit the maximum injection volume to 40% of the nominal 
loop size. For the standard 25 μL sample loop, limit the maximum injection volume to 
10 μL.

Syringe and Loop Loading Speeds for Injections

During an injection sequence, the inner plunger of the concentric syringe descends, pulling 
liquid from a sample vial or well into the needle tubing. After the autosampler withdraws 
sample, the XYZ arm moves the needle to the injection port. The inner plunger of the 
concentric syringe ascends, pushing liquid through the transfer tubing and into the sample 
loop. A stepper motor controls the speed of the plunger. 

You can specify how fast, in microliters per second, the syringe withdraws liquid from a tray 
vial or plate well, and then expels liquid into the autosampler injection port. The default 
syringe speed and the syringe speed range depend on the syringe size (see Table 21).

The appropriate syringe speed depends on the sample. For viscous samples, use a syringe 
speed lower than the default value to avoid stalling the syringe. For samples of low viscosity or 
surface tension, use a lower syringe speed to prevent the sample bolus from breaking apart 
during the transport process.

Table 20. Maximum injection volume

Syringe size (μL) Maximum injection volume (μL)

100 20

250 125

500 300

2500 1250

Tip  Select the syringe size on the Communication page of the Surveyor Autosampler 
Configuration dialog box. The autosampler ships with a 250 μL concentric syringe.
Thermo Scientific Surveyor Plus User Guide for LC Devices 91



3 Instrument Method Setup
Autosampler Instrument Method Parameters
For no waste injections, you can use a higher syringe speed to push the sample from the 
autosampler injection port to the injection valve and a lower loop loading speed to meter the 
sample into the sample loop. The range for the loop loading speed depends on the syringe size 
(see Table 22).

Reservoir Content Page

Use the Reservoir Content page (see Figure 56) to enter descriptions for the contents of the 
four 16 mL reservoir vials located on the right side of the tray compartment and the wash 
solvent bottle located in the solvent platform at the top of the LC system stack. You can type 
up to 80 characters in each box.

Figure 55 shows the relative size of the 1 liter wash bottle and the 16 mL reservoir vials.

Figure 55. Reservoir vials and wash solvent bottle

Table 21. Syringe speeds for injections

Syringe size 
(μL)

Minimum speed 
(μL/s)

Maximum speed 
(μL/s)

Default speed
(μL/s)

100 0.3 13.2 3.00

250 0.8 33.0 8.0

500 1.6 66.1 8.0

2500 8.2 330.8 25.0

Table 22. Loop loading speeds

Syringe size 
(μL)

Minimum speed 
(μL/s)

Maximum speed 
(μL/s)

Default speed
(μL/s)

100 0.01 13.20 3.00

250 0.04 33.00 8.00

500 0.08 66.11 8.00

2500 0.41 330.80 25.00

Wash bottle

Reservoir vials
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 To specify the solvents in the wash bottle and reservoir vials

1. Click the Reservoir Content tab.

The Reservoir Content page appears (see Figure 56).

Figure 56. Reservoir Content page for the autosampler

2. Identify the solvents contained in the 16 mL reservoir vials and the 1 L wash bottle by 
typing their names in their respective boxes.

Timed Events Page for the Autosampler

You can use the TF terminals (see Figure 57) on the back panel of the autosampler to control 
peripheral devices that the data system does not control.

The TF terminal output signal is LO (Closed) by default. To change the polarity of the TF 
output signal to HI (Open), select the Timed Events Active High check box on the Signal 
Polarity page of the Surveyor Autosampler Configuration dialog box (see “Signal Polarity 
Page” on page 56).

Figure 57. Time function event terminals on the back panel of the autosampler

TF terminals
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Use the Timed Events page (see Figure 58) to specify the timed events for the time function 
terminals (TF1 to TF4). 

Figure 58. Timed Events page for the autosampler

 To control external devices (not controlled by your Thermo Scientific MS application)

1. Click the Timed Events tab.

The Timed Events page appears (see Figure 58).

2. Specify the appropriate timed events in the table.

3. Make the appropriate hardwire connections between the TF terminals on the back panel 
of the autosampler and the external device.

Autosampler Timed Events Page Parameters

Table 23 describes the columns in the timed events table for the autosampler.

Table 23. Autosampler timed events table

Parameter Description

Table of timed events Use this table to set up timed events. 

Time Specifies the time (in minutes) when the autosampler 
TF terminal (TF1 to TF4) signals an event. Time 0.00 is 
defined as the time when the autosampler issues an INJECT 
OUT signal. 

The autosampler issues the specified Timed Event signals after 
issuing the Inject Out signal. 

Default: 0
Range: 0 to 9999.0 minutes

TF1, TF2, TF3, and TF4 Specifies whether the event is on or off at the specified time.
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PDA Detector Instrument Method Parameters
Use the Surveyor PDA Plus Method page to specify the data acquisition settings for the 
detector and to trigger external devices from the detector.

  To program the PDA detector to acquire absorbance data

1. In the view bar, click the Surveyor PDA Plus icon.

The view for the Surveyor PDA Plus Detector appears with the Surveyor PDA Plus 
Method page displayed (see Figure 59). 

Figure 59. Surveyor PDA Plus Method page with the default settings
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2. In the Run Length (min) box, type a run time from 0 to 600 minutes.

3. In the Filter Rise Time (sec) list, select a rise time from 0 to 10.0 seconds.

Rise time is inversely proportional to the amount of baseline noise. If your chromatogram 
contains closely eluting peaks, minimize baseline noise while retaining maximum 
resolution by selecting a rise time that is approximately one-tenth of the narrowest peak’s 
width at half-height (FWHM). Increasing the rise time above this level increases peak 
tailing, which can reduce the resolution of closely eluting peaks.

Figure 60 shows the effect of rise time on peak tailing.

Figure 60. Effect of rise time on peak tailing

4. In the Units area, select the Wavelength/Absorbance option.

5. To collect a wavelength scan, select the Collect Spectra Data check box, and then make 
the following entries and selections:

a. In the Start Wavelength (nm) box, type a starting wavelength from 190 to 799 nm.

b. In the End Wavelength (nm) box, type an ending wavelength from 191 to 800 nm. 
The ending wavelength must be greater than the starting wavelength.

Note  For information about using the Diode/Intensity option to perform 
diagnostics, see “Creating a Display Method” on page 313. Methods that record light 
intensities for the PDA detector have the .spda file extension.

m
AU

Minutes

0.1 s rise time
2.0 s rise time

5.0 s rise time

10.0 s rise time
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c. In the Wavelength Step (nm) box, type a value for the wavelength interval.

The default value is 1 nm. The maximum step size depends on the wavelength range 
defined by the starting and ending wavelengths. The range is 1 to 610 nm for a scan 
from 190 to 800 nm. If you are collecting spectral data for a spectral library, use a 
wavelength step of 1 nm.

d. In the Sample Rate (Hz) list, select a sample rate. 

For optimal integration of the chromatographic peaks, select a sample rate that 
acquires a minimum of 20 points across the baseline width of the narrowest peak of 
interest. For example, if the baseline width of the narrowest peak is 20 seconds, select 
a sample rate of 1 Hz or higher. 

Increasing the sampling rate increases the data file size.

e. In the Filter Bandwidth (nm) box, type a bandwidth. 

Depending on the wavelength range defined by the starting and ending wavelengths, 
the range is the subset of odd integers from 1 to 49 nm. The maximum scan range for 
a particular bandwidth is limited as follows:

• Start Wavelength (minimum) = 190 nm + (bandwidth – 1)/ 2

• End Wavelength (maximum) = 800 nm – (bandwidth – 1)/ 2

Increasing the bandwidth decreases the spectral resolution (see Figure 61).

Figure 61. Spectra of toluene, effect of bandwidth on spectral resolution

1 nm bandwidth

11 nm bandwidth
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6. To collect discrete channel data, select one of the options in the Channels area, and then 
make the following entries:

a. In the Sample Rate list, select a sampling rate (in data points per second). Higher data 
rates for discrete channels do not add significantly to the data file size.

b. For each discrete channel (A, B, and C), type a wavelength from 190 to 800 nm in 
the Wavelength (nm) box and a filter bandwidth in the Filter Bandwidth (nm) box. 

Depending on the discrete wavelength, the acceptable bandwidth range is 1 to 49 nm 
in odd-number increments with 1 nm meaning no filtering. Bandwidth values 
outside the range of the detector are not allowed. For example, for the discrete 
wavelength of 200 nm, the maximum bandwidth setting is 21 nm. At a bandwidth 
setting of 21 nm, the reported absorbance value for 200 nm is a weighted average 
from 190 to 210 nm. A value greater than 21 nm would be outside the lower range 
limit of the detector, which is 190 nm.

For information about the Method page parameters, see these topics:

• PDA Detector Instrument Method Parameters

• Display Method Parameters

• Timed Events Table for the PDA Detector

For information about adding timed events to trigger external devices, see “Triggering an 
External Device with the PDA Detector” on page 104.

PDA Detector Instrument Method Parameters

Table 24 describes the parameters for an instrument method. These parameters are available 
when you select the Wavelength/Absorbance option in the Units area.

Table 24. PDA detector Method page parameters for an instrument method (Sheet 1 of 3)

Parameter Description

Run

Run Length Specifies the time in minutes that the PDA detector acquires data.

Default: 10.00 minutes
Range: 0.00 to 600.00 minutes

At the end of the run time, the PDA detector goes to the Ready for Download state. 

Filter Rise Time Specifies the detector’s response time to the signal in seconds.

The selections are 0.00, 0.10, 0.20, 0.50, 1.00, 2.00, 5.00, and 10.00 seconds.
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Units

Wavelength/
Absorbance 

Displays absorbance spectra with the wavelength in nanometers on the x axis and the 
absorbance in milli-absorbance units (mAU) on the x axis. 

Default: Wavelength/Absorbance. 

Select the Wavelength/Absorbance option for instrument methods.

Spectra (with Wavelength/Absorbance option)

Collect Spectral Data To collect scans having a specific wavelength range (nm), bandwidth (nm), scan rate (Hz), 
and step (nm), select this check box. 

Start Wavelength (nm) Specifies the first wavelength in nanometers of the scan range.

Default: 200 nm
Range: 190 to 799 nm

End Wavelength (nm) Specifies the last wavelength in nanometers of the scan range.

Default: 600 nm
Range: 191 to 800 nm 

The end wavelength must be greater than the start wavelength.

Wavelength Step Specifies the wavelength interval between data points across the wavelength range. 

Default: 1 nm 

The maximum step size is the full width of the scan.

The highest spectral resolution is 1 nm and the lowest resolution is the full width of the 
scan. When you specify a spectral scan from 200 to 300 nm at a step of 10 nm, the PDA 
detector sends 11 scan wavelengths to the data system computer.

Sample Rate Specifies the number of data points per second that the PDA detector sends to the data 
system for each scan wavelength.

For optimal integration of the chromatographic peaks, acquire 20 points across the baseline 
width of the peak.

For the Surveyor PDA Detector Plus, the sample rates are 0.5, 1.0, 2.0, 4.0, 5.0, 10.0, and 
20 Hz.

Table 24. PDA detector Method page parameters for an instrument method (Sheet 2 of 3)

Parameter Description
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Filter Bandwidth Specifies the bandwidth for the scan wavelengths. 

Bandwidth values are limited to the subset of odd integers from 1 to 49. In addition, the 
maximum scan range for a particular bandwidth is limited as follows:

Lower range = 190 nm + (bandwidth – 1) / 2
Upper range = 800 nm – (bandwidth – 1) / 2

The maximum scan range for a bandwidth of 49 nm is 214 to 776 nm.

Note  Wider bandwidths decrease both spectral noise and the resolution of the spectra. In 
general, the detector bandwidth should not exceed 10 percent of the bandwidth at 
half-height of the narrowest spectral feature of interest.

Channels (with Wavelength/ Absorbance Units)

No Channels Specifies that no discrete channel measurements are to be acquired. When you select this 
option, the parameters in the Channels area are unavailable.

One Channel Specifies the acquisition of one discrete channel. The data for Channel A is displayed in the 
bottom view of the Display page in black.

Two Channels Specifies the acquisition of two discrete channels. The data for Channel B is displayed in the 
bottom view of the Display page in red.

Three Channels Specifies the acquisition of three discrete channels. The data for Channel C is displayed in 
the bottom view of the Display page in green.

Sample Rate Specifies the sample rate in Hz for all of the discrete channels selected (see sample rate in the 
Spectra area). 

[Ch. A, B, C] 
Wavelength

Specifies the discrete channel wavelength to be acquired. 

Channel A default: 214
Channel B default: 254
Channel C default: 280

Range: 190 to 800 nm

[Ch. A, B, C] 
Filter Bandwidth

Specifies the bandwidth for the corresponding discrete channel. Bandwidth values are 
limited to the subset of odd integers from 1 to 49. 

Default: 9 nm

Table 24. PDA detector Method page parameters for an instrument method (Sheet 3 of 3)

Parameter Description
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Display Method Parameters

Table 25 describes the parameters for a display method. These parameters are available when 
you select the Diode/Intensity option in the Units area.

Table 25. PDA Method page parameters for a display method  (Sheet 1 of 2)

Parameter Description

Run

Run Length Not applicable

Filter Rise Time Not applicable

Units

Units: Diode/Intensity Specifies the display units for the spectrum plots. 

When you select the Diode/Intensity option, you can view the light intensity detected by 
the photo diodes of the diode array. The x axis corresponds to the photo diode number 
(2 to 511). 

There are 512 diodes in the diode array. Diodes 0 and 1 are not used. Diode 2 corresponds 
to wavelength 190 nm and diode 511 corresponds to 800 nm. This gives a spacing of 
611 nm/510 diodes = 1.2 nm/diode. The PDA detector interpolates the data to give 
integer values.

Spectra (with Diode/Intensity option)

Collect Spectral Data Select this check box to scan a range of diodes.

Start Diode 
(diode num)

Specifies the first diode in the scan range. 

Default: 2
Range: 2 to 510, in increments of 1

Diode 2 corresponds to 190 nm.

End Diode 
(diode num)

Specifies the last diode in the scan range.

Default: 511
Range: 3 to 511, in increments of 1

Diode 511 corresponds to 800 nm.

Diode Step Specifies the interval between data points across the range of diode numbers. 

The selections are 1, 2, 4, 5, or 10 diodes. 

Sample Rate Not applicable
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Timed Events Table for the PDA Detector

Table 26 describes the timed events area at the bottom of the Surveyor PDA Plus Method 
page.

Use the Timed Events area to program actuation of a back panel contact closure as a function 
of either time or the absorbance level from one of the discrete wavelength channels. You can 
use this feature to trigger an external device, such as a fraction collector, and to zero the 
absorbance level during an acquisition run. 

For information about connecting an external device to the PDA detector, refer to the 
Surveyor PDA Plus Detector Hardware Manual.

Channels (with Intensity Units)

No Channels Specifies that no discrete channel measurements are to be acquired. When you select this 
option, the parameters in the Channels area are unavailable.

One Channel Specifies the acquisition of one discrete channel. The data for Channel A is displayed in the 
bottom view of the Display page in black.

Two Channels Specifies the acquisition of two discrete channels. The data for Channel B is displayed in the 
bottom view of the Display page in red.

Three Channels Specifies the acquisition of three discrete channels. The data for Channel C is displayed in 
the bottom view of the Display page in green.

Sample Rate Not applicable

[Ch. A, B, C] 
Diode Number

Specifies the diode that you want the detector to monitor. 

Channel A default: 40
Channel B default: 55
Channel C default: 450

Range: 2 to 511, in increments of 1

Table 25. PDA Method page parameters for a display method  (Sheet 2 of 2)

Parameter Description

Table 26. Timed events table on the Surveyor PDA Plus Method page (Sheet 1 of 2)

Parameter Description

Timed Events

Use this area to add, modify, and remove timed events. You can specify the time when the event occurs, the event 
type, the channel, the absorbance level (mAU), and the delay settings. Click New to open the Timed Events dialog 
box.

Timed Events table This table lists all the events in chronological order. You can add, modify, and remove events 
by double-clicking the event setting you want to modify, or by using the New, Delete, and 
Delete All buttons.
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Time Specifies the time in minutes when the detector triggers the event. The maximum time is 
the data acquisition time specified in the Run Length box (see Figure 59 on page 95). 

Default: 0.00 minutes

Type Specifies an event type: Event Off, Event On, Zero Data, or Level Trigger. 

Use a Level Trigger event to specify the absorbance threshold level for triggering an event. 
When you select a Level type event, you must specify the channel of the event, the 
absorbance level that is to trigger the event, and the delay time that the event is to occur 
after the absorbance level trigger event. 

Use a Zero event to zero the absorbance from the detector.

Channel Note  This list is available if you select Level Trigger in the [Event] Type list.

Specifies the discrete wavelength channel (Channel A, Channel B, or Channel C) that the 
PDA detector monitors to activate the external event.

Level Note  This box is available if you select Level Trigger in the [Event] Type list.

Specifies the absorbance level that triggers the external event. 

Range: –2000 to 4000 milli-absorbance units (mAU)

Delay Note  This box is available if you select Level Trigger in the [Event] Type list.

Specifies the delay time in seconds that is to occur between the activation of the event (by 
the preset absorbance level being exceeded) and the actual change of the event output state 
(at the back panel terminals of the PDA detector). This delay compensates for the time 
interval between, for example, when a compound leaves the detector and when it reaches a 
fraction collector. 

Default: 0 seconds
Range: 0 to 65 535, in increments of 1

Buttons

New Click this button to open the Timed Event dialog box where you can add external events to 
the external events table. 

Delete Click this button to remove an external event from the external events table. Select the 
external event that you want to remove, and then click Delete.

Delete All Click this button to remove all external events from the external events table. To remove all 
events, click Delete All.

Table 26. Timed events table on the Surveyor PDA Plus Method page (Sheet 2 of 2)

Parameter Description
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Triggering an External Device with the PDA Detector
The PDA detector can trigger an external device during a chromatographic run. For example, 
you can program the PDA detector to trigger a fraction collector as an analyte begins to elute 
from the LC column. 

 To add a timed event to the instrument method

1. In the Timed Events area of the Surveyor PDA Plus Method page (see Figure 62), click 
New.

Figure 62. Timed Events area of the Method page

The Timed Event dialog box appears (see Figure 63). 

Figure 63. Timed Event dialog box

2. In the Type list, select an event type. 

The selections are Event Off, Event On, Zero Data, or Level Trigger.

Note  You can also zero the absorbance level for a discrete channel during an acquisition 
run by adding a zero event to the Timed Events table.
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3. In the Time (min) box, type the length of time after the chromatographic run starts that 
the event is to occur. 

The range is 0.00 to the run length time for the detector. The Event Off, Event On, and 
Zero Data event types occur at this time. Because the Level Trigger event type occurs after 
this time is exceeded, do not enter a time value that exceeds the expected time (for 
example, the expected retention time of the analyte that you want a fraction collector to 
collect) of the triggering event. 

The Channel list, Level box, and Delay box are available for the Level Trigger event type. 
For more information about the Level trigger type, see the next procedure.

4. To trigger an external device when the absorbance for a discrete channel reaches a specific 
level, do the following:

a. In the Type list, select Level Trigger.

b. In the Channel list, select the discrete wavelength channel to be used to trigger the 
event. 

The available selections are A, B, or C.

c. In the Level (mAU) box, type a value for the absorbance value that triggers the event.

The default value is 0.00 mAU and the range is –2000 to 4000.00 mAU.

d. In the Delay (sec) box, type a time in seconds. 

The delay time compensates for the time interval between, for example, when a 
compound leaves the detector and when it reaches a fraction collector. The default 
value is 0 and the range is the set of integers from 0 to 65 535.

5. To zero the absorbance level for all the wavelength channels that the detector is 
monitoring at a particular time in the run, do the following:

a. In the Type list, select Zero Data.

b. In the Time box, type the time that you want the absorbance level to be zeroed.

6. Click OK to accept the new event and close the Timed Event dialog box.
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UV-Vis Detector Instrument Method Parameters
In the UV/Vis detector view, use the Method page to set up the instrument method 
parameters for the UV/Vis detector (see Figure 64).

Figure 64. Instrument Setup view for the UV/Vis detector

 To open the UV/Vis Detector view

Click the Surveyor UV/Vis icon on the view bar. 

 To set up the instrument method parameters for the UV/Vis detector

1. In the Rise Time (sec) list, select a rise time from 0 to 10.0 seconds.

Rise time is the response time of the detector, in seconds, to the signal. Increasing the rise 
time decreases the baseline noise; however, setting the rise time to a value greater than 
one-tenth the width of the chromatographic peak at half-height results in peak 
broadening. The one-second default value is appropriate for most LC applications.

Figure 65 shows the effect of rise time on peak tailing.
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Figure 65. Effect of rise time on band broadening

2. In the Data Rate (Hz) list, select a data rate from 4 to 20 points per second.

The optimal data rate depends on the expected baseline width of your chromatographic 
peaks. For optimal integration, acquire a minimum of 20 data points across the baseline 
width of the narrowest peak. For example, if the narrowest chromatographic peak has a 
baseline width of 10 seconds, select a data rate of 2 Hz or higher.

3. To zero the baseline at a specific time point, select the Enable Autozero check box and 
type a time in the Autozero Time (min) box. 

The detector resets its output voltage to zero at this time point.

4. In the Program Type area, select one of the following options: 

• To collect one chromatogram during a run, select the Single Wavelength 
190 to 800 nm option. You can program time wavelength changes in the program 
table.

• To collect two chromatograms in the UV range during a run, select the Dual 
Wavelength UV 190 to 450 nm option. You can program time wavelength changes 
in the program table.

• To collect two chromatograms in the visible range during a run, select the Dual 
Wavelength Vis 366 to 700 nm option. You can program time wavelength changes 
in the program table.

5. To zero the baseline when a programmed wavelength change occurs, select the Zero on 
Wavelength Change check box.

m
AU

Minutes

0.1 s rise time
2.0 s rise time

5.0 s rise time
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The detector does not zero the baseline on the first or last rows of a wavelength program. 
If the wavelength program contains three or more rows, the detector zeroes the baseline 
on the second row and all successive rows until it reaches the last row. The detector zeroes 
its output signal even if the same wavelength is listed in the second through second to last 
rows of the table.

UV-Vis Detector Instrument Method Parameters

Table 27 describes the parameters on the Method page for the UV/Vis detector.

Table 27. UV/Vis detector method parameters  (Sheet 1 of 2)

Parameter Description

Rise Time Specifies the filtering in the time domain.

Default: 2.0 seconds

Selections: 0.0, 0.01, 0.1, 0.2, 0.5, 1.0, 2.0, 3.0, 4.0, and 5.0 seconds

Data Rate Specifies the number of points per second acquired per wavelength.

Default: 10 Hz

Selections: 20, 10, 6.67, 5, and 4 Hz

Enable Autozero

Enable Autozero When this check box is selected, the detector zeros the absorbance data at the specified time.

Autozero Time (min) Specifies the time when the detector zeros the absorbance data.

Default: 0 minutes
Range: 0 minutes to the run length

Program Type

Single Wavelength 
UV/Vis 190–800 nm

Specifies that the detector is to acquire data on one wavelength channel. The acquisition 
wavelength is time programmable.

Dual Wavelength UV 
190–365 nm

Specifies that the detector is to acquire data on two wavelength channels in the UV range. 
The acquisition wavelengths are time programmable.

Dual Wavelength Vis 
366–700 nm

Specifies that the detector is to acquire data on two wavelength channels in the visible range. 
The acquisition wavelengths are time programmable.

Other options

Zero on Wavelength 
Change

When this check box is selected, the detector zeros the absorbance data at the times specified 
in the Time column for rows 2 through the last time line.

Programmable wavelength table

Time Specifies the time when the detector is to start monitoring the wavelength or wavelengths 
listed in the Wavelength 1 and Wavelength 2 columns.
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Saving the Instrument Method
The following procedure applies only to the Xcalibur data system. For other 
Thermo Scientific mass spectrometry applications, refer to the Help. 

 To save the instrument method

1. Choose File > Save As. 

The Save As dialog box appears (see Figure 66).

Figure 66. Save As dialog box, showing the file extension for an instrument method

Wavelength 1 Specifies the wavelength that the detector is to start monitoring at the time specified in the 
Time column.

To view the chromatogram for this wavelength in Qual Browser, select Wavelength 1 in the 
Range list for the Chromatogram window.

Wavelength 2 Specifies the wavelength that the detector is to start monitoring at the time specified in the 
Time column.

To view the chromatogram for this wavelength in Qual Browser, select Wavelength 2 in the 
Range list for the Chromatogram window.

Table 27. UV/Vis detector method parameters  (Sheet 2 of 2)

Parameter Description
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2. Browse to the following folder:

drive:\Xcalibur\methods 

3. In the File Name box, type a file name.

4. Click Save. 

The File Summary Information dialog box appears (see Figure 67).

Figure 67. File Summary Information dialog box

5. In the Description box, type a description of the method file.

6. Click OK. 

If the Authorization Manager – Comment check box is selected, the File Save – Audit 
Trail dialog box appears (see Figure 68).
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Figure 68. File Save – Audit Trail dialog box

7. In the Comment box, type a comment concerning the changes you made to the 
instrument method.

8. Click Continue to close the File Save – Audit Trail dialog box and save the instrument 
method.
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Sample Preparation Routines

Sample preparation routines are part of the instrument method. Use the Sample Preparation 
page to create a multitask routine, containing up to 512 tasks. A task consists of a sample 
preparation operation and its associated parameters. 

The ability to add 512 tasks to a sample preparation routine gives you considerable flexibility; 
however, the arrangement of the tasks in the task list must follow a logical order. For example, 
you cannot add a task that deposits liquid before you add a task that draws liquid. In addition, 
if you are using the 250 μL dual-concentric syringe that ships with the autosampler, you must 
follow an additional set of rules that maintain the proper positioning of the inner and outer 
plungers of the syringe.

Opening the Sample Preparation Page
The Sample Preparation page is part of the instrument method.

 To open the Sample Preparation page

1. Open the autosampler view from your data system.

2. Click the Sample Preparation tab. 

The Sample Preparation page appears (see Figure 69). For a new method, in the Prep 
Operations list, the Deposit Liquid in Sample task is highlighted, and its parameters are 
listed below the Add To Task List button.

Contents

• Opening the Sample Preparation Page

• Sample Preparation Rules

• Building the Sample Preparation Routine

• Sample Locations for the Sample Preparation Tasks

• Draw, Eject, and Transfer Volumes for Sample Preparation Tasks

• Syringe Speed Range for Sample Preparation Tasks

• Sample Preparation Routine Example
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Figure 69. Sample Preparation page of the Surveyor Autosampler view

Deposit liquid in sample task parameters Empty task list
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Sample Preparation Rules
The maximum volume that the autosampler can deposit, draw, or transfer during a sample 
preparation task depends on the syringe type, the task requested, and the previous step in the 
sample preparation method. 

Table 28 categorizes the sample preparation tasks into three groups based on whether the task 
uses the inner bore only, the outer bore only, or either bore of the dual-plunger concentric 
syringe. For information about the dual-plunger concentric syringe, see “Interchangeable 
Syringe” on page 14.

For the 250 μL concentric syringe, these rules restrict the arrangement of the tasks in the 
sample preparation list:

• For tasks performed with the inner bore of the dual-concentric syringe, the maximum 
volume (sample + air bubble) that the autosampler can draw, deposit, or transfer is 
limited to the nominal size of the syringe, 250 μL. 

• For tasks performed with either bore, if the sum of the requested volume 
(liquid + air bubble) plus any volume left in the needle tubing from a previous step is 
less than the nominal syringe size, the dual-plunger concentric syringe uses the small 
bore. If this volume is greater than the nominal syringe size, the syringe uses the outer 
bore.

• For tasks performed with the outer bore of the dual-plunger concentric syringe, the 
maximum volume (sample + air bubble) that you can draw, deposit, or transfer is limited 
to 500 μL, except for the Wash Needle and Flush to Waste tasks.

• Crossover between bores is not allowed. This means that you cannot add a task that uses 
the outer syringe bore immediately following a task that uses the inner syringe bore. 
To switch from the inner bore to the outer bore of the syringe, you must insert a 
Flush to Waste step or a Wash Needle step. These tasks home the position of the syringe 
plungers.

Table 28. Sample preparation tasks arranged in groups according to bore usage

Inner bore only Outer bore only Inner or outer bore

Draw from Sample Mix at Sample Draw from Reservoir

Transfer from 
Sample to Sample

Mix at Reservoir Deposit Liquid in Sample

Transfer from 
Sample to Reservoir

Wash Needle Deposit Sample in Reservoir

Flush to Waste Transfer from Reservoir to Sample

Transfer from Reservoir to Reservoir
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Building the Sample Preparation Routine
Sample preparation routines are part of the instrument method (see “Autosampler Instrument 
Method Parameters” on page 85). A sample preparation routine consists of a list of tasks 
performed in order by the autosampler before it makes an injection.

 To build a sample preparation routine

1. Do one of the following:

• To modify an existing sample preparation routine, go to step 2. 

–or–

• To create a new sample preparation routine, go to step 3.

2. Import the sample preparation routine from a stored instrument method as follows:

a. Click Import. 

The Open files dialog box appears.

b. Browse through your Methods folder and select the appropriate instrument method. 
Then click Open. 

Only the sample preparation task list contained in the stored instrument method is 
imported into the current instrument method.

3. For each task that you want to add to the sample preparation routine, do the following:

a. In the Prep Operations list, select a task.

Table 29 lists the thirteen tasks that you can use to create a sample preparation 
routine. When you select a task, the parameters available for the task appear below 
the Add to Task List button.

b. Make the appropriate selections and entries for each task parameter.

c. Click Add To Task List. 

The task appears in the task list in the Method area. 

Tip  The syringe position and nominal volume limit the task order and transfer 
volume:

• If the previous task used the small bore of the syringe, you must add a 
Flush to Waste or a Wash Needle task before you can add a task that requires 
the use of the large bore of the syringe. These tasks home the concentric 
syringe plungers.

• If the previous task used the small bore of the syringe, the transfer volume of 
the current task is limited to the nominal syringe size or less. See “Sample 
Preparation Rules” on page 115 for more information.
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4. Edit the task list as needed:

• To remove the last task in the list, click Remove Task.

• To remove a specific task, select the task, and then click Remove Task.

• To clear the entire task list, click Clear All Tasks.

Sample Preparation Parameters

Tip  To save an instrument method, the sample preparation routine must conform 
to the rules described in “Sample Preparation Rules” on page 115.

Table 29. Sample Preparation page  (Sheet 1 of 5)

Parameter Description

Prep Operations

Use this area to select and add tasks to the task list in the Method area. 

You can add up to 512 tasks to a sample preparation routine; however, the arrangement of the tasks in the task list 
must follow a logical order or you will not be able to save the instrument method. For example, a draw task must 
precede a deposit task. In addition, if you are using the 250 μL concentric syringe that comes with the autosampler, 
you must follow an additional set of rules that allow for the proper positioning of the inner and outer plungers of the 
syringe. (See “Sample Preparation Rules” on page 115).

If you are using the 2500 μL, single plunger syringe, to transfer volumes larger than 500 μL, add an optional tubing 
extension assembly to the needle tubing.

Task List Description

Deposit Liquid in 
Sample 

Deposits liquid in a sample vial or well. 

Parameter Reference, range, or selections

Sample Location “Sample Locations for the Sample Preparation Tasks” on page 122

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125

Needle Height Default: 2 mm
Range: 0 to 18 mm

Deposit Liquid in 
Reservoir

Deposit liquids in a reservoir vial. 

Parameter Reference, range, or selections

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Destination 
Reservoir

RV1, RV2, RV3, or RV4

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125
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Draw from Reservoir Draws liquid from a reservoir vial or the wash bottle. 

Parameter Reference, range, or selections

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Source Reservoir RV1, RV2, RV3, RV4, or Bottle

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125

Air Bubble Range: 0 to 10 μL

Draw from Sample Draws liquid from a vial or well. 

Parameter Reference, range, or selections

Sample Location “Sample Locations for the Sample Preparation Tasks” on page 122

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125

Needle Height Default: 2 mm
Range: 0 to 18 mm

Air Bubble Range: 0 to 10 μL

Flush to Waste Flushes the needle tubing and homes the syringe. 

When the concentric syringe plungers are in the home position and the needle tubing is 
flushed, the autosampler can next perform any of the sample preparation tasks, with the 
exception of the deposit tasks. 

Parameter Reference, range, or selections

Volume Range: 100 to 6000 μL

Reservoir bottle, RV1, RV2, RV3, or RV4

Syringe Speed 1.65 to 661.38 μL/s for the concentric syringes 
0.83 to 330.85 μL/s for the 2500 μL standard syringe

Table 29. Sample Preparation page  (Sheet 2 of 5)

Parameter Description
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Mix at Sample Mixes the contents of a vial or well. 

To mix a sample, the autosampler draws a specified volume of the sample into the needle 
tubing at a specified speed, and then ejects the sample back into the same location at a 
specified speed. 

Parameter Reference, range, or selections

Sample Location “Sample Locations for the Sample Preparation Tasks” on page 122

Volume The maximum volume is 490 μL for the concentric syringes and 
1490 μL for the standard 2500 μL syringe. 

Draw Speed The draw or delivery speed range is from 1.65 to 661.38 μL/s for the 
concentric syringes, and from 0.83 to 330.85 μL/s for the standard 
2500 μL syringe.

Delivery Speed

Cycles Range: 1 to 10

Needle Height Default: 2 mm
Range: 0 to 18 mm

Mix at Reservoir Mixes the contents of a reservoir vial. 

Parameter Reference, range, or selections

Volume The maximum volume is 490 μL for the concentric syringes and 
1490 μL for the standard 2500 μL syringe. 

Destination 
Reservoir

RV1, RV2, RV3, or RV4

Draw Speed The draw or delivery speed range is from 1.65 to 661.38 μL/s for the 
concentric syringes, and from 0.83 to 330.85 μL/s for the standard 
2500 μL syringe. 

Delivery Speed

Cycles Range: 1 to 10

Needle Height Default: 2 mm
Range: 0 to 18 mm

Transfer from Reservoir 
to Reservoir

Transfers liquid from one reservoir to another. 

Parameter Reference, range, or selections

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Source Reservoir bottle, RV1, RV2, RV3, or RV4

Destination 
Reservoir

RV1, RV2, RV3, or RV4

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125

Table 29. Sample Preparation page  (Sheet 3 of 5)

Parameter Description
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Transfer from Reservoir 
to Sample 

Transfers liquid from a reservoir vial or the wash bottle to a vial or well. 

Parameter Reference, range, or selections

Sample Location “Sample Locations for the Sample Preparation Tasks” on page 122

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125

Needle Height Default: 2 mm
Range: 0 to 18 mm

Source Reservoir bottle, RV1, RV2, RV3, or RV4

Transfer from Sample 
to Reservoir 

Transfers liquid from a vial or well to a reservoir vial. 

Parameter Reference, range, or selections

Sample Location “Sample Locations for the Sample Preparation Tasks” on page 122

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Destination 
Reservoir 

RV1, RV2, RV3, or RV4

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125

Needle Height Default: 2 mm
Range: 0 to 18 mm

Air Bubble 0 to 10 μL

Transfer from Sample 
to Sample 

Transfers liquid from one vial or well to another vial or well. 

Parameter Reference, range, or selections

Source Sample “Sample Locations for the Sample Preparation Tasks” on page 122

Destination 
Sample

“Sample Locations for the Sample Preparation Tasks” on page 122

Volume “Draw, Eject, and Transfer Volumes for Sample Preparation Tasks” on 
page 123

Syringe Speed “Syringe Speed for Tasks that Can Use Either Plunger” on page 125

Source Vial Needle 
Height 

Default: 2 mm
Range: 0 to 18 mm

Air Bubble 0 to 10 μL

Destination Vial 
Needle Height 

Default: 2 mm
Range: 0 to 18 mm

Table 29. Sample Preparation page  (Sheet 4 of 5)

Parameter Description
120 Surveyor Plus User Guide for LC Devices Thermo Scientific



 4 Sample Preparation Routines
Building the Sample Preparation Routine
Wait Time Pauses the sample preparation routine for a period of time, for example, for a reaction to 
occur. 

Range: 0 to 1000 minutes 

Wash Needle Washes the exterior of the needle with the solvent in a reservoir vial or the wash bottle. 

Parameter Reference, range, or selections

Volume Range: 100 to 6000 μL

Reservoir bottle, RV1, RV2, RV3, or RV4

Button

Add To Task List Use the Add To Task List button to add a task to the sample preparation routine. 

Method

Use the Method area to display the parameters of a task, remove a task, clear all tasks in the task list, or import the 
sample preparation routine from a stored instrument method. 

The Method area consists of the (sample preparation) task list, the Remove Task button, the Clear All Tasks button, 
and the File Name (read only) box and Import (method) button.

File Name box Displays the name of the selected instrument method that contains the sample preparation 
routine that you want to import into the current instrument method.

Buttons

Remove Task Use this button to remove a task from the task list in the Method area. 

Clear All Tasks Use this button to clear all tasks from the task list in the Method area. 

Import Use this button to open the Open dialog box where you can select an instrument method 
with the sample preparation routine that you want to add to the current instrument 
method. 

After you select an instrument method and click Import, the File Name (read only) box 
displays the file name of the instrument method you want to import. 

Table 29. Sample Preparation page  (Sheet 5 of 5)

Parameter Description
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Sample Locations for the Sample Preparation Tasks
For the sample preparation tasks, you can select an absolute or a relative location.

For the Relative Location option, the selections are Current, Current + 1, Current + 2, and 
Current + 3. Current is the sample location in the current sequence row. Current + 1 is the 
next adjacent vial or well location in the tray, and so on. For example, if the vial location in 
the current sequence row is B:1, Current is B:1, then Current + 1 is B:2, and so on.

For the Absolute Location option, you specify an absolute vial or well location. The vial or 
well locations depend on the tray configuration (see Table 30).

Tip  Remember to place a vial at the selected location.

Table 30. Vial and well positions

Tray configuration Vial or well positions

Standard 1.8 mL vials A:1 to E:20

96 Well Plate A:A1 to C:H12

384 Well Plate A:A1 to C:P24
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Draw, Eject, and Transfer Volumes for Sample Preparation Tasks
The maximum volume that the autosampler can deposit, draw, or transfer during a sample 
preparation task depends on the syringe type, the task requested, and the previous step in the 
sample preparation method:

• For tasks performed with the inner plunger of the concentric syringe, the maximum 
volume (liquid + air bubble) that the autosampler can draw, deposit, or transfer is limited 
to the nominal size of the syringe. 

• For tasks performed with the outer plunger of the concentric syringe, the maximum 
volume (liquid + air bubble) that the autosampler can draw, deposit, or transfer is limited 
to 500 μL, except for the Wash Needle and Flush to Waste tasks, which are limited to a 
range of 100 to 6000 μL, and the Mixing tasks, which are limited to a maximum of 
490 μL. 

Table 31 lists the maximum volumes by task.

Table 31. Draw, eject, and transfer volumes for sample preparation tasks  (Sheet 1 of 2)

Task Maximum volume (μL)
with the inner plunger 

Maximum volume (μL)
with the outer plunger 

Draw from Sample Nominal size of the concentric syringe minus the current 
contents (liquid + air bubble) of the needle tubing

N/A

Transfer from Sample 
to Sample

Nominal size of the concentric syringe minus the current 
contents (liquid + air bubble) of the needle tubing

N/A

Transfer from Sample 
to Reservoir

Nominal size of the concentric syringe minus the current 
contents (liquid + air bubble) of the needle tubing

N/A

Mix at Sample N/A 490

Mix at Reservoir N/A 490

Tip  If the ToolTip specifies a range of 0.0 to 0.0, the contents of the needle tubing already 
equals 500 μL or the previous task used the inner plunger of the syringe. If the previous 
task used the inner plunger, insert a Flush to Waste or a Needle Wash task to home the 
syringe.
Thermo Scientific Surveyor Plus User Guide for LC Devices 123



4 Sample Preparation Routines
Syringe Speed Range for Sample Preparation Tasks
Syringe Speed Range for Sample Preparation Tasks
The syringe speed range for sample preparation tasks depends on whether the task can use 
either syringe plunger or only the inner plunger.

If you enter a speed that is invalid for the volume you are transferring, an error message 
appears.

For information about the syringe speed range for the sample preparation tasks, see these 
topics:

• Syringe Speed for Tasks that Can Use Either Plunger

• Syringe Speed for Tasks that Use the Inner Plunger

Wash Needle N/A 6000

Flush to Waste N/A 6000

Draw from Reservoir Nominal size of the concentric syringe minus the current 
contents (liquid + air bubble) of the needle tubing

500 μL minus the current 
contents of the needle tubing

Deposit Liquid in 
Sample

Total contents (liquid + air bubble) of the needle tubing 
from previous steps

Total contents 
(liquid + air bubble) of the 
needle tubing from previous 
steps

Deposit Sample in 
Reservoir

Total contents (liquid + air bubble) of the needle tubing 
from previous steps

Total contents 
(liquid + air bubble) of the 
needle tubing from previous 
steps

Transfer from 
Reservoir to Sample

Nominal size of the concentric syringe minus the current 
contents (liquid + air bubble) of the needle tubing

500 μL

Transfer from 
Reservoir to Reservoir

Nominal size of the concentric syringe minus the current 
contents (liquid + air bubble) of the needle tubing

500 μL

Table 31. Draw, eject, and transfer volumes for sample preparation tasks  (Sheet 2 of 2)

Task Maximum volume (μL)
with the inner plunger 

Maximum volume (μL)
with the outer plunger 
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Syringe Speed for Tasks that Can Use Either Plunger

The syringe speed range is determined by the type of syringe and the volume requested. For a 
concentric syringe, the autosampler can use either the outer or inner plunger to draw liquid 
into or expel liquid from the needle tubing.

For the tasks listed in Table 32, the autosampler uses the following:

• The outer plunger if the volume of liquid + air being transported is greater than the 
nominal syringe size 

• The inner plunger if the volume of liquid + air being transported is less than or equal to 
the nominal syringe size 

Table 33 lists the speed range for the sample preparation tasks that can use either plunger of 
the concentric syringe. 

Table 32. Tasks that can use either syringe plunger

Task

Draw from Reservoir

Deposit Liquid in Sample

Deposit Sample in Reservoir

Transfer from Reservoir to Sample

Transfer from Reservoir to Reservoir

Note  The ToolTips for the speed parameters list a range of allowable speeds. The 
minimum speed listed is valid for only the inner plunger, and the maximum speed listed is 
valid for only the outer plunger of the configured syringe. 

If you enter a volume that triggers the use of the outer plunger and a speed that is valid for 
only the inner plunger, an error message appears when you attempt to add the task to the 
sample preparation list.
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Syringe Speed for Tasks that Use the Inner Plunger

The autosampler uses the inner plunger of the concentric syringe to perform the following 
tasks:

• Draw From Sample 

• Transfer From Sample To Sample 

• Transfer From Sample To Reservoir 

The syringe size determines the default syringe speed and the syringe speed range 
(see Table 34).

Use a syringe speed lower than the default for viscous samples. Also, use a syringe speed lower 
than the default for samples of very low viscosity or surface tension to prevent the sample 
bolus from breaking apart during the transport process.

Table 33. Syringe speed ranges for tasks that can use either syringe plunger

Syringe size 
(μL)

Volume
(liquid + air) 

Minimum speed
(μL/s)

Maximum speed
(μL/s)

Default speed
(μL/s) 

100 ≤ 100 0.33 13.25 3.0

100 >100 1.65 661.38 250

250 ≤ 250 0.83 33.09 8.0

250 >250 1.65 661.38 250

500 ≤ 500 1.65 66.10 8.0

500 >500 1.65 661.38 250

2500 
(standard)

0 to 1500 0.83 331 25.0

Note  You select the size of the syringe by using the Syringe Type list on the 
Communication page of the Surveyor AS Configuration dialog box. 

Table 34. Syringe speeds for tasks that use the inner plunger of the concentric syringe

Syringe size 
(μL)

Minimum speed
(μL/s)

Maximum speed
(μL/s)

Default speed
(μL/s)

100 0.33 13.25 3

250 0.33 33.10 8

500 1.65 66.11 8
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Sample Preparation Routine Example
The following procedure describes how to create a sample preparation routine to dilute 
samples tenfold.

 To add a sample preparation routine that dilutes samples tenfold

1. From the Surveyor AS view, click the Sample Preparation tab.

The Sample Preparation page appears.

2. Open the .meth file that you want to modify.

In step 3 through step 6, you add the sample preparation tasks to the task list.

3. Add a task that transfers an aliquot of sample solution from the original sample location 
to another sample location:

a. In the Prep Operations list, select Transfer from Sample to Sample. The task 
parameters appear below the Add To Task List button.

b. Keep all the default parameter settings for the Transfer from Sample to Sample task, 
except those that are shown below (see Figure 70).

Parameter Setting Autosampler action

Source Sample

Location Relative Location Withdraws sample from the 
current vial location listed in the 
sequence table.

Location Current

Destination Sample

Location Relative Location Deposits sample in the 
current + 1 vial location listed in 
the sequence table.

Location Current + 1

Volume 50 Transfers 50 μL of sample. 
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Figure 70. Settings for the Transfer from Sample to Sample task

c. Click Add To Task List to add the task to the sample preparation routine. 

When the autosampler performs this task, it withdraws 50 μL of sample from the 
current vial location in the sequence table and deposits it in the current + 1 vial 
location.

4. Add a task that transfers diluent (with the inner syringe plunger) from a reservoir vial to 
the sample location:

a. In the Prep Operations list, select Transfer from Reservoir to Sample. The 
parameters for the task appear below the Add To Task List button.

Default settings
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b. Keep all the default parameter settings for the Transfer from Reservoir to Sample task, 
except those that are shown below (see Figure 71).

Figure 71. Settings for the Transfer from Reservoir to Sample task

Tip  When accuracy is important, keep the transfer volume below the nominal 
syringe size, so that the autosampler uses the inner syringe plunger. Solvent 
transfers made with the inner plunger are more accurate than solvent transfers 
made with the outer plunger because the stepper motor for the inner plunger 
takes smaller steps and provides finer control than the stepper motor for the outer 
plunger.

Parameter Setting Autosampler action

Source reservoir RV1 Draws solvent from 
reservoir vial 1.

Destination Sample

Location Relative Location Deposits solvent in the 
current + 1 vial location listed in 
the sequence table.

Location Current + 1

Volume 225 Transfers 225 μL of solvent.

Default settings
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c. To add this task to the sample preparation routine twice, click Add To Task List 
twice. 

When the autosampler performs this task, it uses the inner syringe plunger to 
withdraw 225 μL of diluent from the reservoir vial 1 and deposit the diluent in the 
current + 1 vial location. Performing this task twice transfers a total of 450 μL of 
diluent to the current + 1 vial location. 

5. Add a task that homes the position of the concentric syringe plungers as follows:

a. In the Prep Operations list, select Wash Needle. The task parameters appear below 
the Add To Task List button.

b. Keep all the default parameter settings for the Wash Needle task (see Figure 72). 

Figure 72. Default parameter settings for the Wash Needle task

c. Click Add To Task List to add this task to the sample preparation routine. 

Note  The syringe cannot switch between bores without first homing the position of 
the two syringe plungers. The Transfer from Reservoir to Sample task that you added 
in step 4 uses the inner syringe bore. The Mix at Sample task that you add in step 6 
uses the outer syringe bore. The Wash Needle task that you add in this step homes the 
position of the two syringe plungers.

Default settings
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6. Add a task that mixes the solution in the new sample location:

a. In the Prep Operations list, select Mix at Sample. The task parameters appear below 
the Add To Task List button.

b. Keep all the default parameter settings for the Mix at Sample task, except those listed 
below (see Figure 73).

c. Click Add To Task List to add this task to the sample preparation routine. 

When the autosampler performs this task, it aspirates and expunges 250 μL of the 
sample solution in the current + 1 vial location 10 times.

Figure 73. Settings for the Mix at Sample task

Parameter Setting Autosampler action

Sample Location

Location Relative Location Aspirates and expunges 250 μL 
sample from the current + 1 vial 
location listed in the sequence 
table 10 times.

Location Current + 1

Volume 250

Cycles 10

Default settings

Default setting
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7. Review the task list by expanding the tasks in the Method list (see Figure 74).

Figure 74. Method area with an expanded task list

8. Save the instrument method (see “Saving the Instrument Method” on page 109).

To perform this sample routine, you must insert empty vials into your sample tray. 
For example, to dilute five samples, place the samples in vial locations A1, A3, A5, A7, 
and A9. Place empty vials in vial locations A2, A4, A6, A8, and A10. Fill reservoir vial 1 
with an appropriate diluent that matches the sample matrix. 

If you do not want to inject the diluted samples, create a five-line sequence that lists the 
vial locations of the original samples (A1, A3, A5, A7, and A9). The original samples are 
not injected.

If you want to inject the diluted samples, create a ten-line sequence that lists all the vial 
locations (A1 to A10). Ensure that you use the method that contains the sample 
preparation routine on the odd rows only (Rows 1, 3. 5. 7. and 9).
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5

Daily Operation

During the initial installation of the Surveyor Plus LC system, a Thermo Fisher Scientific field 
service engineer sets up the solvent lines, primes the pulse dampener of the Surveyor MS 
Pump Plus, and calibrates the PDA detector.

To prepare the system for daily operation, check the status of the devices, warm up the 
detector’s lamps, and remove air from the solvent lines.

To maintain optimal performance of the system, calibrate the PDA detector on a monthly 
basis or whenever you move the detector, and check the light throughput to the diode array 
whenever you move the detector, observe an increase in detector noise, or replace the flowcell 
or lamps (see “Verifying the Performance of the PDA Detector” on page 313).

Prime the pulse dampener of the Surveyor MS Pump Plus on a monthly basis or when you 
notice an increase in pump pulsation.

Note  The pulse dampener of the Surveyor LC Pump Plus does not require priming.

Contents

• Turning On the Power to Each LC Device

• Initiating Communication with the Data System

• Checking the Status of the LC Devices

• Turning Devices On, Off, or into Standby from the Info View

• Filling the Solvent Reservoir Lines with Fresh Solvent

• Priming the Pulse Dampener of the Surveyor MS Pump Plus

• Accessing the Direct Controls
Thermo Scientific Surveyor Plus User Guide for LC Devices 133



5 Daily Operation
Turning On the Power to Each LC Device
Turning On the Power to Each LC Device
 To turn on the power to the LC devices

1. Depress the power switch on each device.

2. Observe the status LEDs for each device. 

Shortly after you turn on the power, all the LEDs except the Comm LEDs turn green. In 
addition, the autosampler syringe goes through its initialization process.

3. Verify that the Power LEDs, the Lamp LED, and the Degas LED turn green:

• If any of the Power LEDs remain amber, make sure that the power line to the affected 
device or devices is connected.

• If the Degas LED on the pump is flashing amber, the degas unit has failed to produce 
a vacuum. Call your local Thermo Fisher Scientific representative for repairs. 

• If the Lamp LED remains amber, both of the lamps are turned off. If the lamps 
are off, turn them on when you check the detector’s status from the data system.
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Initiating Communication with the Data System
You control the LC devices from your Thermo Scientific mass spectrometry application. The 
only manual control for the autosampler and UV/Vis detector are their ON/OFF power 
switches. The PDA detector has two additional manual controls: the filter wheel and the 
attenuators. The filter wheel controls the position of the holmium oxide calibration solution. 
The attenuators control the light throughput to the diode array. The pump has a purge valve.

The following procedure describes how to verify instrument communications from the 
Thermo Xcalibur data system.

 To open the data system and verify instrument communications

1. From your computer desktop, choose Start > Programs > Thermo Xcalibur > Xcalibur.

The Thermo Xcalibur Roadmap window appears (see Figure 75).

Figure 75. Thermo Xcalibur Homepage window with the Roadmap and Info view displayed

Information view Roadmap
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Shortly after you open the data system, the Comm LEDs on the front panels of the LC 
devices turn green if the devices are powered on and connected to the data system 
computer.

2. If the Comm LEDs remain amber, do the following:

• Verify that the Ethernet communication cables for the Surveyor PDA Plus Detector 
or Surveyor UV/Vis Plus Detector, Surveyor Autosampler Plus, and Surveyor LC 
Pump Plus are connected to the Ethernet switch and that the Ethernet switch is 
connected to the data system computer. Verify that the RS-232 cable for the Surveyor 
MS Pump Plus is connected to the data system computer.

• Verify that the stack addresses in the configuration for the Surveyor Autosampler 
Plus, Surveyor PDA Plus Detector or Surveyor UV/Vis Plus Detector, and Surveyor 
LC Pump Plus are correct.

For information about configuring your instrument devices, see Chapter 2, “Thermo 
Foundation Instrument Configuration.” 

Checking the Status of the LC Devices
After you turn on the power to the LC devices and open the Xcalibur data system, check the 
status of each device.

To check the status of the LC devices, follow these procedures:

1. Opening the Status Page of the Information View

2. Viewing the Status of Each Device

Opening the Status Page of the Information View

You can monitor the status of the LC devices from the Information view of the Xcalibur data 
system. This view is normally displayed on the left side of the Home Page window. If this view 
is not displayed, the view has been closed. From the Home Page window, choose View > Info 
View to open the Information view. 

 To display the Status page of the Information view

1. In the Home Page window, open the Information view by doing one of the following:

• Choose View > Info View. 

–or– 

• Click the Information view icon ( ) in the toolbar.

Tip  You can also view the system pressure on the pump page of the Inlet Direct Control 
dialog box in the Tune window for your Thermo Scientific mass spectrometer.
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2. Click the Status tab.

The Status page appears (see Figure 76).

Figure 76. Status page of the Information View

If you have just recycled the power and have not yet downloaded a method, you see the 
following status readouts on the Status page:

• Initializing is displayed while the data system attempts to connect to an instrument 
module.

• Lamp Warm-up is displayed for the detector while the deuterium lamp is igniting.

• Ready to Download is displayed after the data system establishes communication 
with an instrument device and after each run has ended.

Viewing the Status of Each Device

The Surveyor Plus LC system contains an autosampler and an analytical pump. In addition, 
your system might contain an optional detector.

Check the status of each device by clicking its name in the device tree list. The status 
information for a specific device is displayed in the lower portion of the Status page. 

These topics describe the status views for the LC devices:

• Autosampler Status View

• Surveyor MS Pump Plus

• Surveyor LC Pump Plus

• Surveyor PDA Plus Detector Status View

• Surveyor UV/Vis Plus Detector Status View
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Autosampler Status View

The Status view for the autosampler (see Figure 77) contains four pages: 

• AS Status Page

• Oven Page

• Tray Page

• Error Log (Autosampler) Page

Figure 77. Status page showing the AS Status page for the Surveyor Autosampler

Table 35 describes the states that might appear below the Surveyor AS listing.

See Table 35.
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AS Status Page

Table 36 describes the readbacks on the AS Status page of the autosampler status view.

Table 35. Autosampler states 

State Meaning

Initializing The data system is attempting to establish communication with the autosampler.

Ready to Download The autosampler is ready to start a run. 

Ready to Run This state appears momentarily when the data system is downloading an instrument 
method for an LC/MS system.

Running The autosampler is making an injection. If the instrument method contains a time function 
for the autosampler, this state is displayed until the time function has expired.

Direct Control The direct control or calibration windows are open.

Busy The autosampler is performing a direct control operation.

Error An error condition other than the loss of communication has occurred.

Off The data system has attempted to connect to the autosampler and failed five times. 

Table 36. Status readbacks for the autosampler  (Sheet 1 of 3)

Readback Description

Target injection

Vial Position Displays the current vial or microplate well position. For information about the vial and 
well notation, see “Vial and Well Notation” on page 6.

Injection Volume Displays the injection volume for the current injection.
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Other

AS State Displays the following run conditions:

Waiting for 
Download

The autosampler is waiting for the data system to download an 
instrument method.

Waiting for Door 
Close

The Verify Door Is Closed check box is selected (see “Communication 
Page” on page 52) and the tray compartment door is open.

Waiting for 
Temperature

The Wait for Temperature Ready check box is selected (see 
“Communication Page” on page 52) and the tray compartment 
temperature, column oven temperature, or both have not yet reached 
the set temperature. This state remains until the temperature 
controlled areas are equilibrated to the set temperature.

Injecting The autosampler is making an injection. 

Waiting for Pump The autosampler has loaded the sample loop and is waiting for the 
Inject Hold Release signal from the pump.

Ready The autosampler is ready to make an injection.

Error An error condition other than the loss of communication has 
occurred. For example, if you enable the maintenance log and you 
attempt to start a run when one or more of the maintenance counters 
has exceeded its limit, an error condition occurs.

Door State Displays one of the following:

Open The Verify Door Is Closed check box on the Communication page of 
the Surveyor Autosampler Configuration dialog box in the Instrument 
Communication window is selected and the tray compartment door is 
open.

For information about selecting the Verify Door Is Closed check box, 
see “Communication Page” on page 52.

Closed The Door State displays Closed for these conditions:

• The Verify Door Is Closed Check box is selected and the tray 
compartment door is closed.

• The Verify Door Is Closed check box is clear and the door is open 
or closed.

Table 36. Status readbacks for the autosampler  (Sheet 2 of 3)

Readback Description
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Oven Page

Figure 78 shows the Oven page of the status view for the autosampler.

Figure 78. Oven page

Maintenance Due Displays Yes or No.

No The Enable Maintenance Log check box is clear, none of the 
maintenance counters has exceeded its limit, or both.

Yes The Enable Maintenance Log check box is selected and one or more of 
the maintenance counters has exceeded its limit. 

The autosampler cannot start a run until you zero the counter or clear 
the Enable Maintenance Log check box. 

For information about setting up the maintenance counters, see 
“Autosampler Maintenance Information” on page 309. For 
information about clearing the Enable Maintenance Log check box, 
see “Communication Page” on page 52.

Firmware Version Displays the firmware version of the autosampler.

Table 36. Status readbacks for the autosampler  (Sheet 3 of 3)

Readback Description
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Table 37 describes the readbacks on the Oven page of the autosampler status view.

Tray Page

Figure 79 shows the Tray page of the autosampler status view.

Figure 79. Tray page

Table 37. Oven page readbacks 

Readback Description

Control On Displays Yes or No.

You can turn off the oven temperature control by doing one of the following:

• Using the Turn Off Oven Temperature command (see “Controlling the Tray and 
Oven Compartment Temperatures” on page 199)

• Running an instrument method that has the Enable Column Oven Control check 
box cleared

Current Temperature (C) Displays the temperature monitored by the autosampler’s internal temperature sensor.

Set Temperature (C) Displays the user-specified temperature.

You can change the set temperature by doing one of the following:

• Using the Set Oven Temperature command (see “Controlling the Tray and Oven 
Compartment Temperatures” on page 199)

• Running an instrument method that has a temperature setting for the column oven

Ready Status Displays one of the following: 

Ready The oven compartment temperature has reached the set temperature, you 
did not select the Wait for Temperature Ready check box when you 
specified the configuration settings for the autosampler, or both.

For information about the Wait for Temperature Ready check box, see 
“Communication Page” on page 52.

Not Ready The oven compartment temperature has not reached the set temperature.
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Table 38 describes the readbacks on the Tray page of the autosampler status view.
 

Table 38. Tray page parameters 

Readback Description

Control On Display Yes or No.

You can turn off the tray temperature control by doing one of the following:

• Using the Turn Off Tray Temperature command (see “Controlling the Tray and Oven 
Compartment Temperatures” on page 199)

• Running an instrument method that has the Enable Column Oven Control check 
box cleared

Current Temperature (C) Displays the temperature monitored by the autosampler’s internal temperature sensor.

Set Temperature (C) Displays the user-specified temperature.

You can change the set temperature by doing one of the following:

• Using the Set Tray Temperature command (see “Controlling the Tray and Oven 
Compartment Temperatures” on page 199)

• Running an instrument method that has a temperature setting for the column oven

Ready Status Displays one of the following: 

Ready The oven compartment temperature has reached the set temperature, 
you did not select the Wait for Temperature Ready check box when 
you specified the configuration settings for the autosampler, or both.

For information about the Wait for Temperature Ready check box, 
see “Communication Page” on page 52.

Not Ready The oven compartment temperature has not reached the set 
temperature.
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Error Log (Autosampler) Page

Figure 80 shows the Error Log page for the autosampler.

Figure 80. Error Log page

Table 39 describes the parameters on the Error Log page.

Table 39. Error Log page parameters

Parameter Description

Index Lists the order of the error events, in increments of 1. The index 
number for the first error event that occurs after you clear the log 
is 1.

Application code Refer to your autosampler hardware manual for information 
about the application codes.

Buttons

Refresh Loads the error log messages stored by the autosampler.

Clear Clears the error log.
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Surveyor MS Pump Plus

For information about the status of the pump and the degassing unit, see these topics:

• General Page of the Pump Status View 

• Extended Page of the Pump Status View 

• Degasser Page of the Pump Status View

General Page of the Pump Status View

Figure 81 shows the General page of the pump status view.

Figure 81. General page pump status view
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Table 40 describes the status readbacks on the General page of the pump status view.

Table 40. General page of the pump status view  (Sheet 1 of 2)

Readback Description

Status Displays the pump status as follows:

Ready The pump is ready for a run.

Running Isocratic The solvent flow is on, but the pump is not running a gradient 
program.

Homing The pump pistons are moving toward the home position.

Running Gradient The pump is running the solvent conditions specified in the 
gradient program of an instrument method. The gradient 
program can contain isocratic or gradient solvent conditions.

Low Pressure Error The system pressure has fallen below the minimum pressure 
setting for more than one minute.

If you are controlling the pump from the Direct Control dialog 
box, the status returns to Ready after the pump stops pumping. 
The error is posted to the pump’s event log. 

High Pressure Error The system pressure has risen above the maximum pressure 
setting.

Note  When a pressure error occurs, one of the following occurs:

• If you are controlling the pump from the Direct Control dialog box, the status 
returns to Ready after the pump stops pumping. The error is posted to the 
pump’s event log.

• If you are controlling the pump from the Sequence Setup window, the 
Acquisition Server dialog box appears.

Run Time Displays the elapsed time since the last instrument method downloaded, you turned the 
device on from the Status page of the Information view, or you started the pump from the 
Direct Control dialog box.

Flow Rate Displays the user-specified flow rate. For an instrument method, the flow rate changes 
linearly between time lines.

Pressure Displays the pressure monitored by the pump.

Pressure SD Displays the standard deviation of the pressure monitored by the pump.

Start Gradient A check appears in this box when the pump receives the Start gradient signal from the 
autosampler.

Pump Ready A check appears in this box when the pressure monitored by the pump reaches the stability 
level specified in the instrument method.
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Extended Page of the Pump Status View

Figure 82 shows the Extended page of the pump status view.

Figure 82. Extended page of the pump status view

Table 41 describes the status readbacks on the Extended page of the pump status view.

Release Injection A check appears in this box when the pump sends the Release Injection signal to the 
autosampler.

Start 2nd Pump A check appears in this box when Pump 1 triggers Pump 2 to start its pump program.

Table 40. General page of the pump status view  (Sheet 2 of 2)

Readback Description

Table 41. General page of the pump status view 

Readback Description

Flow Rate Displays the user-specified flow rate. Flow rate changes are linear between time lines in the 
gradient program.

Tip  You can change the percent composition of solvents A, B, C, and D by running an 
instrument method or by downloading new solvent conditions from the (Inlet) Direct 
Control dialog box.

Pressure Displays the pressure monitored by the pump.

Pressure SD Displays the standard deviation of the pressure monitored by the pump.

Solvent A, B, C, or D Displays the user-specified percent composition of solvent A, B, C, or D.

Stroke Count Displays the stroke count for the pump pistons. 

When the stroke count exceeds 1 000 000, the number is displayed in red.
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Degasser Page of the Pump Status View

Figure 83 shows the Degasser page of the pump status view.

Figure 83. Degasser page of the pump status view

Table 42 describes the status readbacks on the Degasser page of the pump status view.

Table 42. General page of the pump status view 

Readback Description

Degasser Status The states of the degasser are as follows:

Ready The vacuum level has reached a sufficient level to degas 
the mobile phase solvents.

Not Connected The pump is not communicating with the data system 
computer.

Error An error condition has occurred.

Vacuum Level Displays the vacuum level of the solvent degassing chambers.

Motor Speed Displays the motor speed of the vacuum degasser.
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Surveyor LC Pump Plus

Figure 84 shows the Status view for the Surveyor LC Pump Plus. You can view the system 
pressure from this view.

Figure 84. Surveyor LC Pump Plus Status view
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Table 43 describes the readbacks on the pump status view.

Table 43. Surveyor LC Pump Plus status readbacks 

Readback Description

Status Displays the following pump states:

READY The pump is ready to take a command.

Not Connected The pump is not communicating with the data system 
computer.

Off The pump pistons are stopped.

Running Isocratic The pump flow is on.

Running Gradient The pump is running a gradient program.

Degasser Displays the following degasser states: READY or Not Connected.

Run Time Displays the run time.

Time Remaining Displays the remaining time for the run.

Flow Displays the user-specified flow rate.

Pressure Displays the pressure monitored by the pump.

A Displays the user-specified percent composition for solvent A.

B Displays the user-specified percent composition for solvent B.

C Displays the user-specified percent composition for solvent C.

D Displays the user-specified percent composition for solvent D.
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Surveyor PDA Plus Detector Status View

Figure 85 shows the Status view for the Surveyor PDA Plus Detector. You can view the status 
of the lamps and the wavelength and dark current calibrations from this view.

Figure 85. Surveyor PDA Plus Detector Status view
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Table 44 describes the readbacks for the PDA detector.

Surveyor UV/Vis Plus Detector Status View
Table 44. PDA detector status readbacks 

Readback Description

Connection status Displays whether the PDA detector is communicating with the data system computer.

The connection states are Connected or Not Connected.

Ready or Not Ready to 
Start Run 

Ready to Start Run The detector is ready to start a run or is currently 
acquiring data.

Not Ready to Start Run The deuterium lamp is warming up.

Wavelength 
Calibration

The wavelength calibration is valid or invalid.

Dark Current 
Calibration

The dark current calibration is valid or invalid.

Method is Valid N/A

Filter Wheel Position The filter wheel has two positions:

Position 1 (Run) Light passes through the flowcell onto the diode array.

Position 2 (Closed) Light passes through the holmium oxide filter onto the 
diode array.

Deuterium Lamp The deuterium lamp states are as follows:

The deuterium lamp is off.

The deuterium lamp is starting up, which requires about 
1.5 min.

The deuterium lamp is on.

Tungsten Lamp The tungsten lamp states are as follows:

The tungsten lamp is on.

The tungsten lamp is off.
152 Surveyor Plus User Guide for LC Devices Thermo Scientific



 5 Daily Operation
Checking the Status of the LC Devices
Figure 86 shows the Status view for the Surveyor UV/Vis Plus Detector. You can view the 
absorbance level of the chromatographic baseline from this view.

Figure 86. Surveyor UV/Vis Plus Detector Status view

Table 45 describes the status readbacks for the Surveyor UV/Vis Plus Detector.

Table 45. UV/Vis detector status readbacks

Readback Description

State Displays the following states: Ready for Run and Off.

Run Time Displays the elapsed run time.

Data Type Displays the program type specified in the current instrument method: Dual UV (D2), 
Dual Visible (W), or Single Wavelength.

Lambda 1 (nm) Displays the current wavelength setting for the Wavelength 1 channel.

Lambda 2 (nm) Displays the current wavelength setting for the Wavelength 2 channel.

Absorbance 1 (AU) Displays the current absorbance level for the Wavelength l channel.

Absorbance 1 (AU) Displays the current absorbance level for the Wavelength 2 channel.
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Turning Devices On, Off, or into Standby from the Info View
You can turn on certain activities for a device from its device listing in the Info View. To use 
this feature, the device must be powered on and communicating with the data system. 

 To turn on a device from the Info View

Right-click the device listing on the Status page and choose Turn Device On. 

Depending on the device, the following actions occur:

• When you turn on the pump, it begins pumping solvents from the last set of 
downloaded parameters.

• When you turn on the detector, its lamps turn on.

• When you turn on the autosampler, it adjusts its controlled temperature zones to the 
last set of downloaded parameters.

 To place a device in Standby mode

Right-click the device listing on the Status page and choose Turn Device into Standby. 

Depending on the device, the following actions occur:

• When you place the pump in Standby mode, it stops pumping.

• When you place the detector in Standby mode, nothing happens.

• When you place the autosampler in Standby mode, nothing happens.

 To turn a device off

Right-click the device listing on the Status page and choose Turn Device Off.

Depending on the device, the following actions occur:

• When you turn off the pump, it stops pumping.

• When you turn off the detector, the lamps turn off.

• When you turn off the autosampler, nothing happens.
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Filling the Solvent Reservoir Lines with Fresh Solvent
After filling the solvent bottles, connecting the solvent lines to the degasser, and configuring 
the pump to communicate with the data system, prepare the pump for operation by removing 
the air from the solvent lines that connect the solvent reservoir bottles to the pump’s degassing 
unit.

For information about using the direct controls to start the solvent flow from the Surveyor 
MS Pump Plus, see “Pump Direct Controls” on page 185.

 To quickly draw fresh solvent into the solvent reservoir lines

1. For any solvent line that you want to pull solvent through, disconnect the tubing that is 
connected to the corresponding degasser outlet port.

2. Connect a Luer-Lok™ fitting to the degasser outlet port.

3. Connect a 10 mL syringe to the Luer-Lok fitting, and pull solvent through the line.

4. Remove the Luer-Lok fitting from the outlet port.

5. Reconnect the solvent line to the degasser outlet port.
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Priming the Pulse Dampener of the Surveyor MS Pump Plus
Before you can operate the Surveyor MS Pump Plus, you must prime its built-in pulse 
dampener. Priming the pulse dampener involves filling the dampening coil (see Figure 87) 
with a solvent, such as methanol or isopropanol. After the coil is filled with solvent, it 
effectively dampens pressure pulsations from the rest of your system.

Closing the pulse dampener flush valve after you fill the coil shuts the dampening coil off 
from the mobile phase stream. Because a permeable membrane separates the mobile phase 
stream from the dampening coil, the solvent in the coil slowly diffuses into the mobile phase 
stream. When the pump is in continuous or frequent use, prime the pulse dampener on a 
monthly basis.

Figure 87. Pulse dampening assembly of the Surveyor MS Pump Plus

 To prime the pulse dampener of the Surveyor MS Pump Plus

1. Fill a solvent bottle with particulate-free, HPLC-grade methanol.

2. Connect an HPLC column or a flow restrictor to the LDA outlet.

3. Insert the tip of the 10 mL syringe into the tubing connected to the manual bleeder valve 
(see Figure 88).

Note  Do not fill the pulse dampener with an aggressive acid or a buffered solution. The 
recommended filling solvents are methanol, acetonitrile, or isopropyl alcohol. If you 
accidentally fill the pulse dampener with an acidic or buffered solvent, flush the loop with 
a miscible solvent, and then refill it with methanol, acetonitrile, or isopropyl alcohol.

Manual bleeder valve
(for priming)

Dual valve 
cartridge

Diffusion barrier 
cartridge

2 mL dampening loop
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Figure 88. Manual bleeder valve with attached tubing

4. Open the valve by turning it counterclockwise.

5. To open the direct controls for the Surveyor MS Pump Plus, do one of the following:

• From the Surveyor MS Pump Plus view, choose Surveyor MS Pump Plus > 
Direct Control. The Direct Control dialog box appears.

–or–

• From the tune window for your Thermo Scientific mass spectrometer, choose 
Setup > Inlet Direct Control. The Inlet Direct Control dialog box that contains 
tabbed pages for each configured LC device appears. Click the Surveyor MS Pump 
Plus tab.

6. Start pumping 100% methanol at a flow rate of 1000 μL/min.

7. Fill the loop completely to expel any air that might be trapped in the dampener loop.

8. Set the flow rate to one that is appropriate for your system.

9. Close the manual bleeder valve (see Figure 87 on page 156) by turning the valve 
clockwise. Always keep the pulse dampener valve closed during normal operation.

Note  For information about using the Direct Control dialog box for the Surveyor 
MS Pump Plus, see “Pump Direct Controls” on page 185.

Note  For information about using the Inlet Direct Control dialog box, see 
Chapter 12, “Making a Single Injection from the Tune Window.” 

Outlet of pulse dampener

Manual bleeder valve with 
attached tubing
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Accessing the Direct Controls
You can access the direct controls for each instrument from the Instrument Setup window. 
You can use the direct controls to start and stop the solvent flow from the LC pump, move the 
autosampler’s XYZ arm, turn the detector’s lamps on and off, flush the autosampler’s syringe, 
and so on.

For information about using the direct controls to prepare your LC system for daily operation, 
see the Chapter 6, “Direct Controls.” 

 To access the direct controls 

1. Depending on the data system, do one of the following:

• If you are controlling your instrument from the Xcalibur data system, do the 
following:

• If you are controlling your instrument from a Thermo Scientific data system other 
than Xcalibur, open the instrument control area. 

The instrument control area opens to the first module displayed in the view bar on 
the left side of the window.

a. If it is not already open, open the Roadmap view by clicking the 
Roadmap  button in the toolbar.

b. Click the Instrument Setup  button on the toolbar or the larger 
Instrument Setup icon in the Roadmap View.

The Instrument Setup window opens to the first module displayed in 
the view bar (see Figure 89). The view bar is a vertical bar on the left 
side of the Instrument Setup window. It contains an icon for each 
configured device. When you click a device icon, a green triangle 
appears in the lower-right corner of the icon, and the device view 
appears.
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Figure 89. Instrument Setup window open to the Surveyor AS Method page of the Surveyor AS view

2. To open the view for the device of interest, click its corresponding icon in the view bar.

The view for the specific device appears.

3. Access the direct controls for each device from the menu bar of the device view as follows:

Device Menu Reference

Surveyor LC Pump Plus Choose > Surveyor LC Pump > 
Direct Control > Operation.

“Surveyor LC Pump Plus Direct 
Controls” on page 185

Surveyor MS Pump Plus Choose Surveyor MS Pump > 
Direct Control.

“Surveyor MS Pump Plus Direct 
Controls” on page 190

Surveyor PDA Plus Detector Choose Surveyor PDA Plus > 
Direct Control. Then click the 
Configuration tab. 

“PDA Detector Direct Controls” on 
page 162

Surveyor UV/Vis Plus Detector Choose Surveyor UV/Vis > 
Direct Control.

“UV-Vis Detector Direct Controls” on 
page 183

Surveyor Autosampler Plus Choose Surveyor AS > Direct Control. “Autosampler Direct Controls” on 
page 192
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Direct Controls

You can control some device features without downloading an instrument method. For 
example, you can turn the lamps on or off, set the solvent conditions for the pump, start and 
stop the solvent flow from the pump, and control the autosampler’s temperature zones and its 
XYZ arm by using the direct controls provided by the data system.

For information about accessing the direct controls for each device, see “Accessing the Direct 
Controls” on page 158.

Contents

• PDA Detector Direct Controls

• UV-Vis Detector Direct Controls

• Pump Direct Controls

• Autosampler Direct Controls

Note  For instructions on loading samples into the autosampler, see “Loading the 
Autosampler” on page 210.
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PDA Detector Direct Controls
The Direct Control dialog box for the PDA detector contains the following pages: Display, 
Configuration, Information, and Calibration.

 To open the Direct Control dialog box for the PDA detector

1. Open the PDA detector view.

2. From the menu bar, choose Surveyor PDA Plus > Direct Control (see Figure 90).

Figure 90. Surveyor PDA Plus menu

The Surveyor PDA Plus Direct Control dialog box opens to the Display page 
(see Figure 91).

Figure 91. Surveyor PDA Plus Control dialog box tabs
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Table 46 lists the direct control procedures by the page where they are performed.

For information about using the Calibration page to determine the wavelength accuracy of 
the detector and the dark current produced by the diode array, see “Calibrating the PDA 
Detector” on page 319.

Turning the Lamps On or Off

Use the Configuration page of the Surveyor PDA Plus Direct Control dialog box to turn each 
lamp on or off.

 To turn the lamps on or off

1. Open the Configuration page of the Surveyor PDA Plus Direct Control dialog box 
(see “Configuration Page” on page 171).

2. Click Turn On for the associated lamp.

When you turn on the deuterium lamp, its Status readback reads Starting during the 
30-second ignition period, and then it changes to On. If there is a problem with either 
lamp, its Status readback reads Failed.

Table 46. Direct control procedures 

Page Procedure

Display Page “Checking the Chromatographic Baseline” on page 168

“Verifying the Performance of the PDA Detector” on page 313

Configuration Page “Turning the Lamps On or Off” on page 163

“Resetting the Lamp Usage Hours” on page 164

“Changing the Polarity of the Analog Outputs” on page 164

“Testing the Analog Outputs” on page 165

“Setting the Lamp Startup Time” on page 166

Information Page “Viewing, Exporting, and Clearing the Error Log for the PDA Detector” on page 171

“Checking the Firmware Version of the PDA Detector” on page 171

Note  The intensity of the deuterium lamp falls off very slightly over a period of time 
after the lamp is turned on. Plan to wait at least one hour for the lamp to stabilize 
after a cold start before collecting data in the spectral range of the deuterium lamp.
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Resetting the Lamp Usage Hours

Use the Configuration page of the Surveyor PDA Direct Control dialog box to reset the lamp 
usage hours.

 To reset the lamp usage hours (lifetime hours elapsed)

1. Open the Configuration page of the Surveyor PDA Direct Control dialog box 
(see “Configuration Page” on page 171).

2. Click Reset Lifetime for the associated lamp. 

The stored total run time for the associated lamp resets to zero, and the Last Lifetime 
Reset readback is updated to the current date and time.

Changing the Polarity of the Analog Outputs

Use the Configuration page of the Surveyor PDA Direct Control dialog box to change the 
polarity of the analog outputs.

There are two output signal terminals on the back panel of the PDA detector: Event and 
Ready (see Figure 92).

Figure 92. Event and Ready terminals on the back panel of the PDA detector

 To change the polarity of the analog outputs

1. Open the Configuration page of the Surveyor PDA Direct Control dialog box 
(see “Configuration Page” on page 171).

If the output polarity is Active Low, the Set Active High button is available. If the output 
polarity is Active High, the Set Active Low button is available. 

Tip  Avoid indiscriminately clicking the Reset buttons. Click Reset only after you 
replace the associated lamp with a new one.
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2. Under Analog Outputs (see Figure 93), do one of the following:

• Click Set Active High to change the output polarity from Active Low to Active 
High.

–or–

• Click Set Active Low to change the output polarity from Active High to Active Low.

Figure 93. Analog Outputs area on the Configuration page

Testing the Analog Outputs

Use the Configuration page of the Surveyor PDA Plus Direct Control dialog box to change 
the polarity of the analog outputs.

 To test the analog outputs

1. Open the Configuration page of the Surveyor PDA Plus Direct Control dialog box 
(see “Configuration Page” on page 171).

2. Under Analog Outputs (see Figure 93), do the following:

• Click Turn On or Turn Off to trigger the external device.

• Click Zero DACs to calibrate external instruments, such as an SS420X analog to 
digital converter.

When you click Zero DACs, the DACs outputs are set to zero for about 20 seconds. 
You can extend this calibration time by clicking the button again.
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Setting the Lamp Startup Time

Use the Lamp Startup Time dialog box to set the startup time for the lamps.

If you do not change the lamp startup time, the data system automatically turns the lamps on 
at 4:55 PM on weekdays. 

 To open the Lamp Startup Time dialog box

1. Open the Configuration page of the Surveyor PDA Plus Direct Control dialog box 
(see “Configuration Page” on page 171).

2. In the Programmed Lamp Startup area, click Change (see Figure 94).

Figure 94. Programmed Lamp Startup area of the Configuration page

The Lamp Startup Time dialog box appears (see Figure 95).

Figure 95. Lamp Startup Time dialog box

 To set the startup time for the lamps

1. In the Xcalibur Should Start the Lamps At box, click the hours or minutes text to 
highlight it.

Tip  To change both the hours and the minutes, change one time field, and then click 
OK to accept the setting and close the dialog box. Then open the dialog box a second 
time and change the other time field.
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2. To change the numeric values, do one of the following:

• Use the up or down arrow to the left of the time entry to scroll to the time value that 
you want.

–or–

• Press the UP or DOWN key on your computer keyboard to scroll to the time value 
that you want.

–or–

• Type the numeric value that you want.

3. To change AM to PM or the reverse, highlight the current setting, and then type AM 
or PM.

4. To change the day of the week or to turn off the lamp startup feature, in the On These 
Days list, select Never, Weekdays, or Everyday.

5. Click OK to apply the new lamp startup time.

Lamp Startup Time Parameters

Table 47 describes the parameters in the Lamp Startup Time dialog box.

Table 47. Lamp Startup Time dialog box parameters

Parameter Description

Xcalibur Should Start the Lamps At Specifies the time that the Xcalibur data system 
automatically turns the lamps on.

Default: 4:55 PM

On These Days Specifies the days that the Xcalibur data system 
automatically turns the lamps on. The selections are 
Never, Weekdays, and Every Day.

Default: Weekdays

Buttons

OK Applies the settings and closes the dialog box.

Cancel Cancels the applied time value or date.
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Checking the Chromatographic Baseline

Use the Display page of the Direct Control dialog box to check the chromatographic baseline 
(see “Display Page” on page 176).

 To check the stability of the chromatographic baseline before starting a sequence run

1. Open the Instrument Setup window of the Xcalibur data system.

2. In the view bar, click the icon for the LC pump, and then open the Direct Control dialog 
box for the LC pump.

3. Start the solvent flow from the LC pump. Use the chromatographic conditions specified 
on first line pump program in the instrument method.

For information about starting the solvent flow from the LC pump, refer to the Help for 
the pump.

4. In the view bar of the Instrument Setup window, click the icon for your PDA detector.

The PDA detector view of the Instrument Setup window appears with the Method page 
displayed.

5. From the menu bar, choose Surveyor PDA Plus > Direct Control.

The Direct Control dialog box appears.

6. Click the Display tab.

The Display page appears (see Figure 96).

Figure 96. Control area buttons on the Display page

7. In the Control area, click Load Method.

The Open Display Method dialog box appears (see Figure 97).
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Figure 97. Open Display Method dialog box

8. Select the instrument method that you plan to use in your acquisition sequence.

9. Click Open to download the method to the PDA detector and close the dialog box.

10. In the Control area, click Start Data.

The graphical display begins to update. The spectral scan appears in the top pane and the 
chromatographic data for the discrete channel wavelengths appears in the bottom pane.

When you click Start Data, the Start Data button changes to the SNAPSHOT button 
and the Zero Data button is available (see Figure 98).

Figure 98. Display page with data displaying for an instrument method

Instrument method with 
a .meth file extension

Spectral data
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11. To zero the absorbance level, click Zero Data.

The Current method readback displays Zeroed Data Display (see Figure 99).

Figure 99. Effect of clicking the Zero Data button

12. To stop data acquisition, click Stop Data.

If the noise level is too high, check the light throughput to the diode array. 
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Viewing, Exporting, and Clearing the Error Log for the PDA Detector

You can access an error log for the PDA detector from the Xcalibur data system.

 To view the error log

1. Open the Information page of the Surveyor PDA Direct Control dialog box (see 
“Information Page” on page 181).

2. Click Request Log.

 To export the log to a Microsoft Excel Spreadsheet

Click Export Log.

 To clear the error log

Click Clear Log.

Checking the Firmware Version of the PDA Detector

 To check the firmware version of the PDA detector

Open the Information page of the Direct Control dialog box for the PDA detector 
(see “Information Page” on page 181).

The firmware version of the PDA detector is displayed in the lower-right portion of the 
Information page.

Configuration Page

Use the Configuration page of the Surveyor PDA Plus Direct Control dialog box to perform 
these procedures:

• Turning the Lamps On or Off

• Resetting the Lamp Usage Hours

• Changing the Polarity of the Analog Outputs

• Testing the Analog Outputs

• Setting the Lamp Startup Time

 To open the Configuration page of the Direct Control dialog box

1. Open the Surveyor PDA Direct Control dialog box (see “PDA Detector Direct Controls” 
on page 162).

2. Click the Configuration tab.

The Configuration page appears (see Figure 100).
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Figure 100. Configuration page 
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Configuration Page Parameters

Table 48 describes the parameters on the Configuration page.

Table 48. Configuration page of the Direct Control dialog box for the PDA detector  (Sheet 1 of 4)

Parameter Description

Lamp Maintenance

Use the controls in this area to turn the lamps on and off and to reset the lamp lifetime hours after you replace a lamp.

Deuterium Lamp

Status readback Indicates the status of the deuterium lamp. 

Graphic Text Meaning

Off The deuterium lamp is off.

Starting The deuterium lamp is starting up, 
which requires about 1.5 min.

On The deuterium lamp is on. When the 
status is On, the Turn Off button is 
available. When the status is Off, the 
Turn On button is available.

Last Lifetime Reset 
readback

Displays the date and time that the deuterium lamp was last reset.

Lifetime Hours Elapsed Displays the cumulative time in hours that the deuterium lamp has been in the On state 
since you clicked the Reset Lifetime button.

Turn On/Off button Turns on the deuterium lamp if its current status is Off.

Turns off the deuterium lamp if its current status is On. 

Reset Lifetime button Resets the date and time monitored by the Last Reset readback and the Lifetime readback.

Note  Click Reset Lifetime whenever you replace the deuterium lamp. This resets the Last 
Reset readback to the current date and time and restarts the Lifetime readback at zero.
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Tungsten Lamp

Status readback Indicates the status of the tungsten lamp, as follows:

Graphic Test Meaning

On The tungsten lamp is on.

Off The tungsten lamp is off.

When the status is On, the Turn Off 
button is available. When the status 
is Off, the Turn On button is 
available.

Last Lifetime Reset 
readback

Displays the date and time that the tungsten lamp was last reset.

Lifetime Hours Elapsed Displays the cumulative time in hours that the tungsten lamp has been in the On state since 
you clicked the Reset Lifetime button.

Turn On/Off button  Turns on the tungsten lamp if its current status is Off.

Turns off the tungsten lamp if its current status is On. 

Reset Lifetime button Resets the date and time monitored by the Last Reset readback and the Lifetime readback.

Note  Click Reset Lifetime whenever you replace the tungsten lamp. This resets the Last 
Reset readback to the current date and time and restarts the Lifetime readback at zero.

Analog Outputs

Use the controls in this area to configure and test the Event and Ready outputs. 

Determine if the external device is triggered by contact closure or a TTL (transistor - transistor - logic) signal. If the 
external device requires a TTL signal, determine the polarity of the signal: active high or active low.

Note  For TTL connections:
• Logic level zero (0) is less than +0.8 Vdc (reading from Ground).
• Logic level one (5) is approximately +5 Vdc (+2.4 Vdc minimum from Ground).

Possible configurations of the Event and Ready outputs include the following:

Output state Output polarity Vdc

Off Active High +5

Table 48. Configuration page of the Direct Control dialog box for the PDA detector  (Sheet 2 of 4)

Parameter Description
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Ready Output

Turn On and Turn Off 
buttons

Indicates whether the Ready output state is On or Off. If the Ready output state is On, the 
Turn Off button is available. If the Ready output state is Off, the Turn On button is 
available. 

Ready Output 
readback

Indicates whether the Ready output polarity is Active High or Active Low. If the Ready 
output polarity is Active Low, the Set Active High button is available. If the Ready output 
polarity is Active High, the Set Active Low button is available. 

Set Active Low or Set 
Active High buttons

Set the polarity of the Ready Output signal.

Note  The output polarity must match the polarity (either Active High or Active Low) of the instrument connected 
to the Ready output connection on the back panel of the PDA detector. The signal terminal is the high connection 
and the ground (GND) terminal is the low connection. The autosampler requires active low remote inputs.

Event Output

Use the controls in this area to specify the parameters for output events. 

If the external device is triggered by a contact closure, connect the PDA EVENT terminal (pin 8) to the positive pin 
on the external device input, and connect one of the PDA GND terminals (either of pins 1 or 7) to the external 
device negative pin.

If the external device is triggered using a TTL signal, connect the PDA +5V output (pin 2) to the positive Input 
terminal of the external device, and connect the PDA EVENT output (pin 8) to the negative Input terminal of the 
external device.

Turn On and Turn Off 
buttons

Indicates whether the Event output state is On or Off. If the Event output state is On, the 
Turn Off button is available. If the Event output state is Off, the Turn On button is 
available. 

Event Output readback Indicates whether the Event output polarity is Active High or Active Low. If the Event 
output polarity is Active Low, the Set Active High button is available. If the Event output 
polarity is Active High, the Set Active Low button is available. 

Set Active Low or Set 
Active High buttons

Set the polarity of the Event Output signal.

Note  The output polarity must match the polarity (either Active High or Active Low) of the instrument connected 
to the Event output connection on the back panel of the PDA detector. The signal terminal is the high connection 
and the GND Terminal is the low connection. 

Short DACs Output

Zero DACs button To calibrate external instruments, such as an SS420X analog to digital converter, use the 
controls in this area to short the DACs outputs to zero for about 20 seconds.

Table 48. Configuration page of the Direct Control dialog box for the PDA detector  (Sheet 3 of 4)

Parameter Description
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Display Page

Use the Display page to perform these procedures:

• “Checking the Chromatographic Baseline” on page 168

• “Adjusting the Light Throughput to the Diode Array” on page 315

 To open the Display page

1. Open the Surveyor PDA Direct Control dialog box (see “PDA Detector Direct Controls” 
on page 162).

2. Click the Display tab.

The Display page appears (see Figure 101).

Programmed Lamp Startup

Programmed Lamp 
Startup

Displays the current lamp startup program and provides controls to create a lamp startup 
program that automatically turns on the lamps for operation at a specified time and day 
(never, weekdays, every day). 

Change Opens the Lamp Startup Time dialog box where you can specify a lamp startup time 
(see “Setting the Lamp Startup Time” on page 166).

Table 48. Configuration page of the Direct Control dialog box for the PDA detector  (Sheet 4 of 4)

Parameter Description
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Figure 101. Display page

Display Page Parameters

Table 49 describes the parameters on the Display page.

Table 49. Display page parameters  (Sheet 1 of 4)

Parameter Description

Control

Control The buttons in this area provide control of the display method (.spda).

Load Method Loads the display method or the data acquisition parameters of an instrument method to 
the detector. 

Start Data Initiates the graphical display of the intensity data or the wavelength data.
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Snapshot Saves a comma-separated values file named PDASnapshot.csv to the following folder on 
the data system computer: 

drive:\Xcalibur\data 

A date and time stamp are appended to the file name. The format of the date and time 
stamp is MMDDYYHHMMSS. MM is the month. DD is the day of the month. YY are the 
last two digits of the year. HH is the hour in military time. MM are minutes. SS are 
seconds. You can open this file with the Excel™ application.

For a wavelength/absorbance method, the file contains the absorbance values for the spectral 
scan and the discrete channel wavelengths at the moment that you clicked Snapshot.

For an intensity/diode method, the file contains the intensity values for the scan of the 
diode array and the intensity values for up to three individual diodes.

Note  The Snapshot button is available only after you click the Start Data button and the 
graphical display has started updating.

Zero Data Zeros the absorbance data.

After you click Zero Data, the Current Method status box displays the message Zeroed Data 
Display.

Note  This button is only available in the wavelength/absorbance mode.

Stop Data Stops the updating of the graphical display.

After you click Stop Data, the Current Method status box displays the message Stopped 
Data Display.

Levels (mAU)

Channel A/B/C level This graphical display shows the intensity or absorbance level of each discrete channel, A, B, 
or C, specified in the method. 

Lamp Lifetimes (hours)

Deuterium Displays the cumulative time in hours that the Deuterium lamp has been in the On state 
since you clicked the Reset button.

Note  Click Reset Lifetime on the Configuration page whenever you replace the 
deuterium lamp. This resets the Last Reset readback to the current date and time and sets 
the Lifetime readback to zero.

Tungsten Displays the cumulative time in hours that the tungsten lamp has been in the On state since 
you clicked Reset Lifetime.

Note  Click the Reset Lifetime button on the Configuration page whenever you replace 
the tungsten lamp. This resets the Last Lifetime Reset readback to the current date and 
time and restarts the Lifetime readback to zero.

Table 49. Display page parameters  (Sheet 2 of 4)

Parameter Description
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Status (bottom left)

Status area Displays the status of the PDA detector and the lamps.

Connection Displays the communication status of the PDA detector. Depending on whether the data 
system can connect to the PDA detector, the status displays Connected or Not Connected.

If this readback displays Not Connected, make sure that the PDA detector is powered on. 
Check the Ethernet connections and the instrument configuration settings for the PDA 
detector.

Diode array scan rate Displays the current configuration setting for the diode array scan rate. The possible diode 
array scan rates are 20, 40, and 80 Hz.

PDA status Displays the current state of the PDA detector. The possible states are Not Ready for a Run 
and Ready for a Run. This readback displays Not Ready for a Run if both lamps are off or if 
the deuterium lamp is warming up.

Wavelength calibration Displays whether the wavelength calibration has been applied.

Dark current 
calibration

Displays whether the dark current calibration has been applied.

Method validity Displays whether a method has been downloaded to the PDA detector.

Filter wheel position Displays the position of the filter wheel. The filter wheel has two positions: 1 and 2. When 
the filter wheel is in position 1, the readout displays Run Position. When the filter wheel is 
in position 2, the readout displays Calibration Position.

Deuterium lamp Displays whether the deuterium lamp is on or off.

Tungsten lamp Displays whether the tungsten lamp is on or off.

Current method (top right)

Current method Displays the status of the current method.

Spectrum 

Spectrum Plot Depending on the method type (.meth or .spda), these scan plots are displayed:

• For display methods (.spda), the scan plot shows intensity (counts) normalized to 
100 percent on the y axis and diode number (2 to 511) on the x axis.

• For instrument methods (.meth), the scan plot shows absorbance (mAU) normalized to 
100 percent on the y axis and wavelength (nanometers) on the x axis.

Table 49. Display page parameters  (Sheet 3 of 4)

Parameter Description
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Channels

Channels Plot Depending on the method type (.meth or .spda), these discrete channel plots are displayed:

• For display methods (.spda), the plot shows intensity (counts) normalized to 
100 percent on the y axis and time on the x axis.

• For instrument methods (.meth), the scan plot shows absorbance (mAU) normalized to 
100 percent on the y axis and time on the x axis.

Each discrete channel is color coded. Channel A is yellow, Channel B is purple, and 
Channel C is blue.

Table 49. Display page parameters  (Sheet 4 of 4)

Parameter Description
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Information Page

Use the Information page to monitor the chronological run log, instrument version, and 
system date and time. The error log is an ongoing record of critical and non-critical errors in 
the PDA detector. The log is generated and stored in the detector. This data is useful for 
troubleshooting hardware and software problems.

 To open the Information page

1. Open the Direct Control dialog box for the PDA detector (see “PDA Detector Direct 
Controls” on page 162).

2. Click the Information tab.

The Information page appears (see Figure 102).

Figure 102. Information page
Thermo Scientific Surveyor Plus User Guide for LC Devices 181



6 Direct Controls
PDA Detector Direct Controls
Information Page Parameters

Table 50 describes the parameters on the Information page.

Table 50. Information page parameters 

Parameter Description

Error Log

Error Log Displays errors that are generated by the PDA detector. The error log can hold up to 100 
errors. When the error log is full, the newest error log entry replaces the oldest error log 
entry. The error log is protected by a backup battery when the detector is turned off.

Tip  For best results, save the error log (print to file) before you clear it. The error log is 
useful during preventive and problem maintenance.

Buttons

Request Log Downloads the error log that is stored in the PDA detector and displays the results in the 
Error Log box.

Clear Log Erases the current error log.

Tip  For best results, save the error log (print to file) before you clear it. The error log is 
useful during preventive and problem maintenance.

Export Log Exports the log to a comma-separated values file that you can open with the Excel 
application.

Versions

Versions display box Displays the version number for the detector firmware. This information is useful to 
determine if firmware upgrades are necessary. Have this information handy whenever you 
contact your Thermo Fisher Scientific service representative.

Date and Time

Date and time Displays the current system date and time. This is the time that the data system uses for 
entries in the error log and the time stamp on the snapshot file.
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UV-Vis Detector Direct Controls
Use the Direct Control dialog box for the UV/Vis detector to turn the lamps on or off and to 
zero the chromatographic baseline.

 To turn the UV/Vis detector’s lamps on or off

1. Open the Surveyor UV/Vis Instrument Setup view.

2. From the menu bar, choose Surveyor UV/Vis > Direct Control.

The Direct Control dialog box for the UV/Vis Detector appears (see Figure 103).

Figure 103. Direct Control dialog box for the UV/Vis Detector

3. In the Deuterium Lamp area, click Lamp On.

 To zero the absorbance

Click Zero.

UV/Vis Direct Control Parameters

Table 51 describes the buttons and readbacks in the Direct Control dialog box for the UV/Vis 
detector.

Table 51. Direct control parameters for the UV/Vis detector  (Sheet 1 of 2)

Parameter Description

Deuterium Lamp

Lamp On Turns the deuterium lamp on.

Lamp Off Turns the deuterium lamp off.
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Tungsten Lamp

Lamp On Turns the tungsten lamp on.

Lamp Off Turns the tungsten lamp off.

Other Options

Zero Zeros the absorbance reading from the detector.

Readbacks

Status Displays the state of the UV/Vis detector:

Ready The detector is ready to start data acquisition.

Off The detector is not ready to start data acquisition 
because one or both lamps are off.

Depending on the acquisition wavelengths 
specified in the downloaded instrument method, 
one or both lamps must be on.

• For the UV range, the deuterium lamp must 
be on.

• For the visible range, the tungsten lamp 
must be on.

• When the wavelength table specifies 
wavelengths in both the UV and visible 
ranges, both lamps must be on.

Running The detector is acquiring data.

AU1 Displays the current absorbance value for the first wavelength 
channel.

AU2 Displays the current absorbance value for the second wavelength 
channel.

Table 51. Direct control parameters for the UV/Vis detector  (Sheet 2 of 2)

Parameter Description
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Pump Direct Controls
The Surveyor product line includes the Surveyor LC Pump Plus and the Surveyor MS Pump 
Plus.

These topics describe the direct controls for your Surveyor Plus pump:

• Surveyor LC Pump Plus Direct Controls

• Surveyor MS Pump Plus Direct Controls

Surveyor LC Pump Plus Direct Controls

Use the Surveyor LC Pump Direct Control dialog box to quickly draw fresh solvent through 
the solvent lines, clear an error condition, download new solvent conditions to the pump, and 
start and stop the solvent flow from the pump.

For information on opening the Direct Control dialog box and using the direct controls for 
the Surveyor LC Pump Plus, see these topics:

• Opening the Direct Control Dialog Box for the Surveyor LC Pump Plus

• Operation - Surveyor LC Pump Direct Control Parameters

• Removing Air from the Solvent Lines Connected to the Surveyor LC Pump Plus

• Downloading New Solvent Conditions to the Pump

• Starting and Stopping the Solvent Flow

• Clearing an Error Condition for the Pump

Opening the Direct Control Dialog Box for the Surveyor LC Pump Plus

In the pump view, the direct controls are on the Operation - Surveyor LC Pump Direct 
Control dialog box. In the Tune window for your Thermo Scientific mass spectrometer, the 
direct controls for the pump are on the pump page of the Inlet Direct Control dialog box.

 To open the Operation - Surveyor LC Pump Direct Control dialog box

1. Open the pump view.

2. From the menu bar, choose Surveyor LC Pump > Direct Control > Operation.

The Operation - Surveyor LC Pump Direct Control dialog box appears.
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 To access the direct controls for the pump from the Tune window

1. Open the Tune window for your Thermo Scientific mass spectrometer.

2. Choose Setup > Inlet Direct Control. 

The Inlet Direct Control dialog box that contains tabbed pages for each configured LC 
device appears.

3. Click the Surveyor LC Pump tab.

Operation - Surveyor LC Pump Direct Control Parameters

Table 52 describes the direct control parameters for the Surveyor LC Pump Plus.

Table 52. Operation - Surveyor LC Pump Direct Control parameters  (Sheet 1 of 2)

Parameter Description

Pump

Pump On Turns on the solvent flow from the pump. 

Pump Off Turns off the solvent flow from the pump. 

Error Condition

Clear Clears the error log. You must clear the error log before you can restart the solvent flow from 
the pump.

Method

Flow Rate Specifies the flow rate, in mL/min. 

Range: 0.000 to 9.999 mL/min 

Component A, B, C, 
or D

Specifies the percent composition of solvent A, B, C, or D. 

Download Downloads the new mobile phase settings to the on-board CPU of the Surveyor LC Pump 
Plus.

Purge

Purge Time Specifies the length of time that the pump draws solvent through the system at 
approximately 10 mL/min.

Range: 0.1 to 9.9 minutes

Solvent Valve Specifies the solvent proportioning valve that is activated. The pump draws solvent from the 
solvent line connected to this proportioning valve.

Note  The Surveyor LC Pump Plus is a quaternary gradient pump that can be set up to 
pump four solvents. The solvent lines are labeled A, B, C, and D. You must purge each 
separately.
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Removing Air from the Solvent Lines Connected to the Surveyor LC Pump Plus

Use the purge feature to remove air bubbles from the solvent lines or the pump heads. If the 
solvent line connecting the solvent reservoir bottle to the degassing assembly is completely 
dry, attach a syringe to the drain line and open the drain valve. Make sure that the pump 
power is on, and then draw the syringe barrel back, pulling solvent into the line.

 To remove air from the solvent lines or the pump head assemblies

1. Open the drain valve by turning it counterclockwise 180° to the purge position. Look for 
the word DRAIN to appear upside down on the knob (see Figure 104).

Figure 104. Drain valve knob in the closed and open positions

2. Open the view for the Surveyor LC Pump Plus.

3. From the menu bar, choose Surveyor LC Pump > Direct Control > Operation.

The Operation - Surveyor LC Pump Direct Control dialog box appears (see Figure 105).

Purge Draws the specified solvent at a speed of approximately 10 mL/min through the pump for 
the specified purge time. 

CAUTION  Before you click the Purge button, open the drain valve by turning the drain 
valve knob 180° counterclockwise. 

Stop Purge Stops the solvent flow from the pump.

Tip  After you finish purging the pump, close the drain valve by gently turning the drain 
valve knob clockwise until you feel resistance.

Table 52. Operation - Surveyor LC Pump Direct Control parameters  (Sheet 2 of 2)

Parameter Description

Tip  Cyclical baseline noise can be an indication of air in the pump heads.

DRAIN

CLOSE OPEN

DRAIN

CLOSEOPEN

Open positionClosed position
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Figure 105. Operation page of the Surveyor LC Pump Direct Control dialog box

4. In the Purge area, do the following:

a. In the Purge Time box, type an appropriate purge time. 

The range is 0.1 to 9.9 minutes. Each solvent line holds approximately 3 mL of 
solvent.

b. From the Solvent Valve list, select the solvent valve for the solvent line that you want 
to draw solvent through. 

c. Click Purge.

The pistons of the pump begin to move rapidly, increasing the flow rate to 
9.99 mL/min.

5. After drawing fresh solvent through the solvent lines, close the drain valve.

Downloading New Solvent Conditions to the Pump

 To download new solvent conditions to the pump

1. Open the Surveyor LC Pump Plus view.

2. From the menu bar, choose Surveyor LC Pump > Direct Control > Operation.

The Operation - Surveyor LC Pump Direct Control dialog box appears.
188 Surveyor Plus User Guide for LC Devices Thermo Scientific



 6 Direct Controls
Pump Direct Controls
3. In the Method area, do the following:

a. In the Flow rate box, type the flow rate.

The range is 0.001 to 9.999 mL/min.

b. In the Component A, B, C, and D boxes, type the solvent composition.

c. Click Download.

Starting and Stopping the Solvent Flow

 To start or stop the solvent flow

1. Open the Operation - Surveyor LC Pump Direct Control dialog box (see “Surveyor LC 
Pump Plus Direct Controls” on page 185).

2. Do one of the following:

• To start the solvent flow, click Pump On.

• To stop the solvent flow, click Pump Off.

Clearing an Error Condition for the Pump

When an error condition occurs, the solvent flow from the pump stops. Before you can restart 
the solvent flow, you must clear the error condition.

 To clear an error condition for the pump

1. Open the Surveyor LC Pump Plus view.

2. From the menu bar, choose Surveyor LC Pump > Direct Control > Operation.

The Operation - Surveyor LC Pump Direct Control dialog box appears.

3. Click Clear.
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Surveyor MS Pump Plus Direct Controls

Use the Direct Control dialog box to download new solvent conditions to the pump, start and 
stop the solvent flow from the pump, and change the global pressure limits.

 To download new solvent conditions to the pump

1. Turn on the power to the pump.

2. To open the Direct Control dialog box from the pump view, do the following:

a. From the menu bar of the pump view, choose Surveyor MS Pump Plus > 
Direct Control.

The Direct Control dialog box for the pump appears (see Figure 106).

Figure 106. Direct Control dialog box for the Surveyor MS Pump Plus

3. In the Direct Control dialog box, do the following: 

a. Select the Take Pump Under Control check box.

b. In the Flow box, type an appropriate flow rate for the pump. If you are drawing fresh 
solvent through the lines and the liquid displacement assembly, type the maximum 
flow rate for the pump.

Tip  To open the direct controls for the pump from the Tune window, choose Setup > 
Inlet Direct Control from the menu bar. Then click the pump tab.

Tip  When the power to the pump is off, the proportioning valves are closed. Before 
you take the LDA apart to perform maintenance, turn off the power to the pump to 
prevent solvent from leaking out of the proportioning assembly.
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The maximum flow rate for the Surveyor MS Pump Plus is 1000 μL/min.

c. Type percentages for the solvent lines that you want to draw solvent through in the 
Inlet boxes (A, B, C, and D).

 To start the solvent flow 

Click  (Start). 

 To stop the solvent flow

Click  (Stop).

 To change the global pressure limits

1. Click Pressure Limits.

The Pressure Limits dialog box appears (see Figure 107).

Figure 107. Pressure Limits dialog box

2. In the Min. Pressure box, type the minimum operating pressure for the pump.

3. In the Max. Pressure box, type the maximum operating pressure for the pump.

The maximum pressure for the Surveyor MS Pump Plus is 1000 bar (100 MPa or 
14 504 psi).

4. Click OK to accept the settings and close the dialog box.
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Autosampler Direct Controls
The On/Off switch is the only manual control provided with the autosampler. To perform 
tasks such as moving the XYZ arm to the back of the tray compartment, use the direct control 
commands in the autosampler view or the tune application for your Thermo Scientific mass 
spectrometer.

These topics describe the direct controls for the autosampler:

• Applying a Direct Command

• Direct Control Commands for the Autosampler

• Flushing the Autosampler Syringe

• Removing and Installing Sample Trays

• Controlling the Tray and Oven Compartment Temperatures

You can access the direct control commands for the autosampler from the autosampler view of 
your data system or the tune application for your mass spectrometer.

 To open the Inlet Direct Control dialog box from the tune application

1. In the Tune window, choose Setup > Inlet Direct Control. 

The Inlet Direct Control dialog box appears with tabbed pages for each configured LC 
device.

2. Click the Surveyor AS tab.

The Surveyor AS page appears (see Figure 108).
192 Surveyor Plus User Guide for LC Devices Thermo Scientific



 6 Direct Controls
Autosampler Direct Controls
Figure 108. Inlet Direct Control dialog box for the Surveyor pump and autosampler

 To open the Direct Control dialog box

1. Open the autosampler view.

2. From the menu bar, choose Surveyor AS > Direct Control. 

The Direct Control dialog box appears (see Figure 109).

Figure 109. Direct Control dialog box (Instrument Setup window)
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Applying a Direct Command

 To apply a direct command

1. Select a command from the list of commands.

If the command requires additional parameters, these parameters appear below the list. 
Make the appropriate entries and selections.

2. To execute the command, click Apply.

Direct Control Commands for the Autosampler

Table 53 describes the direct control commands for the autosampler. 

Table 53. Direct control commands for the autosampler (Sheet 1 of 3)

Command Description

Position Arm to 
Access Tray

Moves the XYZ arm to the back of the tray compartment so that you can remove trays from 
or place trays into the tray compartment.

Note. If the tray compartment door is open and you selected the Verify Door Is Closed 
check box when you configured the autosampler, the autosampler does not execute this 
command until you close the tray compartment door. 

Flush Syringe Flushes the needle tubing and the interior of the needle with flush solvent.

Parameter Selections or range

Reservoir RV1, RV2, RV3, RV4, or Bottle

Volume 0 to 6000 μL

Flush Speed Depends on the syringe type as follows:

Syringe type Range

Concentric syringes 1.65 to 661.38 μL/s

Standard 2500 μL syringe 0.83 to 330.85 μL/s 

Flush Syringe at 
Fill Position

Flushes the needle tubing, the interior of the needle, and the sample loop with flush solvent. 
For the parameter descriptions, see Flush Syringe.

Wash Needle Washes the exterior of the needle with solvent.

Parameter Selections or range

Reservoir RV1, RV2, RV3, RV4, or Bottle

Volume 0 to 6000 μL
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Needle Removal Sets the needle to the needle removal position. Apply this command before you remove the 
needle from the XYZ arm.

Set Oven Temperature Sets the temperature of the column oven compartment without downloading an instrument 
method. 

Parameter Range

Temperature 5 to 95 °C

IMPORTANT      Avoid setting the temperature above the boiling point of the mobile 
phase. 

Set Tray Temperature Sets the temperature of the tray compartment without downloading an instrument method. 
The temperature range is 0 to 60 °C.

Parameter Range

Temperature 0 to 60 °C

Turn Off 
Oven Temperature

Turns off the oven temperature control, allowing the temperature of the column oven 
compartment to return to ambient.

Turn Off 
Tray Temperature

Turns off the tray temperature control, allowing the temperature of the tray compartment to 
return to ambient.

Inject Sample Injects a sample. 

Parameter

Vial The vial or well entries depend on the tray configuration:

Tray type Vial locations

Conventional trays A:01 to E:40

96-well plates A:A1 to C:H12

384-well plates A:A1 to C:P24

Volume For the no waste and partial loop injection modes, the minimum injection 
volume is 0.1 μL. 

The maximum volume depends on the syringe type:

Syringe Maximum volume

100 μL concentric syringe  20 μL

250 μL concentric syringe 125 μL

500 μL concentric syringe 300 μL

2500 μL standard syringe 1250 μL

Injection 
Mode

Full Loop, Partial Loop, and No Waste.

Table 53. Direct control commands for the autosampler (Sheet 2 of 3)

Command Description
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Flushing the Autosampler Syringe

To ensure the proper performance of the autosampler, remove air from the wash bottle tubing 
and the autosampler syringe before you make your first injection. Once you have your system 
running, periodically check the level of solvent in the wash bottle and remove air from the 
syringe as needed. 

 To flush air out of the wash bottle tubing and the autosampler syringe

1. Open the view for the autosampler.

2. From the menu bar, choose Surveyor AS > Direct Control. 

The Direct Control dialog box for the Surveyor Autosampler Plus appears 
(see Figure 110).

Move Needle Moves the XYZ arm to a specific vial or well location.

Set Injector Position Switches the position of the injection valve. The injection valve has two positions: fill and 
inject.

Set Syringe to 
Removal Position

Sets the syringe to its removal position.

Set Syringe to 
Home Position

Sets the syringe to its home position.

Set Arm to 
Home Position

Moves the XYZ arm to its home position, which is just above the injection port.

Button

Apply Executes the command.

Table 53. Direct control commands for the autosampler (Sheet 3 of 3)

Command Description

Tip  During a flush operation, the autosampler draws wash solvent into the syringe and 
then pushes wash solvent through the needle tubing and the injection port to waste. 
If you want to remove residual sample from the sample loop, use the Flush Syringe at Fill 
Position command.
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Figure 110. Flush syringe direct control command

3. Initiate the Flush Syringe command:

a. Select Flush Syringe from the list of commands. 

The parameters for the command appear below the list.

b. In the Reservoir list, select Flush Bottle.

c. In the Volume box, type an appropriate flush volume. 

The maximum flush volume is 6000 μL.

d. Click Apply to download the command to the autosampler.

4. Verify that the wash bottle tubing and syringe are free of air (see Figure 111).

5. Close the Direct Control dialog box.
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Figure 111. Solvent path for flushing the syringe
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Removing and Installing Sample Trays

If you did not select the Verify Door Is Closed check box when you specified the 
configuration options for the autosampler, the XYZ arm does not move to the back of the tray 
compartment when you open the tray compartment door.

For information on specifying the configuration settings for the Surveyor Autosampler Plus, 
see “Surveyor Autosampler Plus Configuration Settings” on page 45.

 To remove or install a sample tray

1. Open the Direct Control dialog box for the autosampler.

2. In the Direct Command list, select Position Arm to Access Tray.

3. Click Apply.

The XYZ arm moves to the back of the tray compartment.

Controlling the Tray and Oven Compartment Temperatures

The autosampler has two controlled temperature zones: the tray compartment and the 
column oven compartment. Before you start a sequence run, equilibrate the controlled 
temperature zones at the temperature specified in the instrument method.

Use the direct commands in the Direct Control dialog box or the Inlet Direct Control dialog 
box to control the oven and tray compartment temperatures. For information about opening 
the Direct Control and Inlet Direct Control dialog boxes, see “Autosampler Direct Controls” 
on page 192.

 To download a new column oven temperature

1. Select Set Oven Temperature from the list of commands.

2. In the Temperature box, type an appropriate value for the column oven temperature.

The range is 5 to 95 °C.

3. Click Apply.

 To turn the column oven off

1. Select Turn Off Oven Temperature from the list of commands.

2. Click Apply.

IMPORTANT      Do not set the oven temperature above the boiling point for the 
mobile phase solvent.
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 To download a new tray compartment temperature 

1. Select Set Tray Temperature from the list of commands.

2. In the Temperature box, type an appropriate value for the tray compartment temperature.

The range is 0 to 60 °C.

3. Click Apply.

 To turn the column oven off

1. Select Turn Off Tray Temperature from the list of commands.

2. Click Apply.
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7

Sequence Setup

This chapter describes how to acquire and view chromatographic and PDA spectral data using 
the Xcalibur data system.

Creating a Single Sample Sequence
To set up a sequence to inject a single sample, follow these procedures in order:

1. Opening the Sequence Setup Window

2. Creating the Sequence

3. (Optional) Selecting the Vial Locations Interactively

4. Saving the Sequence

Opening the Sequence Setup Window

 To open the New Sequence Template dialog box

1. Click the Sequence Setup icon on the Home Page. 

The Thermo Xcalibur Sequence Setup window appears (see Figure 112).

Contents

• Creating a Single Sample Sequence

• Equilibrating the Chromatographic Column

• Loading the Autosampler

• Starting Data Acquisition

• Working with the Real Time Plot View
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Figure 112. Sequence Setup window

2. From the Sequence Setup window, choose File > New.

The New Sequence Template dialog box appears (see Figure 113). Go to the next topic, 
“Creating the Sequence” on page 203.

Figure 113. New Sequence Template dialog box
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Creating the Sequence

 To create a new sequence

1. If it is not already open, open the New Sequence Template dialog box (see “Opening the 
Sequence Setup Window” on page 201).

2. In the General area, make the following entries and selections:

a. In the Base File Name box, type a name for the raw data file.

b. Browse to the data file directory where you want to store your raw data files. 

The data system adds the .raw file extension to the data files that contain the 
chromatographic and spectral data. 

c. Browse to the instrument method that you want to use to acquire your raw data files.

Instrument methods have a .meth file extension. The Instrument Setup view for the 
Surveyor Plus devices is described in Chapter 3, “Instrument Method Setup.” 

d. If you have not yet created a processing method that contains the information needed 
to quantitate your unknowns, do not select a processing method. 

You can create a processing method and reprocess your stored data files at a later date. 
Processing methods have a .pmd file extension. For information about performing 
tests to determine the suitability of your chromatographic method and on creating 
calibration curves to quantitate your unknowns, refer to the Thermo Xcalibur 
Quantitative Analysis User Guide.

3. In the Samples area, specify the vial locations by doing one of the following:

• To specify a contiguous set of sample vials or well locations:

– In the Number of Samples box, type the number of samples that you want to 
analyze.

– In the Initial Vial Position box, type the vial position.

The vial positions for the conventional trays are shown in Figure 114. 
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Figure 114. Vial positions for conventional sample trays

For more information about the vial locations for conventional trays and the well 
locations for microwell plates, see “Vial and Well Notation” on page 6.

• To select a non-contiguous set of sample vials or well locations, click Select Vials, and 
then select the vial or well locations by using the Vial Selection dialog box.

For information about using the Vial Selection dialog box, see “Selecting the Vial 
Locations Interactively” on page 206.

4. In the Injections per Sample box, type the number of injections per sample that you want 
the autosampler to make per vial or well location.

5. In the Base Sample ID box, type an identifying name for the sample.

Base sample IDs are optional. If you do not enter a sample identification, the data system 
automatically uses the vial position as the sample identification. If you enter a sample 
identification, the data system automatically appends the vial position to your entry.

6. Click OK to display your sequence spreadsheet (see Figure 115).
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Slot for tray

Vial position
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Vial position
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The injection volume displayed in the Inj Vol column matches the injection volume 
contained in your instrument setup method. You can override this injection volume 
value.

7. To change the injection volume, double-click the spreadsheet cell containing the injection 
volume value that you want to change, highlight the current value, and then type a new 
value in the cell.

For full details of all the parameters in the New Sequence Template dialog box, refer to 
the Help or the Xcalibur manual set.

Figure 115. Sequence Setup view, showing newly created one-line sequence

8. To alter the current column arrangement:

a. Click the Column Arrangement toolbar button. 

The Column Arrangement dialog box appears (see Figure 116). 

Figure 116. Column Arrangement dialog box
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b. Do one of the following:

• To add a column to the sequence, select the column from the Available Columns 
list, and click Add.

• To remove a column from the sequence, select the column from the Displayed 
Columns list, and click Remove.

• To alter the position of the columns in the sequence, select the column from the 
Displayed Columns list, and click either Move Up or Move Down as 
appropriate.

Selecting the Vial Locations Interactively

Use the Vial Selection dialog box to select specific vials for the sequence template. 

 To interactively select vial or well locations for the sequence list

1. In the Sequence Setup window, choose File > New.

The New Sequence Template dialog box appears.

2. In the Samples area, click Select Vials.

The Vial Selection dialog box appears (see Figure 117).
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Figure 117. Vial Selection dialog box

3. Click on a vial position to add it to the sequence template. 

4. When you have finished making your selection, click OK. 

The vial or well locations appear in the position column in the order that you selected 
them.
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Saving the Sequence

 To save the sequence

1. Choose File > Save As.

The File Summary Information dialog box appears (see Figure 118).

Figure 118. File Summary Information dialog box

2. In the Description box, type an appropriate description. Then click OK.

The Save As dialog box appears (see Figure 119).

Figure 119. Save As dialog box, showing the file extension for a sequence file 

3. Browse to the appropriate folder where you want to save the sequence. 
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4. In the File Name box, type a file name.

5. Click Save.

Equilibrating the Chromatographic Column
Warming up the deuterium lamp and equilibrating the LC column reduces baseline drift. For 
information about warming up the D2 lamp, see “Turning the Lamps On or Off” on 
page 163.

\An LC column requires 10 to 20 column volumes to equilibrate to the initial mobile phase 
conditions of an instrument method. For example, it takes approximately 17 mL of mobile 
phase to equilibrate a typical 4.6 mm ID×10 cm length column.

To calculate the volume of an LC column, use the following equation:

 To equilibrate your LC column

1. From the Thermo Xcalibur Roadmap menu, choose GoTo > Instrument Setup to 
display the Instrument Setup window.

2. Download the same solvent percentages and flow rate as those contained in your method 
to the pump:

• For information on downloading new solvent conditions to the Surveyor LC Pump 
Plus and starting the solvent flow, see “Surveyor LC Pump Plus Direct Controls” on 
page 185. 

• For information on downloading new solvent conditions to the Surveyor MS Pump 
Plus and starting the solvent flow, see “Surveyor MS Pump Plus Direct Controls” on 
page 190.

3. In the status view for your pump (available on the Status page of Info View), monitor the 
readings in the Pressure Status area to ensure that the pressure is appropriate for your 
application. See “Viewing the Status of Each Device” on page 137.

Vm = Πr2 × L

Where:

Vm = volume in mL

r = column radius in cm (radius = inner diameter/2)

L = column length in cm
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Loading the Autosampler
Before you load your samples into the autosampler, ensure that your samples are completely 
soluble in the mobile phase and that you have filtered your samples through a 0.5 μm filter (if 
necessary). These techniques minimize sample precipitation in the lines and remove 
particulate matter that could obstruct the flow through the autosampler’s injection valve or 
the LC column. In addition, make sure that the vial caps are securely fastened onto the vials.

Before you start a sequence run, ensure that you have samples in the locations specified in 
your sequence.

 To load a conventional tray into the autosampler

1. Open the left door of the autosampler.

If you configured the Surveyor AS device driver to verify that the tray compartment door 
is closed, the XYZ arm automatically moves to the back of the tray compartment. 

Figure 37 on page 53 shows the location of the Verify Door Is Closed check box, available 
in the Instrument Configuration window.

2. If necessary, use the direct controls to move the XYZ arm to the back of the tray 
compartment (see “Autosampler Direct Controls” on page 192).

3. Hold the tray handle, tilting the back end of the tray down. Insert the tray runner into 
the slot at the rear of the tray compartment. Lower the front of the tray into place. Then 
press down firmly to seat the tray.

Note  To trigger the vial sensor, make sure to position custom vials in the tray so that the 
top of the vial reaches the minimum height of 1.55 inches. If you place vials that fall 
below this minimum height in the tray, the vial sensor does not detect them. When the 
sequence reaches a vial that is below the minimum height, the sequence halts, and the Vial 
Not Found message appears.
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Starting Data Acquisition
 To inject a sample and start data acquisition

1. Open the sequence file containing the information for the sample that you want to inject:

a. From the Sequence Setup view, choose File > Open. 

The Open dialog box appears (see Figure 120).

Figure 120. Open dialog box, showing the selection of a sequence file

b. Browse to the appropriate folder. 

c. Select the sequence that contains the sample you want to run.

You can identify sequence files by their .sld file extension.

d. Click Open.

The selected sequence appears.

2. Highlight the sequence row that you want to run. Do this even if the sequence contains 
just one row. Figure 121 shows a highlighted sequence row.
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Figure 121. Sequence Setup view, showing the first row selected

3. Confirm that you have a vial in the position specified in the sequence row.

4. From the toolbar, click the Run Sample button. 

The Run Sequence dialog box appears (see Figure 122).

The User box contains your login name, and the Run Rows box contains the row number 
that you selected in the sequence spreadsheet.

Figure 122. Run Sequence dialog box
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5. Confirm the following:

• The MS detector and LC components are configured for operation as Xcalibur 
devices in the Instrument list. 

• The autosampler is specified as the start instrument. Yes is displayed in the 
Start Instrument column next to Surveyor AS (see Figure 123).

Figure 123. Surveyor AS specified as the start instrument

After the autosampler injection valve switches to the inject position, the autosampler 
sends a signal to the detector to begin data acquisition.

6. Set up how the run is started as follows:

• To start the run automatically, select the Start When Ready check box. 

After you complete the entries and selections in the Run Sequence dialog box and 
click OK, the run begins after the pump sends a pump ready signal to the 
autosampler. The pump does not indicate the Ready state until it monitors a stable 
backpressure as defined in your instrument method.

• To start the run manually, clear the Start When Ready check box.

7. In the After Sequence Set System area, select one of these three options:

• To keep the devices in the On state, select the On option.

• To automatically turn off the solvent flow from the pump and the detector’s lamps at 
the end of the sequence run, select the Off option. 

• To turn off the solvent flow from the pump but keep the lamps at the end of the 
sequence run, select the Standby option. 

8. Keep the parameters in the other areas at their defaults. 

You can use the Instrument Method and Programs areas in the Run Sequence dialog box 
to specify particular acquisition or processing requirements. For full details of these 
features, refer to the Xcalibur Help.

9. Start the run as follows:

• For automated runs, click OK to start the run.

• For manual runs, click OK, and then choose Actions > Start Analysis from the 
Sequence Setup menu. To subsequently control the acquisition, choose Actions > 
Pause Analysis or Actions > Stop Analysis.
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Working with the Real Time Plot View
To view and review data as it is being acquired in the Real Time Plot view, follow these 
procedures:

• Viewing Data Acquisition

• Reviewing Real-Time Data

• Adding Cells to the Display

Viewing Data Acquisition

 To view the data as it is acquired

1. Choose View > Real Time Plot View, or click the Real Time Plot View button on the 
Home Page toolbar. 

2. If the display is not already locked, click the Lock Display button to lock the display. 

Locking the display lets you monitor the real-time progress of your run.

In the unlocked position, you cannot monitor the real-time progress of your run, but you 
can review your data. For example, you can display the spectrum for a particular peak that 
has already eluted. Data collection continues off screen as you review your data.

If you are collecting PDA scan data, a view similar to that shown in Figure 124 is 
displayed. The view contains three cells: a chromatogram cell, a spectrum cell, and a Total 
Scan cell. 

Locked

Unlocked
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Figure 124. Real Time Plot view, showing the acquisition of PDA scan data and one discrete channel

Reviewing Real-Time Data

You can review the data as it is being collected. 

 To view the spectrum for a particular peak in the chromatogram

1. To unlock the display, click the Lock Display button.

After you unlock the display, data collection continues off screen.

2. Pin the spectrum cell by clicking the pin in the upper-right corner of the cell.

The pin in the upper-right corner of the spectrum cell turns green. Cursor actions in 
other cells, such as the chromatogram cell, affect the view displayed in the pinned 
spectrum cell.

Lock display button
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3. In the chromatogram cell, click the peak of interest.

In the spectrum cell, a spectrum appears for the time point that you clicked.

4. Click the Lock Display button to resume monitoring real-time data acquisition.

5. Pin the chromatogram cell by clicking the pin in the upper-right corner of the cell.

The pin in the upper-right corner of the chromatogram cell turns green. Cursor actions 
in other cells such as the spectrum cell affect the view displayed in the pinned 
chromatogram cell.

6. In the spectrum cell, click the wavelength of interest.

In the chromatogram cell that contained the Total Scan chromatogram, a scan 
chromatogram appears for the specific wavelength that you clicked.

7. Click the Lock Display button to resume monitoring real-time data acquisition.

Adding Cells to the Display

You can display multiple cells in the Real Time Plot view. 

 To display multiple chromatogram cells

1. Click the chromatogram cell to make it the active cell with a gray border.

2. Choose View > Ranges. 

The Chromatogram Ranges dialog box appears (see Figure 125).
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Figure 125. Chromatogram Ranges dialog box

3. For each cell that you want to add, do the following:

a. In the Type column, select its corresponding check box. 

b. In the Detector list, select a detector. 

c. In the Plot Type list, select a plot type.

4. Click OK to close the Chromatogram Ranges dialog box.

5. Choose View > Lock Display to resume monitoring real-time data acquisition.
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Qual Browser

This chapter provides an introduction to the Xcalibur Qual Browser functions that you can 
use to review the PDA data contained in your .raw data files.

Opening a Raw Data File in Qual Browser
Data files containing the raw chromatographic and spectral data have the .raw file extension. 

 To open a .raw file in Qual Browser

1. Click the Qual Browser icon in the Roadmap view of the Homepage window, or choose 
GoTo > Qual Browser.

The empty Qual Browser window appears (see Figure 126).

Contents

• Opening a Raw Data File in Qual Browser

• Working with the Cell Grid

• Changing the Font Size of the Display

• Viewing a Report of the Instrument Method

• Creating a Layout for PDA Data

• Viewing the Spectrum for a Specific Time Point

• Viewing the Chromatogram for a Specific Wavelength

• Determining Peak Areas

• Calculating the Purity of the Chromatographic Peaks
Thermo Scientific Surveyor Plus User Guide for LC Devices 219



8 Qual Browser
Opening a Raw Data File in Qual Browser
Figure 126. Empty Qual Browser window

2. Choose File > Open. 

The Open Raw Data File dialog box appears (see Figure 127).

Figure 127. Open Raw File dialog box

3. Select the .raw file that you want to review.
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4. Select the layout from the list at the bottom of the dialog box. 

The available selections are Default Layout and Current Layout. Select Current Layout if 
the current layout for the Qual Browser window is different from the default layout and 
you want to apply it to your data file.

5. Click Open.

If the default layout has not been modified and your raw file contains MS data in 
addition to PDA or UV data, the data file opens with the MS TIC chromatogram in the 
upper cell and a mass range spectrum in the lower cell. For an explanation of cells, see 
“Working with the Cell Grid” on page 224. The y axis for these cells is set to relative 
absorbance (see Figure 128).

Figure 128. Qual Browser view with a chromatogram cell displaying MS TIC data and a spectrum cell displaying 
mass range data

6. To apply a custom window layout to the Qual Browser view, do the following:

a. Choose File > Layout > Apply. 

The Open Layout File dialog box appears (see Figure 129).
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Figure 129. Open Layout File dialog box

b. Select a layout file from the list. 

Layout files have the .lyt file extension.

c. Click Open to apply the layout to the raw data file.

Figure 130 shows a custom layout file applied to a raw data file containing both MS 
data and PDA data. The custom layout replaces the MS TIC chromatogram with a 
Total Scan chromatogram for the PDA data. It also replaces the mass range spectrum 
data from the MS detector with the spectral data from the PDA detector.

For instructions on how to create a Layout file for your PDA data, see “Creating a 
Layout for PDA Data” on page 233. 
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Figure 130. Qual Browser view with a chromatogram cell displaying a Total Scan from the PDA detector and a spectrum cell 
displaying the spectral data from the PDA detector for time 0

Spectrum for time = 0 minutes
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Working with the Cell Grid
To use the Qual Browser facility, you must understand the concept of cell states and the effect 
of cursor actions in a cell. This section contains the following topics:

• Cell States

• Cursor Actions

Cell States

When you open a raw data file in the Qual Browser window, the information within the data 
file is displayed as a grid of cells. 

There are three hierarchal states for a cell within the grid:

• Inactive Cells

• Active but Unpinned Cells 

• Active and Pinned Cells

The grid always contains either one active but unpinned cell or one pinned cell. If the grid 
contains more than one cell, only one cell can be active and the rest of the cells are inactive.

An unpinned cell has a gray pin icon in its upper-right corner.

A pinned cell has a green pin icon in its upper-right corner.

Inactive Cells

Inactive cells are not highlighted with a gray border and the pin icon in their upper-right 
corners is gray. The cell in the lower portion of Figure 131 is inactive as indicated by the 
absence of a gray border. Menu commands, toolbar buttons, and cursor actions do not affect 
inactive cells. To zoom in on the contents of a cell or access its shortcut menu, you must make 
the cell active.
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Figure 131. Qual Browser window, displaying an active chromatogram cell and an inactive PDA spectrum cell

Active but Unpinned Cells

An active but unpinned cell is highlighted with a gray border, and the pin icon in its 
upper-right corner is gray. The cell in the upper portion of Figure 131 is active but unpinned. 
Menu commands, toolbar buttons, and cursor actions affect the active cell. If the grid does 
not contain a pinned cell, clicking an inactive cell in the grid makes it the active cell.

Active and Pinned Cells

Clicking the pin in the upper-right corner of a cell makes it the pinned cell within the grid. A 
pinned cell is an active cell that cannot be made inactive by clicking in another cell. Instead, 
actions performed in the inactive cells affect the pinned cell as described in the next topic, 
“Cursor Actions” on page 226. The lower cell in Figure 132 is a pinned cell.

To automatically change the range of a cell by clicking in the grid, you must pin the cell. For 
example, to display the spectrum for the 1 minute time point without opening the Spectrum 
Ranges dialog box, pin the spectrum cell, and then click the 1 minute time point in the 
inactive chromatogram cell.

Active cell

Inactive cell

Gray border

Unpinned

Shortcut 
menu for 
chromatogram 
cell
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Figure 132. Qual Browser window, displaying an inactive cell and a pinned cell

Cursor Actions

Within the cells of the grid, you can use the cursor in three ways:

• A click selects a point on the cell.

• A line dragged parallel to any axis selects a range.

• A line dragged in any diagonal direction selects an area.

The effect of these actions depends on the state of the cell. Within an active cell, cursor 
actions rescale the plot (see Table 54). 

Inactive cell

Pinned cell

Table 54. Effect of cursor action in an active cell

Cursor action Effect

Drag parallel to x axis Rescales graph showing selected x-axis range only, same 
y-axis range.

Drag parallel to y axis Rescales graph showing selected y-axis range only, same 
x-axis range.

Dragged area Rescales graph showing both the selected x-axis and y-axis 
ranges.
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If one of the cells is pinned, the cursor action in any of the inactive cells affects the pinned cell 
(see Table 55).

In Figure 133, the spectrum cell on the bottom of the view is pinned. Clicking the 1.8 minute 
time point in the unpinned chromatogram cell causes the spectrum of benzene, which elutes 
at 1.8 minutes, to appear in the pinned spectrum cell. 

Figure 133. Qual Browser window with a pinned spectrum cell and an unpinned chromatogram cell

Table 55. Effect of cursor action in an inactive cell on the pinned cell

Pinned cell Cursor action Effect

Spectrum Click in a chromatogram cell The spectrum cell displays the 
spectrum at that retention time.

Chromatogram Click in a spectrum cell The chromatogram cell displays the 
chromatogram for the wavelength 
selected in the spectrum cell.

In the chromatogram cell, the pointer is 
set to 1.8 minutes, the peak apex for 
benzene.

In the spectrum cell, the spectrum of benzene, which elutes 
at 1.8 minutes under the chromatographic conditions used, 
is displayed.
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In Figure 134, the chromatogram cell on the top of the view is pinned. Clicking a specific 
wavelength in the unpinned spectrum cell displays the chromatogram of the scan wavelength 
in the pinned chromatogram cell.

Figure 134. Qual Browser window with a pinned chromatogram cell and an unpinned spectrum cell

Clicking  (Full Size) in the toolbar sizes the active or pinned cell to the full width and 
height of the window as shown in Figure 135. 

In the chromatogram cell, 
the chromatogram of the 251 nm 
scan wavelength is displayed.

In the spectrum cell, 
the pointer is set to 251 nm.
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Figure 135. Spectrum cell sized to full size of window

Dragging across a region in the active or pinned cell zooms in on that region as shown in 
Figure 136.

Figure 136. Full size view of the spectrum cell zoomed in on the 320 to 380 nm region
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Changing the Font Size of the Display
Occasionally, you might want to change the font size of the data displayed in the Xcalibur 
data system. For example, you might want to increase the font size for screen captures that you 
plan to use for presentations. 

 To increase the font size

1. From the Thermo Xcalibur Roadmap window, choose Tools > Configuration. 

The Thermo Xcalibur Configuration dialog box appears.

2. Click the Fonts tab. 

The Fonts page appears (see Figure 137).

Figure 137. Fonts page in the Thermo Xcalibur Configuration dialog box

3. To increase the font size of the chromatogram, spectrum, and map axis labels, in the 
Proportional Pitch Font area, select a larger font size from the Max list, and select a larger 
font size from the Min list.

4. To increase the font size for the Spectrum List, Scan Header, Scan Filters, or Report, in 
the Fixed Pitch Font area, select a larger font size from the Max list, and select a larger 
font size from the Min list.

Figure 138 shows the chromatogram axes labeled with a font size of 8. Figure 139 shows 
the chromatogram axes labeled with a font size of 16.
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Figure 138. Proportional pitch font size = 8

Figure 139. Proportional pitch font size = 16
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Viewing a Report of the Instrument Method
After you open a data file, you might want to check the instrument parameters that were used 
to acquire it. 

 To view a report that lists the instrument control parameters

1. Choose View > Report > Instrument Method.

The instrument method is displayed in the top cell of the window. The instrument 
method is divided by device, with the parameters for each device displayed on a separate 
page (see Figure 140).

2. Click  (Show Previous and Show Next) to move through the pages of your 
Instrument Method.

Figure 140. Instrument Method Report (PDA page) in the Qual Browser view
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Creating a Layout for PDA Data
This section describes how to view chromatograms and spectral information acquired by the 
PDA detector. In addition, it describes how to save the range and display settings for the PDA 
data in a layout file.

To create a layout file for PDA data, follow these procedures in order:

1. Specifying the Chromatogram and Spectrum Ranges

2. Specifying the Display Options for the Chromatogram and Spectrum Cells

3. (Optional) Inserting Cells

4. Saving the New Layout

Specifying the Chromatogram and Spectrum Ranges

When you open a .raw data file in the Qual Browser application using the default layout, the 
data file opens with the MS TIC chromatogram in the upper cell and a mass range spectrum 
in the lower cell.

Follow these topics to change the upper cell to a chromatogram and the lower cell to spectral 
data acquired by the PDA detector:

• Specifying the Chromatogram Ranges

• Specifying the Spectrum Range

Specifying the Chromatogram Ranges

There are two types of chromatograms for the PDA detector: chromatograms acquired from 
any of the three discrete channels and chromatograms interpolated from the scan data. Follow 
these procedures to display the two types of chromatograms acquired by the PDA detector in 
the Qual Browser window:

• Displaying Scan Wavelength Chromatograms

• Displaying Discrete Wavelength Chromatograms

Displaying Scan Wavelength Chromatograms

 To display a scan chromatogram for the PDA detector data

1. Open a data file (.raw) that has PDA data and MS data (see “Opening a Raw Data File in 
Qual Browser” on page 219).

The data file opens with the MS TIC chromatogram in the upper cell and a mass range 
spectrum in the lower cell. 

Note  You can modify the cells in any order.
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2. Pin the chromatogram cell (see “Active and Pinned Cells” on page 225).

3. Right-click the chromatogram cell. 

4. From the shortcut menu, choose Ranges. 

The Chromatogram Ranges dialog box appears (see Figure 141).

Figure 141. Chromatogram Ranges dialog box with the default layout settings

5. In the Range area, set the displayed time range of the chromatogram:

• For a generic layout file, leave an asterisk in the Time Range box.

When you open a .raw data file, the x axis of the chromatogram is scaled to the run 
time for your detector in the instrument setup method used to acquire the data.

• To specify a specific time range, type a beginning time point and an ending time 
point separated by a dash in the Time Range (minutes) box.
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6. In the Plot Properties area (see Figure 142), make the following selections:

a. In the Detector list, select PDA.

b. In the Peak Algorithm list, select Avalon.

c. In the Plot Type list, select a plot type:

• Select Wavelength to display the chromatogram for a specific wavelength within 
your scan range or to display the averaged results from a range of wavelengths in 
your scan range.

• Select Total Scan to display the average absorbance for each time point of all the 
wavelengths in your scan range.

• Select Spectrum Maximum to display a plot of the maximum absorbance values 
in your scan range for each time point.

d. Select a wavelength range (if you selected the Total Scan plot type, this box is 
unavailable):

• To display the chromatogram for a specific scan wavelength, type the wavelength 
number in the Range(s) box.

• To display a plot of the average absorbance values for a range of wavelengths, type 
the beginning wavelength number and the ending wavelength number separated 
by a dash in the Range(s) box. For example, type 200-300 to display a plot of the 
average absorbance values for the scanned wavelengths from 200 to 300 nm.

Figure 142. Plot Properties area of the Chromatogram Ranges dialog box

7. Click OK to close the dialog box and view your scan chromatogram. 

Figure 143 shows a chromatogram for a wavelength in the PDA scan.

To modify the layout for the spectrum cell, go to “Specifying the Spectrum Range” on 
page 238.
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Figure 143. Chromatogram view with a chromatogram for a PDA scan wavelength

Displaying Discrete Wavelength Chromatograms

 To display a discrete chromatogram for the PDA data

1. If you have not already done so, open a data file (.raw) that has PDA data and MS data 
(see “Opening a Raw Data File in Qual Browser” on page 219).

The data file opens with the MS TIC chromatogram in the upper cell and a mass range 
spectrum in the lower cell. 

2. Pin the chromatogram cell (see “Active and Pinned Cells” on page 225).

3. Right-click the chromatogram cell.

4. From the shortcut menu, choose Ranges. 

The Chromatogram Ranges dialog box appears. Figure 141 on page 234 shows the 
default settings. Figure 144 shows the settings for a discrete channel wavelength.

220 nm
scan wavelength
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Figure 144. Chromatogram Ranges dialog box with the selection of a discrete channel wavelength

5. In the Range area, set the displayed time range of the chromatogram:

• For a generic layout file, leave an asterisk in the Time Range box.

When you open a .raw data file, the x axis of the chromatogram is scaled to the run 
time for your detector in the instrument setup method used to acquire the data.

• To specify a specific time range, type a beginning time point and an ending time 
point separated by a dash in the Time Range box.

6. In the Plot Properties area, select the following:

a. In the Detector list, select UV.

b. In the Peak Algorithm list, select Avalon.

c. In the Plot Type list, select Channel A, Channel B, or Channel C.

7. Click OK to exit the dialog box and view your discrete chromatogram. 

Figure 145 shows a discrete channel chromatogram.
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To modify the layout for the spectrum cell, go to “Specifying the Spectrum Range” on 
page 238. 

Figure 145. Chromatogram view with a chromatogram for a PDA discrete channel

Specifying the Spectrum Range

 To display a spectrum for the PDA data

1. If you have not already done so, open a data file (.raw) that has PDA data and MS data 
(see “Opening a Raw Data File in Qual Browser” on page 219).

The data file opens with the MS TIC chromatogram in the upper cell and a mass range 
spectrum in the lower cell. 

2. Pin the spectrum cell.

3. Right-click the spectrum cell.

4. From the shortcut menu, choose Ranges. 

The Spectrum Ranges dialog box appears (see Figure 146).

5. In the Plot Properties area, select PDA in the Detector list.

Discrete Channel B
wavelength
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6. For a generic layout file for PDA data, keep the other settings in the Spectrum Ranges 
dialog box at their defaults as shown in Figure 146.

Figure 146. Spectrum Ranges dialog box with the PDA detector selected

If you have not already done so, modify the layout for the chromatogram cell as described in 
“Specifying the Chromatogram Ranges” on page 233.

If you have specified the ranges for the chromatogram cell and the spectrum cell, go to the 
next procedure, “Specifying the Display Options for the Chromatogram and Spectrum Cells.” 
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Specifying the Display Options for the Chromatogram and Spectrum Cells

After you specify the chromatogram and spectrum ranges, specify the display options for the 
chromatogram and spectrum cells as described in these topics:

• Setting the Display Options for the Chromatogram Cell

• Setting the Display Options for the Spectrum Cell

Setting the Display Options for the Chromatogram Cell

 To set the display options for the chromatogram cell

1. Pin the chromatogram cell.

2. Right-click the pinned chromatogram cell.

3. From the shortcut menu, choose Display Options. 

The Display Options dialog box appears.

4. Specify the Normalization parameters:

a. Click the Normalization tab. 

The Normalization page appears (see Figure 147).

Figure 147. Normalization page in the Display Options dialog box
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b. In the Normalize Method area, select the Auto Range option.

Selecting Auto Range ensures that the entire dynamic range of the chromatogram is 
displayed in the active view, normalized over the full range of the y axis.

c. In the Normalize Each Plot To area, select the Largest Peak in Selected Time Range 
option. 

5. Specify the Axis parameters as follows:

a. Click the Axis tab. 

The Axis page appears (see Figure 148).

b. In the Units area, select the Absolute option.

Selecting Absolute sets the y axis to the absolute units of μAU.

Figure 148. Axis page in the Display Options dialog box

6. Specify the labels for the peaks in the chromatogram as follows:

a. Click the Labels tab. 

The Labels page appears (see Figure 149).
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Figure 149. Labels page in the Display Options dialog box

b. Select the check boxes associated with the labels that you want to display, such as 
retention time, area, height, and name.

7. Click OK to accept the settings and close the Display Options dialog box.

Setting the Display Options for the Spectrum Cell

 To set the display options for the spectrum cell

1. Pin the spectrum cell.

2. Right-click the pinned spectrum cell.

3. From the shortcut menu, choose Display Options. 

The Display Options dialog box appears.

4. Specify the Normalization parameters as follows:

a. Click the Normalization tab. 

The Normalization page appears (see Figure 150).
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Figure 150. Normalization page in the Display Options dialog box

b. In the Normalize Method area, select the Auto Range option. 

Selecting Auto Range ensures that the entire dynamic range of the spectrum is 
displayed in the active view, normalized over the full range of the y axis.

c. In the Normalize Spectrum To area, select the Largest Peak in Range option. 

5. Specify the Axis parameters as follows:

a. Click the Axis tab. 

The Axis page appears (see Figure 151).

b. In the Units area, select the Absolute option.

Selecting Absolute sets the y axis to the absolute units of μAU.

6. Click OK to close the Display Options dialog box.
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Figure 151. Axis page in the Display Options dialog box

Inserting Cells

Occasionally, you might want to add more cells to the Qual Browser window. For example, 
you might want to add a cell containing a map plot (contour or 3D) to the view screen, or you 
might want to display several discrete or scan wavelengths in separate cells.

 To add a cell containing a map plot to the window

1. Click a cell to make it the active cell.

2. Choose Grid > Insert Cells > Left, Right, Above, or Below.

The location of the new cell is relative to the active cell. Initially, the new cell contains the 
same information as the existing cell (see Figure 152).
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Figure 152. Qual Browser window with three cells

3. Change the lower cell so that it displays the Map view (see Figure 153) as follows:

a. Pin the cell by clicking its pin button.

b. Click the View Map button in the toolbar.

Chromatogram cell

Spectrum cell

Spectrum cell
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Figure 153. Qual Browser window with a chromatogram cell, spectrum cell, and map cell

4. Select the appropriate range options for the map cell as follows:

a. Right-click the map cell.

b. From the shortcut menu, choose Ranges. 

The Map Ranges dialog box appears (see Figure 154). 

Figure 154. Map Ranges dialog box

c. In the Wavelength box, type the wavelength range that you want to display.

d. In the Time box, type the time range that you want to display.
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5. Select the appropriate display options for the map cell as follows:

a. Right-click the map cell.

b. From the shortcut menu, choose Display Options. 

The Display Options dialog box appears.

c. Click the Axis tab. 

The Axis page appears (see Figure 151 on page 244).

d. In the Units area, select the Absolute option.

e. Click the Normalization tab. 

The Normalization page appears.

f. In the Normalize Method area, select the Auto Range option.

g. Click the Style tab. 

The Style page appears (see Figure 155).

Figure 155. Style page in the Display Options dialog box for the map cell

h. Select the appropriate style.

i. Click OK to save your settings and close the Display Options dialog box.
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Saving the New Layout

Now that you have created a layout for displaying your PDA data, save the layout so that you 
can apply it to other data files containing PDA data.

 To save the layout

1. From the Qual Browser window, choose File > Layout > Save As. 

The Save Layout File dialog box appears (see Figure 156).

Figure 156. Save Layout File dialog box

2. Type a file name in the File name box.

3. Click Save.
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Viewing the Spectrum for a Specific Time Point 
 To view a spectrum for a specific time point

1. Open a raw data file with PDA data and apply an appropriate layout file (see “Opening a 
Raw Data File in Qual Browser” on page 219).

2. Pin the spectrum cell.

3. Click a time point in the chromatogram cell.

The spectrum for the selected time point appears in the spectrum cell (see Figure 157).

Figure 157. Qual Browser window with a chromatogram of the PDA test mixture and a 
spectrum for the 7.42 minute time point
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Viewing the Chromatogram for a Specific Wavelength
 To view the scan chromatogram for a specific wavelength

1. Open a raw data file with PDA data and apply an appropriate layout file (see “Opening a 
Raw Data File in Qual Browser” on page 219).

2. Pin the chromatogram cell.

3. Click a wavelength in the spectrum cell.

The scan chromatogram for the selected wavelength appears in the chromatogram cell as 
shown in Figure 158.

Figure 158. Qual Browser window, displaying a chromatogram cell and a spectrum cell

334 nm
scan wavelength
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Determining Peak Areas
In a chromatogram, the area of an isolated peak is directly proportional to the concentration 
of the analyte.

 To make a peak area determination using the Qual Browser application

1. Open the Qual Browser application.

2. Open the data file (.raw) of interest (see “Opening a Raw Data File in Qual Browser” on 
page 219).

3. Ensure that the chromatogram cell is the active cell, as indicated by a gray border.

4. Select the chromatogram that you want to integrate as follows:

a. Right-click the chromatogram and from the shortcut menu choose Ranges. 

The Chromatogram ranges dialog box appears.

b. In the Detector list, select the detector type:

• To integrate a scan wavelength, select PDA.

• To integrate a discrete wavelength channel, select UV.

c. Ensure that Avalon is selected as the Peak Algorithm.

d. Select the appropriate wavelength:

• To display the chromatogram for a scan wavelength, select Wavelength Range 
from the Plot Type list, and then type a value for a wavelength within your scan 
range in the Range box.

• To display the chromatogram for a discrete wavelength channel, select 
Channel A, B, or C from the Plot Type list.

5. Turn on peak detection by right-clicking the chromatogram cell and choosing 
Peak Detection > Toggle Detection in This Plot from the shortcut menu. 

6. To display numerical values for areas of the chromatographic peaks, do the following:

a. Right-click the chromatogram cell and choose Display Options. 

The Display Options dialog box appears.

b. Click the Labels tab. 

The Labels page appears (see Figure 159).
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Figure 159. Labels page in the Display Options dialog box

c. Select the Area check box.

d. Click OK to return to the chromatogram cell.

7. To set the integration parameters, do the following:

a. Right-click the chromatogram and choose Peak Detection > Settings from the 
shortcut menu. 

The Avalon Peak Detection Settings page appears on the left side of the window 
(see Figure 160).

Note  The Avalon Peak Detection Settings page appears only when Avalon is 
selected as the peak algorithm in the Chromatogram Ranges dialog box.
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Figure 160. Avalon Peak Detection Settings page

b. Click Auto Calc Initial Events to force the Avalon peak integration algorithm to 
determine the “best” values for the following initial events: Start Threshold, 
End Threshold, Peak Threshold, P-P Threshold, Bunch Factor, Negative Peaks, and 
Tension.

Figure 161 shows a chromatogram for the 239 nm scan wavelength that is integrated 
with the “best” initial integration values as determined by the Avalon peak integration 
algorithm. The peaks areas are shown above the apexes of the integrated peaks.
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Figure 161. Avalon Peak Detection Settings page displaying a chromatogram acquired 
with the PDA detector

Calculating the Purity of the Chromatographic Peaks
The data system can calculate the spectral purity of your chromatographic peaks by 
comparing the similarity of the spectra across the peak to a spectrum from the peak apex. The 
calculation is affected by the integration of the scan chromatogram and by the scan threshold, 
peak coverage, and scan wavelengths that you set in the Peak Purity Settings dialog box.

 To display the purity values for the integrated peaks

1. Select a chromatogram for a scan wavelength (see “Displaying Scan Wavelength 
Chromatograms” on page 233).

2. Set the integration parameters for the chromatogram (see “Determining Peak Areas” on 
page 251). 

3. Right-click the chromatogram cell and choose Peak Purity from the shortcut menu. 

The Peak Purity Settings dialog box appears (see Figure 162).
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Figure 162. Peak Purity Settings dialog box

4. Select the Enable check box.

5. In the Scan Threshold (μAU) box, type an appropriate scan threshold.

The scan threshold limits the portion of the peak included in the analysis to spectral slices 
that have a lambda max above the scan threshold. You can set this limit to eliminate noise 
from the analysis. The limits for this box are 0 to 2 000 000 μAU. 

6. In the Peak Coverage % box, type an appropriate value for your application. The limits 
for this parameter are 1 to 100% coverage. 

At a setting of 100%, the data system compares all the spectral slices that fall within the 
beginning and ending tick marks of the integrated peak. To limit the peak purity 
calculation to a specific range of wavelengths in the scan, select the Limit Scan 
Wavelength check box, and then enter a wavelength range in the Wavelength Range box.

7. Click OK to close the Peak Purity Settings dialog box, and then view the effect of your 
peak purity settings.

The following figures show the effect of various settings on peak purity:

• Figure 163 shows the effect of the scan wavelength on peak purity.

• A comparison of Figure 164 and Figure 165 on page 257 demonstrates the effect of 
integration on peak purity.

• Figure 166 on page 258 shows the effect of the scan threshold setting on peak purity.

• Figure 167 on page 258 shows the effect of the peak coverage setting on peak purity.
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Figure 163. Comparison of peak purity results for two different scan wavelengths

225 nm scan wavelength
3 uAU scan threshold
95% peak coverage

239 nm scan wavelength
3 uAU scan threshold
95% peak coverage
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Figure 164. Chromatogram for the 225 nm scan wavelength with default integration parameters

Figure 165. Chromatogram for the 225 nm scan wavelength with Auto calc integration parameters

Impurity

Benzene

3 uAU scan threshold
95% peak coverage
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Figure 166. Effect of scan threshold on peak purity calculation

Figure 167. Effect of peak coverage on peak purity calculations

500000 uAU scan threshold
95% peak coverage

3 uAU scan threshold
95% peak coverage

3 uAU scan threshold
50% peak coverage

3 uAU scan threshold
5% peak coverage

Peak start Peak stop

Peak start Peak stop
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LC Pump Calibration and Record Keeping

This chapter describes the calibration and record keeping procedures for the Surveyor LC 
Pump Plus.

The Surveyor LC Pump Plus is factory calibrated to produce an accurate flow rate while 
pumping water at 1 mL/min. Its ability to accurately proportion binary mobile phases is also 
tested at a flow rate of 1 mL/min.

The Surveyor LC Pump Plus does not require calibration upon arrival at its shipping 
destination. However, over time, the pressure readings from its built-in pressure transducer 
can drift and require re-zeroing. If you are running the LC pump at high backpressures, you 
might notice an increase in its pressure pulsation. You can reduce this pressure pulsation by 
adjusting the compressibility setting of the LC pump.

Contents

• Calibrating the Surveyor LC Pump Plus

• Recording Maintenance Information for the Surveyor LC Pump Plus

• Firmware Version Information for the Surveyor LC Pump Plus
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Calibrating the Surveyor LC Pump Plus
Two calibration options for the Surveyor LC Pump Plus affect its performance: the alpha 
setting, which affects the flow rate; and the compressibility setting, which affects the pressure 
pulsation of the system. The alpha setting is factory calibrated to produce an accurate flow 
rate for water. The compressibility setting is set to 0.45 GPa–1, which is the compressibility 
value for water.

If you are pumping solvents other than water and your application is sensitive to pressure 
pulsation, you might want to optimize the compressibility setting. After you optimize the 
compressibility setting, check the flow rate accuracy. If adjusting the compressibility setting 
has affected the flow rate accuracy, adjust the alpha setting.

In addition to the alpha setting and the compressibility setting, the pressure transducer that is 
attached to the back of the purge manifold assembly is also factory calibrated. If you replace 
the pressure transducer, you must update the pressure sensor adjustment setting. Even if you 
never replace the pressure sensor, you must occasionally re-zero its output, as the readout 
tends to drift under normal usage.

These topics provide information on calibrating the LC pump:

• Accessing the Calibration Options for the Surveyor LC Pump Plus

• Calibration Options for the Surveyor LC Pump Plus

• Calibration Procedures for the Surveyor LC Pump Plus

Accessing the Calibration Options for the Surveyor LC Pump Plus

You can fine-tune the performance of the Surveyor LC Pump from the Calibration – Surveyor 
LC Pump Direct Control dialog box. 

 To open the Calibration – Surveyor LC Pump Direct Control dialog box

1. Turn on the power to the Surveyor LC Pump.

2. Open the Surveyor LC Pump view in the Instrument Setup window.

3. Choose Surveyor LC Pump > Direct Control > Calibration. 

The Calibration – Surveyor LC Pump Direct Control dialog box appears (see 
Figure 168).
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Figure 168. Calibration page for the Surveyor LC Pump

Calibration - Surveyor LC Pump Direct Control Parameters

Table 56 describes the calibration parameters for the Surveyor LC Pump Plus.

Default value

Table 56. Calibration parameters for the Surveyor LC Pump Plus  (Sheet 1 of 2)

Parameter Description

Settings

Compressibility Specifies the compressibility of the mobile phase (see “Compressibility” on page 262).

For information on determining the appropriate value for your solvent conditions, see 
“Updating and Optimizing the Compressibility Setting” on page 266.

Pressure Recorder Full 
Scale

Specifies the full-scale range of the recorder connected to the pressure terminals on the back 
panel of the pump (see “Pressure Recorder Full Scale” on page 264).

Range: 1 to 10, in integer steps

For information on setting the full-scale range for the pressure recorder, see “Scaling the 
Output of the Pressure Recorder Terminals” on page 268

Flow Rate Adjustment 
(Alpha)

Makes fine adjustments to the flow rate (see “Flow Rate Adjustment (Alpha)” on page 265).

For information on calibrating the alpha value, see “Updating the Flow Rate Adjustment 
Setting” on page 268.
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Calibration Options for the Surveyor LC Pump Plus

The Xcalibur data system provides the following calibration options (see Figure 168) for the 
Surveyor LC Pump Plus:

• Compressibility

• Pressure Recorder Full Scale

• Flow Rate Adjustment (Alpha)

• Pressure Sensor Adjustment

• Pressure Transducer Zero

Compressibility 

The compressibility of a liquid is a measure of its resistance to a decrease in volume caused by 
an increase in pressure. Compared to gases, most liquids are relatively incompressible. Water, a 
commonly used mobile phase solvent, is even less compressible than most organic solvents 
because of its extensive hydrogen bonding and cluster structure.

For information on updating the compressibility setting, see “Updating and Optimizing the 
Compressibility Setting” on page 266.

Effect of the Compressibility Setting 

Even though liquids are relatively incompressible, the compressibility of the mobile phase can 
affect your chromatography if you are running the LC pump at the upper limit of its pressure 
range. You can use the compressibility setting for the Surveyor LC Pump to compensate for 
the compressibility of the mobile phase. However, changing the compressibility setting 
simultaneously affects both the pressure pulsation of the Surveyor LC Pump and the flow rate 
of the mobile phase.

Pressure Sensor 
Adjustment

Adjusts the pressure sensor reading (see “Pressure Sensor Adjustment” on page 265).

For information on adjusting the pressure sensor reading, see “Updating the Pressure Sensor 
Adjustment Setting” on page 269.

Set Downloads the new setting to the pump.

Pressure Transducer

Zero Calibrates the current pressure reading as the zero point (see “Pressure Transducer Zero” on 
page 265).

For information on setting the zero point for the pressure transducer, see “Zeroing the 
Pressure Transducer” on page 269.

Table 56. Calibration parameters for the Surveyor LC Pump Plus  (Sheet 2 of 2)

Parameter Description
262 Surveyor Plus User Guide for LC Devices Thermo Scientific



 9 LC Pump Calibration and Record Keeping
Calibrating the Surveyor LC Pump Plus
The compressibility effect is caused by the portion of the cam cycle where the pistons are 
compressing the mobile phase. The compressibility portion of the cam cycle extends from the 
time when the primary piston starts discharging until the time the secondary piston reaches 
full intake—approximately 80° of the cam cycle. To minimize the pressure pulsation and 
maintain a constant flow rate, the on-board CPU compensates for this compression by 
making fine adjustments to the speed of the stepping motor. If the compressibility setting is 
incorrect, the LC pump cannot effectively minimize the pressure pulsation.

Figure 169 shows the overlaid pressure traces for three runs of water pumped at a nominal 
flow rate of 3 mL/min. The compressibility settings for the three runs were 0.45 GPa–1, 
1.25 GPa–1, and 3.0 GPa–1, as labeled. The compressibility of water is 0.45 GPa–1.

Figure 169. Overlaid LC pump pressure traces, showing the effect of the compressibility setting

Table 57 lists the calculated pressure pulsation and the empirically determined flow rates for 
the three different compressibility settings. The pressure pulsation as well as the actual flow 
rate increased as the compressibility setting increased. 

3.0 GPa-1

0.45 GPa-1

1.25 GPa-1
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Compressibility Ratios for Common Solvents

Because most mobile phases are made up of a mixture of solvents, you must determine the 
correct compressibility setting for a given mobile phase empirically. Table 58 lists the 
compressibility ratios for a few common solvents. 

Pressure Recorder Full Scale

The pressure recorder full-scale calibration option sets the scaling factor for the pressure trace 
if you choose to monitor the pressure with a chart recorder. The pressure recorder terminals 
are located on the back of the Surveyor LC Pump Plus (see Figure 170). Integer values from 
1 to 10 are within the allowable range. 

Full scale = Set value × 4.9 MPa (50 kgf/cm2) (full-scale voltage = 1 mV)

For example:

When the set value = 1, the full scale is 4.9 MPa (50 kgf/cm2)

When the set value = 10, the full scale is 49.0 MPa (500 kgf/cm2)

4.9 MPa = 50 kgf/cm2 = 49 bar = 711 psi

Table 57. Measured flow rate and pressure pulsation versus compressibility setting

Compressibility 
setting

% Pressure
pulsation

Actual flow rate
(mL/min) % Rel diff

0.45 GPa–1 ± 0.2% 3.01 + 0.3%

1.25 GPa–1 ± 0.4% 3.05 + 1.8%

3.0 GPa–1 ± 1% 3.18 + 5.9%

Table 58. Measured flow rate and pressure pulsation versus compressibility setting

Solvent Compressibility ratio (GPa-1)

Water 0.45

Acetonitrile 1.20

Methanol 1.25

Hexane 1.60

Note  The value for the scaling factor is stored until you change it or until you turn off the 
power to the Surveyor LC Pump.
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Figure 170. Terminals located on the back of the Surveyor LC Pump Plus 

For information on setting the scaling factor for the pressure recorder, see “Scaling the Output 
of the Pressure Recorder Terminals” on page 268.

Flow Rate Adjustment (Alpha)

The alpha value for your Surveyor LC Pump Plus is factory calibrated based on a flow rate of 
1.000 mL/min for distilled water. A sticker containing the factory calibration value is located 
inside the pump on the motor casing. You can optimize the alpha value for your application 
by updating the alpha setting. The range for alpha values is 1 to 9.9. If you are pumping 
water, decreasing the alpha value by 1 decreases the flow rate by 1 percent. Increasing the 
alpha value by 1, however, increases the flow rate by 1 percent.

For information on setting the alpha value, see “Updating the Flow Rate Adjustment Setting” 
on page 268.

Pressure Sensor Adjustment

Reset the Pressure Sensor Adjustment parameter when you replace the pressure sensor. Each 
pressure sensor is labeled with a data sticker that contains a “0.XXXX” value for the pressure 
sensor adjustment setting. Multiply this value by 10 000 and then update the pressure sensor 
adjustment setting for your Surveyor LC Pump Plus.

For information on updating the pressure sensor adjustment, see “Updating the Pressure 
Sensor Adjustment Setting” on page 269.

Pressure Transducer Zero

The pressure readout for the Surveyor LC Pump Plus is produced by a cell type 
potentiometer. This type of device tends to drift by small increments, requiring you to 
occasionally re-zero the readout. To update the pressure transducer zero value, turn off the 
pump flow and open the drain valve knob. Then click the pressure transducer zero button in 
the data system that operates your pump.

For information on zeroing the pressure transducer, see “Zeroing the Pressure Transducer” on 
page 269.
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Calibration Procedures for the Surveyor LC Pump Plus

You fine-tune the performance of the Surveyor LC Pump Plus from the 
Calibration - Surveyor LC Pump Direct Control page (Figure 168 on page 261).

For instructions on opening the Calibration page, see “Accessing the Calibration Options for 
the Surveyor LC Pump Plus” on page 260.

To fine-tune the performance of the Surveyor LC Pump Plus, follow these procedures:

• Updating and Optimizing the Compressibility Setting

• Scaling the Output of the Pressure Recorder Terminals

• Updating the Flow Rate Adjustment Setting

• Updating the Pressure Sensor Adjustment Setting

• Zeroing the Pressure Transducer

Updating and Optimizing the Compressibility Setting

If you have already determined the best compressibility setting for your application, update 
the compressibility setting of the Surveyor LC Pump Plus.

For information on compressibility, see “Compressibility” on page 262.

 To update the compressibility setting

1. Open the Calibration page for the Surveyor LC Pump (see “Accessing the Calibration 
Options for the Surveyor LC Pump Plus” on page 260). 

2. Type a new value into the Compressibility setting box. Then click Set.

 To optimize the compressibility setting for your application

1. Set up your system:

a. Set up a device to record the pressure output from the back panel pressure terminals. 
See “Pressure Recorder Full Scale” on page 264.

b. Scale the output of the pressure terminals as described in “Scaling the Output of the 
Pressure Recorder Terminals” on page 268.

2. Download the mobile phase parameters specified in your application: 

a. If it is not already on, turn on the power to the Surveyor LC Pump Plus.

b. From the Surveyor LC Pump view, choose Surveyor LC Pump > Direct Control > 
Operation.

The Operation - Surveyor LC Pump Direct Control dialog box appears 
(see Figure 171).
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Figure 171. Operation - Surveyor LC Pump Direct Control dialog box

c. In the Method area, enter the specified flow rate in the Flow Rate box and enter the 
specified mobile phase composition in the Component A through Component D 
boxes.

d. Click Download to send these parameters to the onboard CPU of the Surveyor LC 
Pump Plus.

e. Click Pump On to turn on the pump flow.

3. Record the pressure trace.

4. If the pressure pulsation is too high for your application, change the compressibility 
setting. Then, repeat steps 2 and 3. Continue to change the compressibility setting until 
the level of pump pulsation is adequate for your application.

5. After you change the compressibility setting to minimize the pressure pulsation, check the 
flow rate. If necessary, adjust the flow rate adjustment setting as described in “Updating 
the Flow Rate Adjustment Setting” on page 268.

Note  Changing the compressibility setting affects the flow rate.
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Scaling the Output of the Pressure Recorder Terminals 

For information on using the pressure terminals on the pump’s back panel, see “Pressure 
Recorder Full Scale” on page 264.

 To set the full-scale output of the pressure recorder terminals

1. Open the Calibration page for the Surveyor LC Pump (see “Accessing the Calibration 
Options for the Surveyor LC Pump Plus” on page 260). 

2. Enter a value from 1 to 10 in the Pressure Recorder Full Scale box (see Figure 168 on 
page 261). Then click Set. For information on scaling the output of the pressure recorder 
terminals, see “Pressure Recorder Full Scale” on page 264.

Updating the Flow Rate Adjustment Setting 

If you change the compressibility setting for the Surveyor LC Pump, you might also need to 
change its flow rate adjustment setting. Changing the flow rate adjustment setting can 
compensate for minor deviations in the flow rate of approximately ±5 percent from the 
expected value. 

 To update the flow rate adjustment setting

1. Open the Calibration page for the Surveyor LC Pump (see “Accessing the Calibration 
Options for the Surveyor LC Pump Plus” on page 260).

2. In the Flow Rate Adjustment (alpha) box (see Figure 168 on page 261), type a new value:

• If the actual flow rate is below the set value, increase the alpha value. If you are 
pumping water, increasing the alpha value by 1increases the flow rate by 1%.

For example, if the pump is set to deliver a flow rate of 1 mL/min and the actual flow 
rate is 0.96 mL/min, which is 4 percent below the set rate, raise the current setting 
by 4. If the current setting is 5.0, enter a new setting of 9.0.

• If the actual flow rate is above the set value, decrease the alpha value. If you are 
pumping water, decreasing the alpha value by 1 decreases the flow rate by 1%.

For example, if the pump is set to deliver a flow rate of 1 mL/min and the actual flow 
rate is 1.04 mL/min, which is 4 percent above the set rate, lower the current setting 
by 4. If the current setting is 5.0, enter a new setting of 1.0.

3. Click Set.
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Updating the Pressure Sensor Adjustment Setting

Reset this parameter when you replace the pressure sensor. Each pressure sensor is labeled with 
a data sticker that contains a “0.XXXX” value for the pressure sensor adjustment setting. 
Multiply this value by 10 000 and enter the result in the Pressure Sensor Adjustment 
setting box. 

 To update the pressure sensor adjustment setting

1. Open the Calibration page for the Surveyor LC Pump (see “Accessing the Calibration 
Options for the Surveyor LC Pump Plus” on page 260). 

2. In the Pressure Sensor Adjustment box (see Figure 168 on page 261), type the value on 
the data sticker “0.XXXX” multiplied by 10 000.

3. Click Set.

Zeroing the Pressure Transducer

The offset error of the pressure transducer is the value that is displayed when it should be zero, 
such as when the purge manifold knob is set to the open position. You can correct for this 
offset error by re-zeroing the pressure readout of the pressure transducer when the purge 
manifold knob is open.

 To re-zero the output of the pressure transducer

1. Stop the flow of solvent from the LC pump:

a. From the Instrument Setup window, choose Surveyor LC Pump > Direct Control > 
Operation.

b. Click Pump Off.

2. Open the drain valve to ensure that the transducer is actually sensing zero system pressure 
(see Figure 172). When the drain valve is in the open position, look for the word DRAIN 
to appear upside down on the knob. 

Figure 172. Drain valve in closed and open positions

DRAIN

CLOSE OPEN

DRAIN

CLOSEOPEN

Closed position Open position
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3. Open the Calibration page of the Direct Control dialog box by choosing 
Surveyor LC Pump > Direct Control > Calibration.

4. Click Zero in the Pressure Transducer area (see Figure 168 on page 261).

5. When you are finished zeroing the pressure transducer, close the drain valve by gently 
turning the knob clockwise until you feel resistance.

Recording Maintenance Information for the Surveyor LC Pump Plus
Use the Direct - Control Maintenance dialog box to update the maintenance information for 
the Surveyor LC Pump Plus and to set the pistons to the maintenance position.

Each pump head assembly contains a piston seal. The two seals can wear at different rates, 
causing leaks to occur in one or both pump heads. Before dismantling the pump head 
assemblies, attempt to determine the source of the leakage. To save time and materials, replace 
only the piston seal in the pump head assembly that is leaking. Or, as a preventive measure, 
replace the piston seals after pumping 120 L of mobile phase.

 To open the Direct Control - Maintenance dialog box

From the menu bar of the Surveyor LC Pump Plus view, choose Surveyor LC Pump > 
Direct Control > Maintenance.

The Maintenance - Surveyor LC Pump Direct Control page appears (see Figure 173).

Figure 173. Direct Control - Maintenance dialog box

Note  Applying excessive force to the drain valve knob reduces the life span of its 
O-ring.
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 To reset the solvent volumes or the pump operating time

Perform the following tasks as specified:

• Every time you install a new piston seal, click the appropriate Reset button.

Clicking Reset sets the readback for the volume of liquid pumped by the respective 
pump head assembly to zero.

• If you install a new motor, click the Reset button under Pump Operating Time.

Clicking Reset sets the recorded hours for the pump operating time to zero.

 To set the pistons to the maintenance position before removing the pump heads

Click Maintenance Position.

Maintenance -Surveyor LC Pump Direct Control Parameters

Table 59 describes the parameters in the Maintenance dialog box for the 
Surveyor LC Pump Plus.

Table 59. Maintenance dialog box for the Surveyor LC Pump Plus 

Parameter Description

Left Seal Volume

Reset Zeros the recorded volume of mobile phase pumped by the left pump head. 

Every time you install a new piston seal in the left pump head, click Reset in the Left Seal 
Volume area to set the recorded volume of liquid pumped by the left pump head assembly 
back to zero. 

Right Seal Volume

Reset Zeros the recorded volume of mobile phase pumped by the right pump head. 

Every time you install a new piston seal in the right pump head, click Reset in the Right 
Seal Volume area to set the recorded volume of liquid pumped by the right pump head 
assembly back to zero. 

Pump Operating Time

Reset Resets the recorded operating time for the Surveyor LC Pump Plus to zero. 

If you install a new motor, click Reset in the Pump Operating Time area to set the recorded 
Pump Operating Time back to zero. 

Position Pistons 

Maintenance Position Sets the pistons to the maintenance position.

Set the pump pistons to the maintenance position before removing the pump heads.

To set the pistons to the maintenance position, click Maintenance Position.
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Firmware Version Information for the Surveyor LC Pump Plus
Use the Configuration - Surveyor LC Pump Direct Control dialog box (see Figure 174) to 
view the firmware versions of the pump’s Main board and Pump Converter board.

Figure 174. Configuration - Surveyor LC Pump Direct Control dialog box

 To view the firmware version of your Surveyor LC Pump Plus

1. Open the pump view.

2. From the menu bar, choose Surveyor LC Pump > Direct Control > Configuration.

The Configuration - Surveyor LC Pump Direct Control page appears.

Configuration Page Parameters

Table 60 describes the parameters on the Firmware page.

Table 60. Configuration - Surveyor LC Pump Direct Control page parameters

Parameter Description 

Firmware Versions

Pump Main Board Displays the firmware version of the Pump Main printed circuit 
board. 

Pump Converter 
Board

Displays the firmware version of the Pump Converter printed 
circuit board.
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Autosampler Calibration and Record Keeping

This chapter describes the calibration and record keeping procedures for the autosampler.

The autosampler does not require calibration upon arrival at its shipping destination. 
However, if you use custom vials or custom microplates, you must perform the Well Bottom 
Distance calibration, which determines the actual depth of a vial or microplate well (see “Well 
Bottom Distance Calibration” on page 305). If problems occur with the column oven control, 
the tray temperature control, or the arm positioning, contact a Thermo Fisher Scientific 
service representative. This appendix includes calibration procedures for these items; however, 
to calibrate the autosampler’s temperature zones and XYZ arm position, you must have the kit 
that contains the necessary test fixtures.

Contents

• Calibrating the Autosampler

• Autosampler Maintenance Information

• Autosampler Validation Information
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Calibrating the Autosampler
There are four calibration options for the autosampler: 

• Column Oven Air Sensor Calibration

• Vial Tray Metal Sensor Calibration

• Arm Calibration

• Well Bottom Distance Calibration

The column oven and oven compartment temperature calibrations and the arm calibration 
are typically performed by a Thermo Fisher Scientific field service representative. To perform 
these calibrations yourself, you must have the service kit that contains the temperature test 
fixtures. In addition, to calibrate the temperature sensors for the autosampler’s 
temperature-controlled zones, your Thermo Scientific application must be capable of 
providing feedback for these sensors.

If you choose to use custom vials or custom microwell plates, you must perform the 
Well Bottom Distance calibration, which determines the depth of the custom vial or 
microplate well. Perform this calibration you select a new custom tray configuration and each 
time you use a new type of custom vial or custom microwell plate.

 To open the Calibration dialog box for the autosampler 

1. Open the view for your autosampler.

2. In the menu bar, choose Surveyor AS > Calibration.

The Calibration dialog box appears (see Figure 175).

Note  Typically, a Thermo Fisher Scientific field service representative calibrates the 
controlled temperature zones and the XYZ arm position. To perform the temperature 
calibrations yourself, order the Field Service Calibration Kit (P/N 60053-62001). To 
calibrate the XYZ arm, order the LED light fixture and the non-reflective target port 
fixture.

Note  If you are controlling the autosampler from a Thermo Scientific data system other 
than the Xcalibur data system, refer to the Help provided with your data system for 
information about accessing the Calibration dialog box for the autosampler.
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Figure 175. Calibration dialog box for the autosampler

Column Oven Air Sensor Calibration

To calibrate the column oven temperature, you must have the oven sensor test fixture 
provided in the Field Service Calibration Kit (P/N 60053-62001) for the autosampler.

To calibrate the column oven temperature, follow these procedures in order:

1. Preparing to Calibrate the Column Oven Temperature 

2. Specifying the Internal Set Target for the Column Oven Calibration Temperature

3. Adjusting the Temperature Calibration for the Column Oven

Preparing to Calibrate the Column Oven Temperature

 To set up the system for a temperature calibration

1. Open the status view for the autosampler’s oven temperature.

To open the Oven page from the Xcalibur data system, do the following:

a. If the Information view is closed, click the Information View button ( ) to 
open the view. 

The Information view opens with the Status page displayed.

CAUTION  Because the column oven compartment can reach temperatures as high as 
95 °C (203 °F), ensure that the column oven is off and that the column oven 
compartment is at room temperature before you install the oven sensor test fixture.
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b. Verify that the status reads Ready to Download. 

For information about checking the status, see “Checking the Status of the LC 
Devices” on page 136.

c. Click Surveyor AS in the directory tree.

The status pages for the autosampler appear at the bottom of the Status page.

d. Click the Oven tab.

The Oven status page appears.

2. On the Oven page, check the column oven status. 

3. If the column oven is on and set to a high temperature, turn the column oven off, open 
the column oven door, and wait for the column oven to cool to room temperature.

For information about using the direct controls to turn the column oven on or off, see 
“Controlling the Tray and Oven Compartment Temperatures” on page 199.

4. Install the oven sensor test fixture (869C thermometer or equivalent) as follows:

a. If it is not already open, open the column oven door.

b. Loosen the top thumbscrew that holds the column clamp.

c. With the sensor facing down, slide the metal cable protector under the right side of 
the clamp.

d. Verify that the sensor is between the upper and lower column clamps and that it is 
not touching any metal.

e. Tighten the thumbscrew on the sensor, route the cable of the sensor so as not to 
interfere with the door, and then close the column oven door.

5. Open the Calibration dialog box for the autosampler. For information about accessing 
the Calibration dialog box from the Xcalibur data system, see “Calibrating the 
Autosampler” on page 274.

Specifying the Internal Set Target for the Column Oven Calibration Temperature

Use the Internal Set Target page of the Column Oven Air Sensor Calibration wizard to specify 
the calibration temperature.

 To specify the internal set target for the calibration temperature

1. Set up the system to perform the column oven calibration (see “Preparing to Calibrate the 
Column Oven Temperature” on page 275).

2. Select the Column Oven Air Sensor Calibration option, and then click Next.

The Diagnostic - Internal Set Target page of the Column Oven Air Sensor Calibration 
wizard appears (see Figure 176). The default calibration temperature is 50.0 °C.
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Figure 176. Diagnostic - Internal Set Target page of the Column Oven Air Sensor Calibration 
wizard with the default temperature setting of 50.0 °C

3. In the Calibration Target Temperature (C) box, type 30 (see Figure 177).

Figure 177. Diagnostic - Internal Set Target page of the Column Oven Air Sensor Calibration 
wizard with the user setting of 30 °C

4. Click Start Calibration.

The data system turns on the column oven and downloads the target temperature. 
The Next button becomes available. 

5. Click Next.

The default temperature for the calibration of 
the column oven temperature is 50.0 °C.

User setting. The range is 5 to 95 °C.
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The Diagnostic - External Standard page of the Column Oven Air Sensor Calibration 
wizard appears (see Figure 178). The default calibration temperature for the external 
standard is 50 °C.

Figure 178. Oven page and the Diagnostic - External Standard page of the Column Oven Air 
Sensor Calibration wizard

Adjusting the Temperature Calibration for the Column Oven 

 To adjust the temperature calibration for the column oven

1. Specify the calibration temperature and start the Column Oven Air Sensor Calibration 
wizard (see “Specifying the Internal Set Target for the Column Oven Calibration 
Temperature” on page 276).

2. Wait for the current temperature readback on the Oven page to reach 30.0 °C 
(see Figure 179).

The Current temperature readback displays the temperature recorded by the 
autosampler’s internal temperature sensor.

The oven control is on and the 
set temperature is 30 °C.

The default temperature for 
the calibration of the column 
oven temperature is 50.0 °C.
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Figure 179. Oven page, showing that the current temperature has reached the set temperature

3. When the current temperature readback on the Oven page (autosampler view on the 
Status page of the Information view) reaches exactly 30.0 °C (see Figure 179), do the 
following:

a. Type the reading from the 869C thermometer in the External Standard 
Temperature (C) box (see Figure 180).

For example, if the thermometer reading is 29.8 °C, type 29.8 in the External 
Standard Temperature (C) box. The range is 0 to 110.0 °C.

Figure 180. Diagnostic - External Standard page of the Column Oven Air Sensor 
Calibration wizard

b. Verify that the current temperature on the Oven page is still displaying 30.0 °C. 

c. On the Diagnostic - External Set Target page (see Figure 180), click Adjust. 

Note  The external standard is the thermometer.

The current temperature is 30 °C.

Type the temperature reading 
from the thermometer that you 
temporarily installed in the 
column oven compartment.
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The data system downloads the temperature calibration to the autosampler and the 
Finish button becomes available (see Figure 181).

Figure 181. Diagnostic - External Standard page of the Column Oven Air Sensor 
Calibration wizard

d. Repeat step 3a through step 3c until the readings from the 869C thermometer and 
the current temperature readout agree within ±0.2 °C.

4. When the temperatures on the 869C thermometer and the Current Temperature 
readback are within ±0.2 °C of each other, click Finish (see Figure 181).

5. On the Oven page, verify that the Current Temperature readback is stable at 30.0 °C with 
a maximum temperature drift of ±0.2 °C.

6. After you verify the stability of the column oven temperature, turn off the column oven 
using the autosampler direct controls and remove the temperature probe.

For information about the autosampler direct controls, see “Controlling the Tray and 
Oven Compartment Temperatures” on page 199.

Finish button
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Vial Tray Metal Sensor Calibration

Use the Vial Tray Metal Temperature Sensor Calibration wizard and an external temperature 
sensor to calibrate the vial tray temperature control. 

To perform the vial tray metal sensor calibration procedure, you must have the following 
items provided in the Field Service Calibration Kit (P/N 60053-62001):

• Calibrated Omega 869C RTD thermometer or equivalent

• A/S vial tray sensor

To calibrate the column oven temperature, follow these procedures in order:

1. Preparing to Calibrate the Tray Compartment Temperature 

2. Specifying the Internal Set Target for the Tray Compartment Temperature

3. Adjusting the Tray Temperature Calibration

Preparing to Calibrate the Tray Compartment Temperature

 To set up the system to calibrate the temperature of the tray compartment

1. Install the tray temperature sensor as follows:

a. Open the door to the tray compartment.

b. Install the tray temperature sensor into location E of the tray compartment.

The tray temperature sensor is a standard tray with a temperature sensor cemented 
into a middle vial location of the tray. 

c. Route the cable of the sensor through the notch at the top on the tray compartment 
so that it does not interfere with the door closure.

d. Close the door to the tray compartment.

2. Open the status page for the tray temperature.

To open the Tray page from the Xcalibur data system, do the following:

a. If the Information view is closed, click the Information View button ( ) to 
open the view.

The Information view opens with the Status page displayed.

b. Verify that the status reads Ready to Download. For more information, see 
“Checking the Status of the LC Devices” on page 136.

c. Click the listing for the autosampler in the directory tree. 

The status pages for the autosampler appear at the bottom of the Status window.
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3. Click the Tray tab.

The Tray page appears (see Figure 182).

Figure 182. Tray page

4. Open the Calibration dialog box for the autosampler (see “Calibrating the Autosampler” 
on page 274).

5. Select the Vial Tray Metal Sensor Calibration option (see Figure 183).

Figure 183. Calibration dialog box

6. Click Next.

The Diagnostic - Internal Set Target page of the Vial Tray Metal Sensor Calibration 
wizard appears (see Figure 184). 

The default external standard temperature is 40.0 °C.
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Specifying the Internal Set Target for the Tray Compartment Temperature

Use the Diagnostic – Internal Set Target page (see Figure 184) of the Vial Tray Metal Sensor 
Calibration wizard to specify the calibration temperature.

Figure 184. Diagnostic - Internal Set Target page of the Vial Tray Metal Sensor Calibration wizard

 To specify the target calibration temperature for the tray compartment and start the 
calibration

1. Prepare the system for the temperature calibration (see “Preparing to Calibrate the Tray 
Compartment Temperature” on page 281).

2. In the Calibration Target Temperature box, type 30.0, and then click Start Calibration 
(see Figure 185).

Default temperature
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Figure 185. Diagnostic -Internal Set Target page of the Vial Tray Metal Sensor Calibration 
wizard

The data system turns on the tray temperature control and downloads the set temperature 
of 30.0 °C. The Next button becomes available.

3. Click Next.

The Diagnostic - External Standard page appears (see Figure 186). The default external 
standard temperature is 40.0 °C. The range is 0 to 110.0 °C.

Figure 186. Tray page and the Diagnostic - External Standard page of the Vial Tray Metal 
Sensor Calibration wizard

User setting

Default setting

Tray temperature control is on.

The set temperature is 30.0 °C.
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Adjusting the Tray Temperature Calibration

Use the Diagnostic – External Standard page of the Vial Tray Metal Sensor Calibration 
wizard, the status readout on the Tray page, and the external temperature sensor to adjust the 
temperature calibration of the tray compartment.

 To adjust the calibration temperature of the tray compartment

1. When the current temperature readback on the Tray page reaches exactly 30.0 °C 
(see Figure 187), do the following:

a. In the External Standard Temperature (C) box (see Figure 187) on the External Set 
Target page, type the reading from the thermometer. 

Figure 187. Tray page (status view) and the Diagnostic - External Standard page of the Vial Tray 
Metal Sensor Calibration wizard

b. On the Tray page, verify that the Current Temperature readback still displays 
30.0 °C. 

c. On the Diagnostic - External Standard page (see Figure 187), click Adjust.

The data system downloads the calibration to the autosampler and the Finish button 
becomes available (see Figure 188).

Type the temperature reading 
from the test fixture that you 
temporarily installed in the 
tray compartment.

Current temperature has 
reached the set 
temperature of 30.0 °C.
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Figure 188. Diagnostic - External Standard page of the Vial Tray Metal Sensor Calibration 
wizard with an available Finish button

d. Repeat step 1a through step 1c until the temperatures on the thermometer and the 
current temperature readout (see Figure 187) agree within ± 0.2 °C.

2. When the temperatures on the 869C thermometer and the Current Temperature readout 
are within ±0.2 °C of each other, click Finish at the bottom of the Diagnostic - External 
Set Target page.

3. On the Tray status page, verify that the Current Temperature readout is stable at 30.0 °C 
with a maximum temperature drift of ± 0.2 °C.

4. After you have verified the stability of the oven tray temperature, remove the temperature 
probe.
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Arm Calibration

During an injection, the XYZ arm moves between the specified vial or well location and the 
injection port. When you move the autosampler, you can jar the XYZ arm, causing it to lose 
alignment.

Performing the arm calibration procedure requires you to visually align the XYZ arm over the 
injection port. To make this visual alignment, you must replace the needle with an LED light 
fixture that shines a small beam of red light onto the port and replace the stainless steel 
injection port with a non-reflective target fixture. These test fixtures do not come with the 
autosampler; you must order them from Thermo Fisher Scientific.

After following the instructions in the Arm Calibration wizard to adjust the XYZ arm 
alignment, test the alignment by making a set of injections from one or two 384-well 
microplates. The microplate carrier and the 384-well microwell plates are provided in the 
Autosampler Accessory Kit.

To calibrate the XY position of the XYZ arm, you must have these items:

• LED light fixture (P/N 60357-60021)

• Target port fixture (P/N 60357-20021)

• Microplate carrier

• One or two 384-well microtitre plates

• Masking tape

Figure 189 shows the LED light and the target port fixtures.

Figure 189. Arm calibration fixtures available by special order

Target port fixture

LED holder8-pin connector 
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To calibrate XY position of the XYZ arm and verify the calibration, follow these procedures:

1. Modifying the Autosampler Instrument Configuration

2. Starting the Arm Calibration Wizard

3. Moving the Arm to the Needle Removal Position

4. Installing the LED Light Fixture and the Target Port Fixture

5. Moving the XYZ Arm to the Home Position

6. Aligning the Light Beam with the Target

7. Applying the Arm Calibration Setting

8. Checking the Arm Calibration Offset Values

9. Testing the Alignment of the XYZ Arm

Modifying the Autosampler Instrument Configuration

To calibrate the arm position, turn off the feature that prevents control of the autosampler 
when the tray compartment door is open.

 To modify the instrument configuration for the autosampler

1. Open the Surveyor Autosampler Configuration dialog box.

The dialog box opens with the Tray page displayed (see Figure 190).
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Figure 190. Tray page with the 384-well microplate tray type selected

2. Select the 384-well plate tray type.

3. In the A1 Well Position area, select the Top Left option.

4. Click the Communication tab.

The Communication page appears.

5. Clear the Verify Door Is Closed check box (see Figure 191).
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Figure 191. Communication page with the Verify Door Is Closed check box cleared

When the Verify Door Is Closed check box is selected, the data system prevents you from 
starting an injection sequence or using some of the direct control commands for the 
autosampler when the tray compartment door is open.

6. Click OK at the bottom of the dialog box to accept the settings and close the dialog box.

7. Click Done to close the Thermo Foundation Instrument Configuration window.

Go to the next procedure, “Starting the Arm Calibration Wizard.” 

Starting the Arm Calibration Wizard

Use the Arm Calibration wizard to adjust the home position of the XYZ arm.

For information about the LED light and non-reflective needle port fixtures that you must 
have to perform the Arm Calibration wizard, see “Arm Calibration” on page 287.

 To start the Arm Calibration wizard

1. If you have not already done so, modify the autosampler instrument configuration as 
described in “Modifying the Autosampler Instrument Configuration” on page 288.

2. Open the view for the autosampler.

3. From the Surveyor AS menu, choose Calibration.

The Calibration dialog box appears (see Figure 192).

4. Select the Arm Calibration option.

Clear this check box.
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Figure 192. Calibration dialog box with the Arm Calibration option selected

The Arm Calibration wizard appears (see Figure 193). 

The Current Calibration Values area displays the current calibration values for the x-axis 
and y-axis position of the XYZ arm over the autosampler injection port.

Figure 193. Current Calibration Values page

5. Click Next to proceed to the next page of the wizard.

Go to the next procedure, “Moving the Arm to the Needle Removal Position.” 

Note  The user interface specifies the x- and y-axis offsets in microns, which is another 
term for micrometers.

1000 micrometers = 0.04 inches

The diameter of the hole in the center of the target port fixture is 0.047 inches.
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Moving the Arm to the Needle Removal Position

Use this page of the Arm Calibration wizard to move the arm to the needle removal position 
(see Figure 194).

Figure 194. Move the Arm to Needle Removal Position button page

 To move the XYZ arm to the needle removal position

1. Click Move the Arm to Needle Removal Position.

The XYZ arm moves to the center front of the tray compartment and the needle holder 
moves down 1 inch.

2. Click Next to proceed to the next page of the wizard.

Go to the next procedure, “Installing the LED Light Fixture and the Target Port Fixture.” 

Installing the LED Light Fixture and the Target Port Fixture

This page of the Arm Calibration wizard instructs you to remove the needle and install the 
calibration light source (see Figure 195).

Figure 195. Request to install the LED light fixture page
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The needle assembly is a welded piece of 0.012 in. ID stainless steel tubing with an externally 
threaded fitting, a needle flag, a latch, and a compression spring (see Figure 196). It slides into 
the needle mount on the XYZ arm and is secured with the latch. The needle tubing assembly 
has an internally threaded fitting that connects to the 10-32 externally threaded fitting of the 
needle assembly.

Figure 196. Needle assembly 

 To install the light fixture and the target port fixture

1. Remove the needle assembly from the needle mount as follows:

a. Unscrew the needle tubing assembly from the needle assembly.

b. For the Surveyor Autosampler Plus, remove the syringe drive assembly (refer to the 
instructions in the Surveyor Autosampler Plus Hardware Manual).

c. Pull the latch nut of the needle assembly forward. 

d. Pull the needle up from the needle mount on the XYZ arm.

2. Install the LED light fixture as follows:

a. Connect the 8-pin connector of the light fixture cable to the timed events connector 
on the back panel of the autosampler (see Figure 197). The red wire with the resistor 
connects to the +5V autosampler pin and the black wire connects to the autosampler 
ground pin.

Needle mount on 
the XYZ arm

Latch

Compression 
spring

10-32 fitting

Needle flag
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Figure 197. Cable connection for the light fixture

b. Verify that the LED is brightly lit. 

c. Insert the LED holder into the needle mount (see Figure 198).

Resistor

Light fixture connector

8-pin connector on the back panel of 
the autosampler
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Figure 198. Inserting the LED holder into the needle mount

d. Push the LED holder down until it meets resistance from the needle mount. 

e. Make sure that the light fixture cable is routed so that it does not obstruct the 
movement of the XYZ arm. 

3. Install the target port fixture as follows:

a. Remove the aluminum retention clip (see Figure 199) from the wash station housing, 
pull it forward, and then upward.

Figure 199. Retention clip for the autosampler injection port

LED holder

Needle mount

Retention clip
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b. Pull the injection port out from the wash station (see Figure 200).

Figure 200. Autosampler injection port connected to the transfer tube nut 

4. Insert the target port fixture (see Figure 189 on page 287) into the position previously 
held by the injection port.

5. Click Next to proceed to the next page of the wizard.

Go to the next procedure, “Moving the XYZ Arm to the Home Position.” 

Moving the XYZ Arm to the Home Position

Use this page of the Arm Calibration wizard (see Figure 201) to move the XYZ arm to the 
home position. In the home position, the XYZ arm is aligned over the autosampler injection 
port.

Figure 201. Move the Arm to the Home Position button page

 To move the XYZ arm to the home position

1. Click Move the Arm to the Home Position. 

The XYZ arm moves to the home position. The Next button becomes available.

2. Click Next to proceed to the next page of the Arm Calibration wizard.

Go to the next procedure, “Aligning the Light Beam with the Target.” 

Injection port

Transfer tube nut
296 Surveyor Plus User Guide for LC Devices Thermo Scientific



 10 Autosampler Calibration and Record Keeping
Calibrating the Autosampler
Aligning the Light Beam with the Target 

Use this page of the Arm Calibration wizard (see Figure 202) to adjust the fine position of the 
XYZ arm.

Two lead screws and two stepper motors control the x-axis and y-axis position of the XYZ arm 
(see Figure 203).

The Left and Right buttons move the XYZ arm along the x axis. The Forward and Backward 
buttons move the XYZ arm along the y axis.

Figure 202. Alignment buttons page
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Figure 203. XYZ arm of the Surveyor Autosampler Plus

 To align the light beam over the hole in the target port fixture

1. In the Step list of the Arm Calibration wizard, select 25x (793.75 microns). 

This selection moves the arm 793.75 micrometers (0.03125 inches) each time you click 
Left, Right, Forward, or Backward.

1 micrometer = 3.937 × 10–5 inches

2. Click Left, Right, Forward, and Backward to align the position of the light beam with 
the hole in the center of the target port fixture.

3. In the Step list, select a smaller step size, and continue aligning the position of the 
light beam.

4. After you align the light beam with the hole in the center of the target port fixture, 
click Next to proceed to the next page of the wizard.

Go to the next procedure, “Applying the Arm Calibration Setting.” 

 

x-axis 
stepper motor

x-axis 
lead screw

y-axis 
stepper motor

XYZ arm

y-axis 
lead screw

x axis

y axis
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Applying the Arm Calibration Setting

Use this page of the Arm Calibration wizard (see Figure 204) to download the new arm 
calibration settings.

Figure 204. Set Calibration button page

 To apply the current calibration settings for the arm position

1. Ensure that the light beam is centered over the hole in the target port fixture 
(see Figure 205).

Figure 205. LED light beam centered over the hole in the target port fixture

2. Click Set Calibration.

The Next button becomes available.

3. Click Next to proceed to the final page of the wizard.

Go to the next procedure, “Checking the Arm Calibration Offset Values.” 

LED light beam aligned with the 
hole in the target port fixture
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Checking the Arm Calibration Offset Values

Use this page of the Arm Calibration wizard to check the calibration values and close the 
wizard (see Figure 206).

Figure 206. Final page of the Arm Calibration wizard with the Finish button

 To verify the calibration setting

1. In the Current Calibration Values area, verify the following:

• The X Offset readback displays a value from +900 to –900 μm.

• The Y Offset readback displays a value from 1500 to 2500 μm.

2. Click Finish to accept the settings and close the Arm Calibration wizard.

3. Remove the LED and target port calibration fixtures.

4. Reinstall the injection port as follows:

a. Insert the injection port into the port in front of the wash station. 

b. Align the retention clip with the slot located in front of the wash station. 

c. Using the retention clip to push the injection port down, align the circular cutout in 
the retention clip over the alignment screw. 

d. Insert the end of the retention clip into the wash station slot as far as it will go.

Figure 207 shows the installation of the retention clip.

Tip  1000 microns = 1000 micrometers = 0.04 inches

The diameter of the hole in the center of the target port fixture is 0.047 inches.
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Figure 207. Retention clip installation

5. Reinstall the needle assembly as follows:

a. Remount the syringe drive assembly.

b. Slide the needle into the needle mount on the XYZ arm.

c. Turn the latch to the right.

d. Reconnect the needle tubing assembly to the needle assembly. 

Leave the autosampler view of the Instrument Setup view open and go to the next procedure, 
“Testing the Alignment of the XYZ Arm.” 

Retention clip 
installed

Slot in wash station

Injection port

Alignment screw
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Testing the Alignment of the XYZ Arm

To test the alignment of the XYZ arm, make injections from the four corners of two 384-well 
microplates.

 To test the alignment of the XYZ arm

1. Cover columns 1, 2, 23, and 24 of two 384-well microplates with tape (see Figure 208).

Figure 208. 384-well microplate positions

2. Place the microplates in each end of the microwell carrier, leaving the middle position 
empty. 

3. Load the microwell carrier into the tray compartment of the autosampler as follows: 

a. From the menu bar, choose Surveyor AS > Direct Control. 

The Direct Control dialog box appears (see Figure 209).

1 24

A

P

A1 A24

P24P1
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Figure 209. Direct Control dialog box for the autosampler

b. Select Position Arm to Access Tray, and then click Apply. 

The XYZ arm moves to the back of the tray compartment.

c. Insert the microwell carrier into the tray compartment.

d. Verify that the microwell carrier sits flat and is properly installed. 

4. Send the XYZ arm to the home position as follows:

a. In the Direct Control dialog box, select Go to Home Position.

b. Click Apply.

The XYZ arm moves to the home position, which is above the injection port.

5. Make an injection from each corner of the microplate as follows: 

a. In the Direct Control dialog box, select Inject Sample.

The sample injection parameters appear (see Figure 210).

Figure 210. Direct Control dialog box with the Inject Sample command selected

b. In the Vial box, type C:A1. 
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c. Click Apply and wait for the injection to finish.

The XYZ arm moves to the location of the A:1 well of the (C) microplate at the back 
of the tray compartment, and then lowers the needle through the masking tape and 
into the well.

d. In the Vial box, type C: A24. 

e. Click Apply and wait for the injection to finish.

f. In the Vial box, type C: P1. 

g. Click Apply and wait for the injection to finish. 

h. In the Vial box, type C: P24. 

i. Click Apply and wait for the injection to finish.

6. Remove the microplate and check the location of the injections as follows:

a. In the Direct Control dialog box, select Position Arm to Access Tray. 

The XYZ arm moves to the back of the tray compartment.

b. Remove the tray from the tray compartment, and inspect the holes in the tape. Verify 
that the holes are at or near the center of the microplate wells. Each hole must be at 
least 0.05 cm (0.02 inches) from the edge of the well. 

7. If the results are not satisfactory, repeat the arm calibration, and then repeat the alignment 
test with the second (A) microplate, located at the front of the tray compartment.
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Well Bottom Distance Calibration

The autosampler supports custom vials and well plates in addition to the standard 1.8 mL 
vials, 96-well plates, and 384-well plates. However, to use custom vials or well plates, you 
must first determine how far the autosampler needle must travel to reach the bottom of the 
vials or wells. 

Use the Well Bottom Distance wizard to determine the distance that the needle must travel to 
reach the bottom of a vial or well. The XYZ arm uses this value when you select one of the 
custom tray configurations.

To perform a well bottom distance calibration, follow these procedures in order:

1. Starting the Well Bottom Distance Wizard

2. Selecting the Calibration Method for the Well Bottom Distance

3. Depending on the selected calibration method, follow one of these procedures:

• Manually Entering the Well Bottom Distance

–or–

• Using the Needle Sensor to Determine the Well Bottom Distance

Starting the Well Bottom Distance Wizard

 To start the Well Bottom Distance wizard

1. Open the status view for the autosampler.

For information about opening the status view from the Xcalibur data system, see 
“Checking the Status of the LC Devices” on page 136.

2. Verify that the autosampler status reads Ready to Download.

3. Open the view for the autosampler.

4. From the Surveyor AS menu, choose Calibration. 

The Calibration dialog box appears (see Figure 211).

IMPORTANT      Because the autosampler stores only one value for the custom well bottom 
distance, you must perform a well bottom distance calibration each time you select a new 
custom tray type configuration and each time you use a different type of custom vial or 
custom microwell plate.
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Figure 211. Calibration dialog box with the Well Bottom Distance option selected

5. Select the Well Bottom Distance option, and then click Next.

The Select Calibration Method page appears (see Figure 212).

Figure 212. Select Calibration Method page

Go to the next procedure, “Selecting the Calibration Method for the Well Bottom Distance” 
on page 306.

Selecting the Calibration Method for the Well Bottom Distance

Use the Select Calibration Method page of the Well Bottom Distance wizard to select a 
calibration method. You can manually enter a bottom distance value for your custom vials or 
microplates, or you can use the autosampler’s needle sensor feature to determine the correct 
distance value.
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 To select the calibration method for the well bottom distance

Do one of the following:

• Select the Enter Value Manually option if you want to enter a previously determined 
value for the well bottom distance. Click Next. Then go to the next procedure, 
“Manually Entering the Well Bottom Distance.” 

–or–

• Select the Calibrate to Find Value option to perform an active calibration. Click 
Next. Then go to “Using the Needle Sensor to Determine the Well Bottom Distance” 
on page 308.

Manually Entering the Well Bottom Distance

 To manually enter a new value for the well bottom distance

1. In the Enter New Value (microns) box, type the new value in micrometers 
(see Figure 213).

The range is 15 000 to 46 990 micrometers (15 to 46.9 mm).

Figure 213. Manual calibration page

2. Click Set Calibration.

The new bottom distance value (in microns) appears at the top of the dialog box and the 
Finish button becomes available.

1 micron = 1 micrometer

3. Click Finish to close the Well Bottom Distance dialog box.

Note  The autosampler stores only one well bottom distance value for custom tray 
configurations. The number at the top of this dialog box is the current value for 
the distance.

Note  The user interface specifies the bottom distance in microns, which is another 
term for micrometers.
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Using the Needle Sensor to Determine the Well Bottom Distance

The autosampler has a needle sensor that can determine the bottom distance of custom vials 
or microplate wells.

 To determine the well bottom distance with the autosampler’s needle sensor

1. Remove the cap or lid from your vial or well plate.

2. Place the vial into a tray or the well plate into a carrier, and then place the tray or carrier 
into the tray compartment of the autosampler.

3. In the Calibrate at Well/Vial position box (see Figure 214), type a vial or well location.

Figure 214. Calibrate to find page

4. Click Set Calibration to activate the autosampler. 

After the XYZ arm moves to the selected location, the needle mechanism descends until it 
detects the bottom of the vial or well. After it detects the bottom, the XYZ arm moves to 
the home position. In the Well Bottom Distance wizard, the new bottom distance 
calibration value appears at the top of the page.

5. Click Finish to accept the calibration.

IMPORTANT      Remove vial caps or well plate lids before performing an active well 
bottom distance calibration. As the needle pierces a vial cap or a well plate lid, the 
spring in the needle mechanism is compressed, which can cause premature activation 
of the needle sensor.

IMPORTANT      Before placing a custom tray into the autosampler tray compartment, 
check the height limitations for 96-well and 384-well plates listed in the hardware 
manual for your autosampler. Tall objects will stall the autosampler arm.

Note  If you are calibrating the bottom distance of a vial, verify that you have placed a 
vial in the selected location.
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Autosampler Maintenance Information
Use the Maintenance Information dialog box (see Figure 215) to set the scheduled 
maintenance time (SMT) for the autosampler maintenance items: Injections, Valve Cycles, 
Needle Cycles, and Syringe Cycles. 

Figure 215. Maintenance Information dialog box

 To open the Maintenance Information dialog box

1. Open the view for your autosampler.

The Method page for your autosampler appears.

2. In the menu bar, choose Surveyor AS > Maintenance. 

 To set a new usage limit

1. Click the tab for the page that contains the maintenance item that you want to change the 
usage limit for.

2. In the Usage Limit box, type the usage limit.

3. Click Set New Limit.

 To reset the usage counter after performing the scheduled maintenance task

1. Click the tab for the scheduled maintenance task.

2. Click Zero Counter.

Note  If you selected the Enable Maintenance Log check box on the Communication page 
of the Surveyor AS Autosampler dialog box when you configured the Surveyor 
Autosampler, you can set the scheduled maintenance times (see “Communication Page” 
on page 52).
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Maintenance Information Parameters

Table 61 describes the parameters on the Maintenance Information pages.

When anyone of these counters on the Maintenance Information pages exceeds the 
user-specified usage limit, the Maintenance Due readback displays Yes and the data system 
prevents the autosampler from making injections. 

To enable the autosampler, you must zero the counter or change the usage limit. If the usage 
limit is based on a scheduled maintenance plan, perform the scheduled maintenance. 

Table 61. Maintenance Information dialog box pages and parameters

Page or Parameter Description

Page

Injections Use this page to set the scheduled maintenance time for the number of user-defined 
injections (excluding any cancelled injections). 

Valve Cycles Use this page to set the scheduled maintenance time for the number of user-defined valve 
cycles for the injection valve (from Fill to Inject). 

Needle Cycles Use this page to set the scheduled maintenance time (SMT) for the number of user-defined 
needle cycles when the needle is inserted into a septum, injection port, or wash station. 

Syringe Cycles Use this page to set the scheduled maintenance time (SMT) for the number of user-defined 
syringe cycles where the syringe is put in the Ready position. 

Parameter

Usage Limit Use this box to specify the new usage limit for the selected maintenance item.

Note  When a counter exceeds the usage limit, the autosampler cannot start a run until 
you reset the counter to zero, change the usage limit, or clear the Enable Maintenance Log 
check box on the Communication page of the Surveyor Autosampler Configuration 
dialog box (see “Communication Page” on page 52).

Set New Limit Downloads the new usage limit to the autosampler.

Current Counter and 
Zero Counter

Displays the current count. When the counter exceeds the usage limit (scheduled 
maintenance time), the autosampler cannot start a run until you perform the scheduled 
maintenance or clear the Enable Maintenance Log check box on the Communication page 
of the Autosampler Configuration dialog box.

Zero Counter Zeros the counter for the selected maintenance item.
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Autosampler Validation Information
Use the Validation Information dialog box (see Figure 216) to enter the validation date for the 
indicated parameter and the name of the person who performed the validation.

Figure 216. Validation Information dialog box

 To open the Validation Information dialog box

1. Open the view for your autosampler.

The Method page for your autosampler appears.

2. In the menu bar, choose Surveyor AS > Validation.

The Validation Information dialog box appears.

 To specify your user name and the validation date

1. In the Time box, type or select the validation date.

2. In the Initial Name box, type your initials.

3. Click Set.
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Validation Information Parameters

Table 62 describes the parameters on the Validation Information dialog box.

Table 62. Validation Information dialog box parameters

Parameter Description

Time To change the date that the validation was performed, click the 
arrows to increase or decrease the value, and then click Set.

Initial Name To change the name of the person who performed the validation, 
type the new value in the Initial Name box, and then click Set.

Current Values This readback displays the current time and initial name.

Button

Set Enter the appropriate values in the Time box and the Initial Name 
box, and then click Set to set the values.
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PDA Detector Performance Check and Calibration

This chapter describes the performance verification and calibration procedures for the PDA 
detector.

The PDA detector is factory tested for linearity, noise, and drift. Because of the sensitivity of 
its optical bench, adjust the light throughput to the diode array and recalibrate the PDA 
detector after you install it, and each time you move it, change its flow cell, or replace either of 
the lamps. 

Verifying the Performance of the PDA Detector
Before you perform either calibration procedure, turn on both lamps (see “Turning the Lamps 
On or Off ” on page 163), let the temperature of the detector stabilize for approximately 
one hour, and adjust the light throughput to the diode array detector.

To adjust the light throughput to the diode array, follow these procedures:

• Creating a Display Method 

• Adjusting the Light Throughput to the Diode Array

Creating a Display Method

Methods that display a plot of integrated light intensity versus diode number have a .spda file 
extension.

 To create a display method for the PDA detector

1. In the view bar of the Instrument Setup window, click the Surveyor PDA Plus button. 

The view for the PDA detector appears.

2. In the Units area, select the Diode/Intensity option (see Figure 217).

Contents

• Verifying the Performance of the PDA Detector

• Calibrating the PDA Detector
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Figure 217. Surveyor PDA Plus Method page with the Diode/Intensity option selected

3. Verify that the following parameters are specified on the Surveyor PDA Method page in 
the Spectra area:

• Start Diode (diode num) = 2

• End Diode (diode num) = 511

• Diode Step (diode num) = 1

4. Choose File > Save to save the display method. 

An error message appears (see Figure 218).

Figure 218. Error message that appears when you attempt to save a display method

Note  For a display method, the following parameters are not downloaded to the PDA 
detector: run length, filter rise time, and sample rate. 
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5. Click OK.

6. From the menu bar, choose Surveyor PDA > Direct Control.

7. Click Yes.

The Save PDA Display Method dialog box appears.

8. Save the display method. 

The data system saves the method with a .spda file extension.

After you save the method, the Direct Control dialog box appears with the Display page 
open. 

9. To adjust light throughput to the diode array, go to “Adjusting the Light Throughput to 
the Diode Array.” 

Adjusting the Light Throughput to the Diode Array

The PDA Detector has two attenuators that control the light throughput from the lamps. 
Manually adjusting the position of the attenuators increases or decreases the amount of light 
falling onto the array.

Adjust the light throughput to the diode array whenever you do the following:

• Observe an increase in the detector noise level.

• Move the detector.

• Replace either lamp or the flowcell.

The first time that you adjust the attenuators, you must create a display method that records 
light intensities. You can identify display methods by their .spda file extension. After creating 
the method for adjusting the attenuators, save it with a descriptive name, such as 
diagnostics.spda, and store it for future use to simplify future adjustments of the attenuators.

To adjust the light output from the lamps, follow these procedures in order:

1. “Preparing the LC System for an Attenuator Adjustment” on page 316

2. “Adjusting the Attenuators” on page 317

3. “Adjusting the Attenuators” on page 317

Note  The .spda file extension is a special file extension used for all method files based 
on Diode/Intensity units. When you create a file with an .spda file extension, you can 
only load and use it in the Direct Control dialog box.

Note  Before you adjust the attenuators, replace the column with a flow restrictor, and set 
the pump to deliver HPLC-grade water at a flow rate of 1 mL/min through the flowcell.
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Preparing the LC System for an Attenuator Adjustment

 To prepare the LC system for an attenuator adjustment

1. Ensure that the lamps are on. 

You can view the lamp status from the Configuration page of the Direct Control dialog 
box or from the PDA detector view of the Status page of the Information view. For 
information about the Configuration page, see “Configuration Page” on page 171.

2. Replace the LC column with a flow restrictor.

3. Start pumping HPLC-grade water at a flow rate of 1 mL/min through the flowcell.

Go to the next procedure, “Accessing the Attenuators.” 

Accessing the Attenuators

 To access the attenuators

1. Open the front doors of the detector.

2. Unscrew the captive screw, and then remove the flowcell cover.

The attenuators are located on the right side of the front panel. Two black tabs are 
attached to the attenuators for manual adjustments (see Figure 219). 

The left tab controls the light throughput from the deuterium lamp (UV region) and the 
right tab controls the light throughput from the tungsten lamp (Visible region). Moving 
an attenuator tab up increases the light throughput, and moving the tab down decreases 
the light throughput to the diode array.

Figure 219. Attenuator tabs for the Surveyor PDA Plus Detector

Go to the next procedure, “Adjusting the Attenuators” on page 317.

Deuterium lamp 
attenuator tab

Tungsten lamp 
attenuator tab
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Adjusting the Attenuators

 To adjust the attenuators

1. If you have not already done so, create a display method to view the light intensity from 
the lamps (see “Creating a Display Method” on page 313).

2. Load the display method to the detector as follows:

a. In the Direct Control dialog box for the PDA detector, click the Display tab. 

The Display page appears.

b. In the Control area, click Load Method. 

The Open Display Method dialog box appears (see Figure 220).

Figure 220. Open Display Method dialog box for the PDA detector

c. Choose your display method file (.spda).

d. Click Open.

The file name of the display method appears in the Current Method readback on the 
Display page (see Figure 221 on page 318).

3. Start the data stream and adjust the attenuators as follows:

a. In the Control area, click Start Data.

The spectrum of light intensities appears in the top window (see Figure 221). For the 
UV region, the diode of maximum intensity is between diode 10 and diode 50. For 
the Visible region, the diode of maximum intensity is between diode 400 and 
diode 500. Ignore the spike at approximately diode number 380. This spike is due to 
the deuterium lamp.
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Figure 221. Display page for the PDA detector with an intensity spectrum

b. Adjust the attenuators (see Figure 219 on page 316) as follows:

• Adjust the attenuator with the left tab on the PDA (UV range attenuation) to 
achieve a maximum value from 400 000 to 900 000 intensity counts in the 
region between diode number 10 and diode number 40.

• Adjust the attenuator with the right tab (Visible range attenuation) to achieve a 
maximum value from 400 000 to 900 000 intensity counts in the region between 
diode number 400 and diode number 500.

4. To record the light intensities, do the following:

• To save a picture of the scan to the Clipboard, press ALT+PRINT SCREEN. Paste 
this picture into a text editor such as Microsoft™ Word. Keep this scan for future 
comparisons to see if there is degradation in light intensity. Date the printout and 
add it to your maintenance records. 

• To save the data to a file, click SNAPSHOT.

The data system saves a comma-separated values file named PDASnapshot.csv to the 
following folder on the data system computer: 

drive:\Xcalibur\data 

A date and time stamp are appended to the file name. The format of the date and 
time stamp is MMDDYYHHMMSS. MM is the month. DD is the day of the 
month. YY is the last two digits of the year. HH is the hour in military time. MM are 
minutes. SS are seconds. You can open this file with the Excel application.

Display method file nameStart Data –or– 
SNAPSHOT button
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For a wavelength/absorbance method, the file contains the absorbance values for the 
spectral scan and the discrete channel wavelengths at the moment that you clicked 
Snapshot.

For an intensity/diode method, the file contains the intensity values for the scan of 
the diode array and the intensity values for up to three individual diodes.

5. After you finish adjusting the attenuators, replace the flowcell access cover, close the front 
doors of the detector, and replace the flow restrictor with your LC column.

Calibrating the PDA Detector
For information about calibrating the PDA detector, see these topics:

• Calibration Page for the PDA Detector

• Performing a Dark Current Calibration

• Performing a Wavelength Calibration

• Creating and Editing a Custom Wavelength Calibration List

To calibrate the wavelength accuracy of the optical bench, the PDA detector uses a holmium 
oxide reference solution, one of the four calibration files provided with the Xcalibur data 
system, or your own custom wavelength calibration file.

Figure 222 shows the holmium oxide spectrum.

Figure 222. Holmium oxide spectrum

IMPORTANT      Before you perform a wavelength calibration, verify that the diode array is 
not saturated (see “Adjusting the Light Throughput to the Diode Array” on page 315).
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Calibration Page for the PDA Detector

Use the Calibration page (see Figure 223) to perform the dark current and wavelength 
accuracy calibrations. Perform these calibrations on a regular basis and as part of the operation 
verification procedure.

Figure 223. Calibration page, showing that the detector is not calibrated

Before you perform a wavelength calibration, verify that the diode array is not saturated (see 
“Adjusting the Light Throughput to the Diode Array” on page 315).

 To open the Calibration page

1. From the PDA detector view, choose Surveyor PDA Plus > Direct Controls.

The Direct Control dialog box appears.

2. Click the Calibration tab.
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 To start a dark current calibration

1. Turn on both lamps and wait one hour for the lamps to equilibrate (see “Turning the 
Lamps On or Off” on page 163). 

2. In the Dark Current Calibration area, click Calibrate. 

The Dark Current Calibration wizard appears. 

3. Follow the instructions provided by the wizard. For more information, click Help at the 
bottom of the Dark Current Calibration dialog box.

 To start a wavelength calibration

1. Disconnect the LC column from the system, and then pump HPLC-grade methanol 
through the flowcell to remove any contaminants.

2. Turn on both lamps and wait one hour for the lamps to equilibrate (see “Turning the 
Lamps On or Off” on page 163). 

3. Verify that the array is not saturated (“Adjusting the Light Throughput to the Diode 
Array” on page 315).

4. In the Wavelength Calibration area, click Calibrate. 

The Wavelength Calibration wizard appears.

5. Follow the instructions provided by the wizard. For more information, click Help at the 
bottom of the Wavelength Calibration dialog box.

 To reset the wavelength or dark current calibration to the default values

• To reset the dark current calibration values, in the Dark Current Calibration area, click 
Reset Dark Current Calibration To Default Values.

• To reset the wavelength calibration values, in the Wavelength Calibration area, click Reset 
Wavelength Calibration To Default Values.

Note  The diode array used in the PDA detector has a background count level at each 
diode even when both lamps are off. This background count level is called the dark 
current. This background or dark current must be subtracted from the intensity counts 
before the intensity values are converted to absorbance units (AU). After you perform a 
dark current calibration, the PDA detector corrects the spectrum intensity values for the 
dark current.
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Calibration Page Parameters

Table 63 describes the parameters on the Calibration page for the PDA detector.

Table 63. Calibration page parameters for the PDA detector

Parameter Description

Dark Current Calibration

Calibrate Starts the dark current calibration.

Last Calibration Indicates whether or not the PDA detector is currently calibrated. If the detector has not 
been calibrated, the readback is Not Calibrated. If the detector has been calibrated, the date 
and time of the last calibration are displayed.

Reset Dark 
Current Calibration To 
Default Values

Reloads the default instrument dark current calibration values. When you perform a dark 
current calibration, the Xcalibur data system compares the results to the last saved 
calibration file. This can cause successive calibrations to deviate from the default. 
Occasionally, you must reset to the default calibration values before performing a new dark 
current calibration to get calibration values as close to the default as possible.

Wavelength Calibration

Calibrate Starts the wavelength calibration. 

Last Calibration 
[Wavelength]

Indicates whether the PDA detector is calibrated. If the detector has not been calibrated, 
this readback displays Not Calibrated. If the detector has been calibrated, this readback 
displays the date and time of the last calibration.

Reset Wavelength 
Calibration To Default 
Values

Reloads the default instrument wavelength calibration values. When you perform a 
wavelength calibration, the Xcalibur data system compares the results to the last saved 
calibration file. This can cause successive calibrations to deviate from the default. 
Occasionally, you must reset to the default calibration values before performing a new 
wavelength calibration to get calibration values as close as possible to the default.
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Performing a Dark Current Calibration

The function of the array calibration is to measure and correct for the dark current produced 
by the diodes of the photodiode array. The dark current is the small amount of background 
signal that is produced by the diodes of the array even when both lamps are turned off.  

The environmental conditions of your laboratory can cause the dark current of the diode 
array to increase over time. For best results, perform an array calibration (dark current) after 
any of the following events occur:

• After 100 hours of use or monthly, whichever comes first

• Whenever a 5 °C change in the operating environment occurs

• After you move the detector

• After you replace the lamp

• After you download a new firmware file

Because the dark current produced by the diodes rises as the temperature within the detector 
rises, warm up the lamps for one hour before you perform a dark current calibration. 
Warming up the lamps for one hour allows the detector to equilibrate to its normal operating 
temperature. 

The lamps turn off during the dark current calibration routine. After the dark current 
calibration routine finishes, the lamps turn back on.

 To perform the dark current calibration

1. Pump methanol through the flow cell at 1 mL/min. 

2. Turn on both lamps and wait one hour for the lamps to equilibrate.

3. Open the Calibration page for the PDA detector.

4. To start the wizard for the dark current calibration, click Calibrate in the Dark Current 
Calibration area. 

The preconditions page appears (see Figure 224).
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Figure 224. Preconditions page

5. Read the list of preconditions, and determine if the PDA detector is ready: 

• If the detector meets all the preconditions, click Next to proceed with the calibration. 

The status page appears.

• If the detector does not meet all the preconditions, click Cancel to exit the wizard. 
Then prepare the PDA detector for calibration and begin this wizard again.

6. Observe the status pane as the calibration proceeds (see Figure 225). 

Figure 225. Calibration status page
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7. When the calibration is complete, click Next. 

The next page of the wizard appears (see Figure 226). You can export the results of the 
calibration from this page.

Figure 226. Export results page

8. (Optional) To print a record of the dark current calibration, do the following:

a. Click Export Results. 

The Save As dialog box appears (see Figure 227).

Figure 227. Save As dialog box, showing the file extension for a text file

b. Type a name in the File Name box, and then click Save. 

Once you have saved the file with a name of your choice, you can view or print the 
contents of the file using any text editing program (see Figure 228).
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Figure 228. PDA dark current calibration text file

9. Click Apply to download the calibration results to the detector. 

The wizard proceeds to the success confirmation page (see Figure 229).

Figure 229. Success confirmation page

10. Click Finish to close the wizard. 

The calibration is saved and the date and time of calibration are displayed in the Dark 
Current Calibration area of the Calibration page as the Last Calibration (see Figure 230).
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Figure 230. Calibration page, showing the Currently Calibrated status
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Performing a Wavelength Calibration

The alignment of the spectrum on the diode array depends on the physical alignment of 
various components of the optical bench. The alignment can become offset if the detector is 
sharply jolted, in shipping, for example. Such bumps and jars can slightly change the 
wavelength of light reaching the photodiode array. The automated wavelength calibration 
procedure determines the detector’s wavelength accuracy and adjusts the detector’s wavelength 
algorithm to correct for any misalignment.

 To perform a wavelength calibration

1. Pump HPLC-grade methanol at 1 mL/min through the flowcell.

2. Turn on both lamps and wait one hour for the lamps to equilibrate as follows:

a. From the PDA detector view, choose Surveyor PDA Plus > Direct Controls.

The Direct Control dialog box appears.

b. Click the Configuration tab. 

The Configuration page appears.

c. In the Deuterium Lamp area, click Lamp On to turn on the deuterium lamp.

d. In the Tungsten Lamp area, click Lamp On to turn on the tungsten lamp.

3. Start the Wavelength Calibration wizard as follows:

a. Click the Calibration tab. 

The Calibration page appears (see Figure 231). 
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Figure 231. Calibration page for the PDA detector

b. In the Wavelength Calibration area, click Calibrate.

Page 1 of the wizard appears. This page lists the preconditions required to perform a 
wavelength calibration (see Figure 232). 
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Figure 232. Preconditions page

c. Read the preconditions, and determine if the detector meets these preconditions:

• If the detector meets all of the preconditions, click Next to proceed to the next 
page of the wizard where you are prompted to select a wavelength file. 

• If the detector does not meet all the preconditions, click Cancel to exit the 
wizard and prepare the PDA detector for calibration.

Note  On any page of the wavelength calibration wizard, you can click Cancel to 
exit the procedure.
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4. Do the following:

a. Select a peak set from the list. 

The peak set should span the wavelengths you use under normal operating 
conditions. 

Figure 233 shows the selection of the Holmium Oxide 5 peak set. This wavelength 
list instructs the program to calibrate the detector at each of the five wavelengths 
shown.

Figure 233. Choose Calibration Peak List page

Note  The data system has four calibration files to select from. For example, the 
Holmium Oxide UV file contains five wavelengths in the UV region, while 
the other files use sets of wavelengths from both the UV and visible wavelength 
regions. The holmium oxide absorbance maxima are selected from a spectrum 
published in “Holmium Oxide Solution Wavelength Standard from 
240 to 640 nm - SRM 2034 (NIST Special Publication 260-54).”

Note  For information about creating a custom peak list, see “Creating and 
Editing a Custom Wavelength Calibration List” on page 337.

Click to create a 
custom peak list.
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b. Click Next. 

The next page of the wizard appears (see Figure 234). 

5. Do the following:

a. Observe the status pane that tells you the wavelength file is being downloaded 
(see Figure 234). 

Figure 234. Download status for the selected peak list page

b. After you see the message: Click the Next button to proceed with the wavelength 
calibration, click Next. 

The next page of the Wavelength Calibration wizard appears (see Figure 235). This 
page instructs you to place the filter wheel in position 2.

Figure 235. Request to rotate the filter wheel to position 2 page 

6. Rotate the Holmium Oxide filter wheel to position 2 as directed.

After you turn the wheel, the Next button becomes available (see Figure 236).

Instruction to click Next
332 Surveyor Plus User Guide for LC Devices Thermo Scientific



 11 PDA Detector Performance Check and Calibration
Calibrating the PDA Detector
Figure 236. Available Next button

7. Click Next.

The calibration status page of the wizard appears (see Figure 237).

Figure 237. Calibration status page

8. Do the following:

a. Observe the status pane (see Figure 237). 

The diagnostics program waits a few seconds for the rise time filter to equilibrate, and 
then the detector takes a holmium oxide scan. 

b. When you see the message: Click the Next button to proceed with calibration, 
click Next.

The next page of the wizard appears (see Figure 238).

Instruction to click Next
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Figure 238. Request to rotate the filter wheel to position 1 page

9. Rotate the wheel back to position 1 (Open) as instructed. 

After you rotate the wheel, the Next button becomes available (see Figure 239). 

Figure 239. Available Next button

10. Click Next to proceed.

The results page for the wavelength calibration appears (see Figure 240).
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Figure 240. Delta values page

11. Verify that the delta values are within ±1 nm: 

• If the Delta values are acceptable, go to step 12.

• If the delta values are not within the range of ±1 nm, do not export the results. 
Complete the calibration procedure. Then, repeat the wavelength calibration. After 
applying a second calibration, if the Delta values are still not within the range 
of ±1 nm, call your Thermo Fisher Scientific service representative for assistance.

12. (Optional) To print a report of the calibration results, do the following:

a. Click Export Results to print the results to a file. 

The Save As dialog box appears (see Figure 241).

Click to accept 
the calibration 
(see step 13).

Click to export the 
calibration results 
to a text file (see 
step 12).
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Figure 241. Save As dialog box

b. Type a name in the File Name box, and then click Save. 

After you save the file with a name of your choice, you can view or print the contents 
of the file using any text editing program (see Figure 242).

Figure 242. Wavelength Calibration file, viewed in Microsoft Notepad
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13. To apply the calibration results to the detector, click Apply on the Delta Values page (see 
Figure 240 on page 335). 

The success confirmation page appears (see Figure 243).

Figure 243. Success confirmation page for a wavelength calibration

14. Click Finish to complete the wavelength calibration. 

The calibration is saved. The date and time of the calibration are displayed in the 
Wavelength Calibration area of the Calibration page (see Figure 231 on page 329).

Creating and Editing a Custom Wavelength Calibration List

Use the Custom List Name dialog box to name a custom wavelength calibration list 
(WCL file).

 To open the Custom List Name dialog box and the Edit Peak List area

1. Start the Wavelength Calibration wizard (see “Performing a Wavelength Calibration” on 
page 328).

2. Verify that the PDA detector meets the preconditions for a wavelength calibration and 
click Next.

The wavelength list page appears (see Figure 233 on page 331).

3. Click Save As Custom List.

The Custom List Name dialog box appears (see Figure 244).
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Figure 244. Custom List Name dialog box

4. Type a name for the list in the box, and then click OK to add the name to the Choose 
Calibration Peak List and close the dialog box.

The name of the custom list appears in the Choose Calibration Peak List box.

5. In the Choose Calibration Peak List box, click the custom list name.

The wavelength list becomes available.

6. In the wavelength list, click a wavelength that you want to edit.

The Edit Peak List area appears to the right of the wavelength list.

 To create a custom wavelength calibration list

1. Start the Wavelength Calibration wizard (see “Performing a Wavelength Calibration” on 
page 328).

2. Click Save As Custom List.

The Custom List Name dialog box appears.

3. In the box, type a name.

4. Click OK. 

The name of the new wavelength calibration list appears in the Choose Calibration Peak 
List box.

 To edit the wavelength calibration list

1. Click the Crest/Window pane. 

The Edit Peak List area appears.

2. To add a wavelength, type a wavelength in the Peak Crest box and a window in the Peak 
Window box, and then click Add.

3. To delete a wavelength, select the wavelength, and then click Delete.
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4. Click Save As Custom List to save the edited list.

The Custom List Name dialog box appears.

5. Type the name of the custom list in the box.

The Save As Custom dialog box appears (see Figure 245).

Figure 245. Save As Custom dialog box

6. Click Yes to save the wavelength calibration list.

Edit Peak List Area

Table 64 describes the parameters in the Edit Peak List area on the Choose Calibration Peak 
list page of the Wavelength Calibration wizard.

Table 64. Edit Peak List area of the Wavelength Calibration wizard for the PDA detector

Parameter Description

Peak Crest Specifies a spectral band. The holmium oxide wheel contains a 
solution of holmium oxide in perchloric acid. 

Range: 190 to 800 nm

Peak Window Specifies the search window for the peak crest. 

Start wavelength = peak crest – peak window/2

End wavelength = peak crest + peak window/2

Range: 0.1 to 611.0

Buttons

Modify Modifies the selected spectral band.

Add Adds a spectral band.

Delete Deletes a spectral band.
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Making a Single Injection from the Tune Window

If you are using the Surveyor Plus LC system as an inlet to a Thermo Scientific mass 
spectrometer, you can use the direct control dialog boxes available from the Tune window to 
make a single injection and acquire data.

For information about setting up the LC/MS system, refer to the Getting Connected Guide 
for your mass spectrometer. For information about acquiring raw data files from the tune 
program for your mass spectrometer, refer to the Getting Started Guide for your mass 
spectrometer.

 To inject a single sample from the Tune window

1. Prepare the LC system for operation. See Chapter 5, “Daily Operation.” 

2. From the Tune window for your Thermo Scientific mass spectrometer, choose Setup > 
Inlet Direct Control. 

The Inlet Direct Control dialog box that contains tabbed pages for each configured LC 
device appears.

3. Start the solvent flow from the pump as follows:

• For the Surveyor LC Pump Plus, click the Surveyor LC Pump tab. In the Method 
area (see Figure 246), enter the appropriate values for the flow rate and the solvent 
percentages. Click Download. In the Pump area, click Pump On to start the solvent 
flow.

Note  You can use the PDA Direct Control dialog box to perform diagnostic tests such as 
checking the performance of the deuterium lamp. To acquire PDA data for a single 
injection, you must run a single row sequence from the Sequence window.
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Figure 246. Surveyor LC Pump page of the Inlet Direct Control dialog box

• For the Surveyor MS Pump Plus, click the Surveyor MS Pump Plus tab. Select the 
Take Pump Under Control check box (see Figure 247). Type the appropriate flow 
rate in the Flow box. Type the appropriate solvent proportions in the Inlet boxes. 
Select the Pump Ready check box. Click  (Start) to start the solvent flow. 

Figure 247. Direct Control dialog box for the pump

4. Start the injection as follows:

a. In the Inlet Direct Control dialog box, click the Surveyor AS tab.

The Surveyor AS page appears (see Figure 248).
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b. In the list of commands, select Inject Sample. 

The Inject sample parameters appear (see Figure 248).

Figure 248. Surveyor AS page of the Direct Inlet Control dialog box

c. In the Vial box, type the location of the sample. Ensure that you have placed a sample 
in this location.

For information about the vial and well notation, see “Vial and Well Notation” on 
page 6.

d. In the Volume (μL) box, type the volume that you want to inject.

e. Select the injection mode: Full, Partial, or No Waste. For more information, see 
“Injection Modes” on page 19.

f. Click Apply.

The autosampler loads the sample into the sample loop connected to the injection 
valve as follows:

The XYZ arm of the autosampler moves to the sample location, and then lowers 
the needle into the sample vial. The syringe plunger descends, drawing sample 
into the needle tubing. The XYZ arm moves back to the injection port, and then 
lowers the needle into the injection port. The syringe plunger ascends, pushing 
sample into the injection port, through the transfer tubing, and into the sample loop 
of the injection valve.

5. On the Surveyor MS Pump Plus page, select the Release Injection check box.

The injection valve switches to the inject position, allowing mobile phase to backflush the 
sample out of the sample loop and into the LC column.
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Index
Numerics
384-well microplates, well positions  10, 302
96-well microplates, well positions  7

A
absorbance level

zeroing for the PDA detector during a run  105
zeroing for the UV/Vis detector  23
zeroing on the Display page  178

accessories
reservoir vials  5
solvent lines  23
standard vials  6
wash bottle assembly  13

active and pinned cells, Qual Browser  225
air bubbles, loaded into the sample loop  19
alpha values for flow rate adjustment  265, 268
analog outputs

changing the polarity  164
testing  165

areas of peaks, displaying  242
arm calibration, autosampler  287
attenuators, PDA  22
autosampler

automated sample preparation  113
busy status message  139
calibrating  274
configuration parameters  45
custom vials or microplates, using  305
Direct Inlet Control dialog box  343
instrument method parameters  85
loading trays  210
timed events table parameters  94
transfer tubing  17
vial and well notation  6

autozero function for the UV/Vis detector  107
Avalon integration algorithm  237

B
back panels

Ethernet port location  24
unit ID location  42

baseline
drift, reducing  209
noise, reducing  187
zeroing absorbance level

PDA detector  103
UV/Vis detector  23

C
cables

Ethernet  3, 41
RS-232 serial  2
system interconnect  32

calibration
arm calibration, autosampler  287
column oven  275
dark current  323
LC pump  260
tray temperature  281
wavelength  328
well bottom distance, custom vials or microplates  305

calibration curves, creating  203
cell grid, Qual Browser

adding cells to the real-time display  216
cell states  224
cursor actions  226
inserting cells  244

channels, instrument method  100
chemicals, filtering  210
chromatograms

cursor actions, cell grid  226
labels (retention time, area, and so on)  241
peak detection  252
UV data, displaying  250

column
 See LC column

column arrangement, sequence spreadsheet  205
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Index: D
column oven
description  21
direct control  199
temperature calibration  275
test fixture, installing  276

Comm LED
autosampler  38
LC pump  37
MS pump  36
PDA detector  39
UV/Vis detector  40

communication, Xcalibur data system  41
compliance

FCC  vii
regulatory  iii
WEEE  ix

compressibility
defined  262
updating  266
values  264

concentric syringe
See  syringe, autosampler

configuration options
autosampler  45
LC pump  63
MS pump  61
PDA detector  65
UV/Vis detector  66

contact closure cable  32
conventional vial trays  6
Custom List Name dialog box  337
custom vials and microplates

calibrating the bottom distance of  305
selecting tray options  47

D
dark current calibration  323
data acquisition

analyzing acquired data  219
starting  211
viewing real-time  214

data files
naming  203
opening  219

dead volume for transfer tubing, configuring  54
Degas LED

LC pump  37
MS pump  36

degassing unit, built-in  2, 23
delay volume, LC pump  3
delay, PDA detector timed event  103

delta values, PDA calibration  335
Description box, LC column  69
detectors

See PDA detector or UV/Vis detector
devices

adding to the instrument configuration  44
start instrument  213
status, viewing  137
turning into Standby mode  154
turning on/off  154

dilutions, sample preparation example for automating  127
diode numbers  102
diode voltage leakage  323
Direct Control dialog box

autosampler  197
LC pump  188
MS pump  190
PDA detector  162
UV/Vis detector  183

discrete channel wavelengths, instrument method  100
display methods

creating  313
saving  314

display options
chromatogram cell  240
map cell  247
spectrum cell  242

drain valve knob for LC pump  4, 187, 269
dual wavelength program, UV/Vis detector  107

E
electromagnetic compatibility  vii
error log

autosampler  144
PDA detector  182

event types, PDA detector timed event  103
external devices, triggering  102

F
FCC compliance  vii
file types

comma-separated values file (.csv)  318
data file (.raw)  219
display method (.spda)  315
layout file (.lyt)  222
processing method (.pmd)  203
sequence (.sld)  208

fill position, injection valve  18
filter frit, LC pump  4
filter wheel, PDA detector  22
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Index: G
firmware, upload version  60
fixed loop injection

See full loop injection
flow rate

adjustment setting  268
gradient program changes  79
range

LC pump  3
MS pump  2

flush bottle location  13
flush speeds  87, 89
font size of display, changing  230
fraction collector, triggering  102
full loop injection

description  20
instrument method parameter  90

G
gradient delay volume

autosampler preheat tubing  21
LC pump pulse dampener  3
MS pump  2

gradient program
LC pump  71
MS pump  79

Gradient Start signal, pump  35
grinding sound, caused by high flush speeds  89

H
heights, chromatographic peak  242

I
inactive cells, Qual Browser  224
initialization process for syringe  134
Initializing status message  137
inject position, injection valve  18
injection mode, description  19
injection valve, description  18
injection volume

full loop injections  20
no waste injections  19, 90
partial loop injections  20

instrument methods
adding a sample preparation routine  113
autosampler parameters  85
creating  67
LC pump parameters  69
MS pump parameters  74
parameters report, data file  232

PDA detector parameters  98
saving  109
UV/Vis detector parameters  108

Instrument Setup window, opening  68
integration

auto calculation  253
Avalon integration algorithm  252

intensity
counts, maximum light throughput  318
data, recording  318

intensity display  178
isocratic pump program

creating for LC pump  71
creating for MS pump  81

L
Labels page, Display Options dialog box  241
Lamp Startup Time dialog box  166
lamps

controls on the PDA detector Configuration page  163
deuterium  22–23
Information view Turn Device On command  154
lamp warm-up message  137
safety interlock  23
timed startup for PDA detector  166
tungsten  22–23
turning on, UV/Vis detector  183
usage hours, resetting for the PDA detector  164
wavelength range for the PDA detector  22

Lamps LED
PDA detector  39
UV/Vis detector  40

layout files for PDA data
creating  233
saving  248

LC column
damaging  77
equilibrating  209

LC pump
components  3
in-line filter frit  4
instrument method parameters  69
LED states  37
purging  4, 187

LEDs, device status  35
level trigger  103
light fixture, arm calibration  287, 294
light throughput to the diode array, adjusting  315
Load Method button  177, 317
Lock Display button  214
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Index: M
M
maintenance log, autosampler  54
manuals, accessing  xvi
methods

See instrument methods or display methods
microplates

384-well  10
96-well  7
description  6
selecting tray options  47

MS pump
instrument method parameters  74
operating without solvent  77
pressure settings, minimum and maximum  77
pressure stability  77
priming the pulse dampener  156
Ready signal  77

N
names, chromatographic peaks  242
needle and needle tubing assemblies, description  16
New Sequence Template dialog box  202
no waste injection

description  19
injection volume recommendation  91
instrument method parameter  90

noise, detector  170
Normalization page, Display Options dialog box  240

O
On, Off, Standby shortcut menu  154
On/Off switches for LC devices  135
output signal terminals  164
Oven page readbacks, autosampler  142

P
partial loop injection

description  20
instrument method parameter  89

PCR plate, configuring  48
PDA detector

dark current calibration  323
data acquisition parameters  95
display method parameters  101
functional description  22
instrument method parameters  98
light throughput, adjusting  315
parameters in method report  232
timed events parameters  102
wavelength calibration  328

PDASnapshot.csv  318
peaks, chromatographic

areas, displaying  251
peak detection  251
purity settings  255

polarity, active high or active low  164
Post-Injection Valve Switch Time box  89
Power LED

autosampler  38
LC pump  37
MS pump  36
PDA detector  39
UV/Vis detector  40

power, turning on/off  134
precision, injection-to-injection  89
preheating tubing  21
Prep Operations list  116
pressure

minimum for LC pump  69
recorder terminals  264
sensor adjustment  269
units for displaying backpressure  63

pressure recorder terminals, scaling the output  268
pressure transducer

replacing  265
zeroing  265, 269

processing method (.pmd) file type  203
pump

See LC pump or MS pump
Pump Ready signal  35

Q
Qual Browser

accessing  219
cell grid  224
cursor actions  226
display options, UV chromatograms  240
layout files, creating  233

R
Ready signal, pump  77
ready to download message  137
real-time data

locking  214
reviewing  215

regulatory compliance  iii
removal position, needle  303
report, instrument method  232
Reservoir Content page, autosampler solvent descriptions  93
Reset Lifetime button  173
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Index: S
retention times, chromatographic peak
displaying  242
effect of temperature control on reproducibility  87

rise time filter
for the PDA detector  96
for the UV/Vis detector  106

Run LED
autosampler  38
LC pump  37
MS Pump  36
PDA detector  39
UV/Vis detector  40

S
safety interlock, lamps  23
safety standards  iii
sample loop description  18
sample preparation

routines, creating  113
rules  115
Sample Preparation page, opening  113

sample rate, PDA detector  99
sample trays

figure showing conventional trays  204
loading into the tray compartment  210
selecting tray options  47
temperature control  21
vial and microplate well positions  6

Save PDA Display Method dialog box  315
scan threshold  255
screen saver, turning off  24
seals, piston, ruining  77
sequences

creating  201
saving  208
turning off the lamps and the solvent flow  213

Snapshot button  169, 178, 318
solvent composition

gradient program linearity  79
instrument method  79
programming for LC pump  72

solvent lines
four lines for mobile phase solvents  23
wash bottle  23

solvent platform  23
solvent reservoir bottles  23
spectral light intensity (.spda) file type  315

spectrum
chromatographic time point  249
cursor actions  226
displaying  238
maximum absorbance  235

speeds
flush speed setting  87
loop loading  92
no waste injections  19

stack address or stack number  24, 42, 63, 65
standard syringe (single plunger), size  14
standby, Status page shortcut menu item  154
Start Data button  169
status

checking the status of the LC devices  136
LEDs for LC devices  35

Stop Data button  170
switches

Ethernet  24
tray compartment door, magnetic  6

synchronizing the LC devices  32
syringe valve, description and figure  13
syringe, autosampler

configuring  53
description  14
flushing  196
sample preparation rules for  115

T
target port fixture, arm calibration  299
Temp LED  38
temperature control

tray and LC column compartments  21
Wait for Temperature Ready check box  54

terminals, output signals  164
Timed Events page, autosampler  94
timed events, PDA detector  104
total scan  235
tray compartment door

magnetic switch  210
Verify Door Is Closed check box  54

tray compartment temperature
calibration  281
control  21

tray temperature sensor, installing  281
trays

See sample trays
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Index: U
tubing
behind column oven  21
degasser  2
needle tubing  13
solvent lines  23
wash bottle  13

Turn Device On command  154

U
unit ID

description  42
relation to communication protocols  24

unpinned cells, Qual Browser  225
UV/Vis detector

configuring  66
direct controls  183
instrument method parameters  108
lamp controls  183
parameters in method report  232
wavelength modes  23

V
valves

six-port injection valve  18
syringe two-position rotary valve  13

variable volume injections, types  20
Verify Door Is Closed check box  6, 54, 290
vial bottom sensing  54
Vial Not Found message  210
vial trays, notation  6
viscous flush solvents  89
volume

flush  197
full loop injections  20
gradient delay, pulse dampener in LC pump  3
no waste injections  19, 90
partial loop injections  20
preheat tubing  21
sample loops  18
sample preparation operations  115
standard needle tubing and needle tubing extension  13
tubing in chambers of vacuum degassing unit  2

W
Wait for Temperature Ready check box  54
wash bottle location  13

wavelength
accuracy, calibrating  328
calibration list, editing  338
data acquisition range

PDA detector  99
UV/Vis detector  108

WEEE compliance  ix
well bottom distance calibration  305
well position and well ordering, selecting  49

X
x- and y -axis offset values, arm calibration  300
Xcalibur data system

Instrument Setup Window, opening  68
Qual Browser, opening  219
Roadmap view  135
Sequence Setup window, opening  201

XYZ arm
description  15
home position  296
moving to the back of the tray compartment  303
position, calibrating  287

Z
Zero DACs button  175
Zero Data

button on Display page  170
event type, PDA detector  105

zeroing, absorbance level
PDA detector  103
UV/Vis detector  23, 107
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